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NATIONAL CYBERSECURITY CENTER OF EXCELLENCE

The National Cybersecurity Center of Excellence (NCCoE) at the National Institute of Standards 
and Technology (NIST) addresses businesses’ most pressing cybersecurity problems with 
practical, standards-based solutions using commercially available technologies. The NCCoE 
collaborates with industry, academic, and government experts to build modular, open, end-to-
end reference designs that are broadly applicable and repeatable. The center’s work results in 
publicly available NIST Cybersecurity Practice Guides, Special Publication Series 1800, that 
provide users with the materials lists, configuration files, and other information they need to 
adopt a similar approach. 

To learn more about the NCCoE, visit http://nccoe.nist.gov. To learn more about NIST, visit 
http://www.nist.gov.  

NIST CYBERSECURITY PRACTICE GUIDES 

NIST Cybersecurity Practice Guides (Special Publication Series 1800) target specific cybersecurity 
challenges in the public and private sectors. They are practical, user-friendly guides that 
facilitate the adoption of standards-based approaches to cybersecurity. They show members of 
the information security community how to implement example solutions that help them align 
more easily with relevant standards and best practices. 

The documents in this series describe example implementations of cybersecurity practices that 
businesses and other organizations may voluntarily adopt. The documents in this series do not 
describe regulations or mandatory practices, nor do they carry statutory authority.  

ABSTRACT 

To protect power generation, transmission, and distribution, energy companies need to control 
physical and logical access to their resources, including buildings, equipment, information 
technology, and industrial control systems. They must authenticate authorized individuals to the 
devices and facilities to which they are giving access rights with a high degree of certainty. In 
addition, they need to enforce access control policies (e.g., allow, deny, inquire further) 
consistently, uniformly, and quickly across all of their resources. This project resulted from direct 
dialogue among NCCoE staff and members of the electricity subsector, mainly from electric 
power companies and those who provide equipment and/or services to them. The goal of this 
project is to demonstrate a centralized, standards-based technical approach that unifies identity 
and access management (IdAM) functions across operational technology (OT) networks, 
physical access control systems (PACS), and information technology systems (IT). These 
networks often operate independently, which can result in identity and access information 
disparity, increased costs, inefficiencies, and loss of capacity and service delivery capability. This 
guide describes our collaborative efforts with technology providers and electric company 
stakeholders to address the security challenges energy providers face in the core function of 
IdAM. It offers a technical approach to meeting the challenge, and also incorporates a business 
value mind-set by identifying the strategic considerations involved in implementing new 

http://172.16.33.88:9080/AlertEnterprise/
https://nistgov.sharepoint.com/sites/nccoe/Energy/Shared%20Documents/IdAM%20Practice%20Guide/Drafts/NIST_SP1800-2c_ES_IDAM-HowTo.docx
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technologies. This NIST Cybersecurity Practice Guide provides a modular, open, end-to-end 
example solution that can be tailored and implemented by energy providers of varying sizes and 
sophistication. It shows energy providers how we met the challenge using open source and 
commercially available tools and technologies that are consistent with cybersecurity standards. 
The use case scenario is based on a normal day-to-day business operational scenario that 
provides the underlying impetus for the functionality presented in the guide. While the 
reference solution was demonstrated with a certain suite of products, the guide does not 
endorse these products in particular. Instead, it presents the characteristics and capabilities that 
an organization’s security experts can use to identify similar standards-based products that can 
be integrated quickly and cost-effectively with an energy provider’s existing tools and 
infrastructure. 

KEYWORDS 

Cyber, physical, and operational security; cyber security; electricity subsector; energy sector; 
identity and access management; information technology  
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1 INTRODUCTION 1 

1.1 PRACTICE GUIDE STRUCTURE 2 

This NIST Cybersecurity Practice Guide demonstrates a standards-based example solution and 3 
provides users with the information they need to replicate this approach to identity and access 4 
management (IdAM). The example solution is modular and can be deployed in whole or in 5 
parts.  6 

This guide contains three volumes: 7 

• NIST SP 1800-2a: Executive Summary 8 

• NIST SP 1800-2b: Approach, Architecture, and Security Characteristics – what we built 9 
and why  10 

• NIST SP 1800-2c: How To Guides – instructions 11 
for building the example solution 12 

The following instructions show IT professionals and security engineers how the National 13 
Cybersecurity Center of Excellence (NCCoE) implemented example solutions to the challenge of 14 
a centralized IdAM system. We developed two builds that conform to federal standards and best 15 
practices, and address the challenge of providing a secure, centralized, uniform, and efficient 16 
solution for managing authentication and authorization services, access control, and 17 
provisioning across what are currently three independent and disparate corporate silos: IT, 18 
operational technology (OT), and physical access control systems (PACS) networks.  19 

This example solution is packaged as a “How To” guide. The guide demonstrates how to 20 
implement standards-based, commercially available cybersecurity technologies in the real 21 
world, based on risk analysis. 22 

We cover all the products that we employed in this example solution. We do not recreate the 23 
product manufacturer’s documentation, which is presumed to be widely available. Rather, these 24 
guides show how we incorporated the products together in our environment. 25 

These guides assume that the people using this document have experience implementing 26 
information technology security products (including systems integration and administration of 27 
networked Windows and Linux systems, firewalls, routers, etc.) in an electricity subsector 28 
organization. While we have used the commercially available products described here, we 29 
assume that you have the knowledge and expertise to choose other products that might better 30 
fit your IT systems and business processes.1 If you use substitute products, we hope you’ll seek 31 
                                                      
1 Certain commercial entities, equipment, or materials may be identified in this document in order to describe an 
experimental procedure or concept adequately. Such identification is not intended to imply recommendation or 
endorsement by NIST or NCCoE, nor is it intended to imply that the entities, materials, or equipment are 
necessarily the best available for the purpose.  

YOU ARE HERE 
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products that are congruent with standards and best practices, as we have. Refer to NIST SP 32 
1800-2b: Approach, Architecture, and Security Characteristics, Section 4.5, Table 2, for a list of 33 
the products that we used, mapped to the cybersecurity controls provided by this example 34 
solution, to understand the characteristics you should seek in alternate products. Section 4.4 35 
Security Characteristics and Controls Mapping, of that document describes how we arrived at 36 
this list of controls. 37 

The security characteristics in our access management platform are informed by guidance and 38 
best practices from standards organizations, including the North American Electric Reliability 39 
Corporation’s (NERC) Critical Infrastructure Protection (CIP) standards. In addition, this 40 
document was reviewed by the NERC ES-ISAC to ensure that the approach was informed by 41 
standards and NERC regulations. 42 

While we have used a suite of commercial products to address this challenge, this guide does 43 
not endorse these particular products, nor does it guarantee regulatory compliance. Your 44 
utility’s information security experts should identify the standards-based products that will best 45 
integrate with your existing tools and IT system infrastructure. Your company can adopt this 46 
solution or one that adheres to these guidelines in whole, or you can use this guide as a starting 47 
point for tailoring and implementing parts of a solution. This NIST Cybersecurity Practice Guide 48 
does not describe “the” solution, but a possible solution. This is a draft version. We are seeking 49 
feedback on its contents and welcome your input. Comments and suggestions will improve 50 
subsequent versions of this guide. Please contribute your thoughts to energy_nccoe@nist.gov, 51 
and join the discussion at http://nccoe.nist.gov/forums/energy. 52 

NOTE: These are not comprehensive tutorials. There are many possible service and 53 
security configurations for these products that are out of scope for this example 54 
solution. 55 

1.2 CONVENTIONS 56 

Filenames, pathnames, partitions, URLs, and program names are in italic text: 57 

filename.conf 58 

…/folder/filename.conf 59 

http://nccoe.nist.gov 60 

Commands and status codes are in Courier: 61 
 mkdir 62 
Code that a user inputs is in Garamond bold:  63 

service sshd start 64 
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2 BUILD OVERVIEW 65 

The NCCoE constructed the IdAM build infrastructure using off-the-shelf hardware and 66 
software. The infrastructure was built on Dell model PowerEdge R620 server hardware. The 67 
server operating system was VMware vSphere virtualization operating environment. In addition, 68 
a 6-terabyte Dell EqualLogic network attached storage (NAS) product was used for storage, Dell 69 
model PowerConnect 7024 and Cisco Catalyst 3650 and 3550 physical switches were used to 70 
interconnect the server hardware, external network components, and the NAS. 71 

The lab network was accessible from the public Internet via a virtual private network (VPN) 72 
appliance and firewall to enable secure Internet and remote access. The lab network was not 73 
connected to the NIST enterprise network. Table 1 lists which software and hardware 74 
components were used in the builds, the specific function each component contributes, and 75 
whether the product was installed within the virtual environment or as physical device. 76 

Table 1. Build Implementation Component List (including security controls) 77 

 
 

Product Vendor 

 
 

Component  

 
 

Function 

Implementation 
(physical device or 

virtual environment)  

Dell PowerEdge R620 Server hardware Physical device 

Dell PowerConnect 7024 Network switch Physical device 

Dell EqualLogic Network attached 
storage 

Physical device 

VMware vSphere vCenter Server 
version 5.5 

Virtual server and 
workstation 
environment 

Virtual environment 

Microsoft Windows Server 2012 
r2 
Active Directory Server 

Authentication and 
authority 

Virtual environment 

Microsoft Windows 7 Information 
management 

Virtual environment 

Windows Windows Server 2012 
r2 
DNS Server 

Domain name system Virtual environment 

Windows  SQL Server Database Virtual environment 
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Product Vendor 

 
 

Component  

 
 

Function 

Implementation 
(physical device or 

virtual environment)  

AlertEnterprise Enterprise Guardian Interface and translation 
between IdAM central 
store and the PACS 
management server 

Virtual environment 

CA Technologies Identity Manager 
Rel 12.6.05 Build 
06109.28 

Identity and access 
automation 
management 
application, IdAM 
provisioning 

Virtual environment 

Cisco ISE Network Server 
3415 

Network access 
controller 

Virtual environment 

Cisco Catalyst 3550 Network switch Physical device 

Cisco Catalyst 3650 TrustSec-enabled 
physical network switch 

Physical device 

GlobalSign SSL Certificate Cloud certificate and 
registration authority 

Virtual environment 

Mount Airey 
Group 

Ozone Authority Central attribute 
management system 

Virtual environment 

Mount Airey 
Group 

Ozone Console Ozone administrative 
management console 

Virtual environment 

Mount Airey 
Group 

Ozone Envoy Enterprise identity store 
interface 

Virtual environment 

Mount Airey 
Group 

Ozone Server Ozone centralized 
attribute based 
authorization server 

Virtual environment 

RADiFlow Industrial Service 
Management Tool 
(iSIM) 

Supervisory control and 
data acquisition (SCADA) 
router management 
application 

Physical device 
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Product Vendor 

 
 

Component  

 
 

Function 

Implementation 
(physical device or 

virtual environment)  

RADiFlow SCADA Router 
 RF-3180S 

Router/firewall for 
SCADA network 

Physical device 

RSA  Adaptive Directory 
Version 7.1.5 

Central identity store, 
IdAM provisioning 

Virtual environment 

RSA  IMG  
Version 6.9 
Build 74968 

Central IdAM system 
(workflow management) 

Virtual environment 

TDi Technologies ConsoleWorks User access controller, 
monitor, and logging 
system 

Virtual environment 

RS2 Technologies AccessIT! Universal 
Release 4.1.15 

Physical access control 
components 

Configures and monitors 
the PACS devices (e.g., 
card readers, keypads) 

Virtual environment 
server and physical 
device card reader 

Schweitzer 
Electronics 
Laboratory 

SEL-2411 Remote Terminal Unit 
(RTU) 

Physical device 

Schneider 
Electric 

Tofino Firewall model 
number 
TCSEFEA23F3F20 

Ethernet/IP firewall Physical device 

XTEC Xnode Remote access control 
and management 

Physical device 

2.1 BUILD IMPLEMENTATION OVERVIEW 78 

The build implementation consists of multiple networks implemented to mirror the 79 
infrastructure of a typical energy industry corporation. The networks include a management 80 
network and a production network, Figure 1. The management network was implemented to 81 
facilitate the implementation, configuration, and management of the underlying infrastructure, 82 
including the physical servers, vSphere infrastructure, and monitoring. The production network, 83 
Figure 1, consists of  84 

• the demilitarized zone (DMZ) 85 
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• Identity and Access Management - IdAM 86 

• IT - business management system 87 

• OT - ICS/SCADA industrial control system and energy management system (EMS) 88 

• PACS – physical access control system networks 89 

These networks were implemented separately to match a typical electric utility enterprise 90 
infrastructure. Firewalls are configured to route traffic and limit access among the production 91 
networks to block all traffic except required inter-network communications. The primary inter-92 
network communications are the user access and authorization updates from the central IdAM 93 
systems to and from the directories and PACS, IT, and OT networks. The DMZ provides a 94 
protected neutral network space that the other networks of the production network can use to 95 
route traffic to and from the Internet or each other. 96 
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97 
 98 

Figure 1. Management and production networks 99 
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 100 

Figure 2. IdAM build implementation production network 101 

The IdAM network represents the proposed centralized/converged IdAM network/system. This 102 
network was separated to highlight the unique IdAM components proposed to address the use 103 
case requirements.  104 

The IT network represents the business management network that typically supports corporate 105 
email, file sharing, printing, and Internet access for general business-purpose computing and 106 
communications.  107 

The OT network represents the network used to support the energy management systems 108 
(EMS)s and industrial control systems (ICS)/supervisory control and data acquisition (SCADA) 109 
systems. Typically, this network is either not connected to the enterprise IT network or is 110 
connected with a data diode (a one-way communication device from the OT network to the IT 111 
network). Two-way traffic is allowed per NERC-CIP and is enabled via the OT firewall only for 112 
specific ports and protocols between specific systems identified by IP address. 113 

The PACS network represents the network used to support the physical access control systems 114 
across the enterprise. Typically, this network uses the enterprise IT network and is segmented 115 
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from the user networks via virtual local area networks (VLANs). In our architecture, a firewall is 116 
configured to allow limited access to and from the PACS network to facilitate the 117 
communication of access and authorization information. Technically, this communication 118 
consists of user role and responsibility directory updates originating in the IdAM system. 119 

The public Internet is accessible by the lab environment to facilitate both cloud services and 120 
access for vendors and NCCoE administrators.  121 

The VPN firewall was the access control point for vendors to support the installation and 122 
configuration of their components of the architecture. The NCCoE also used this access to 123 
facilitate product training. This firewall also blocked unauthorized traffic from the public 124 
Internet to the production networks. Additional firewalls are used to secure the multiple 125 
domain networks (IT, OT, IdAM, and PACS) explained below. 126 

Switching in the implementation is executed using a series of physical and hypervisor soft 127 
switches. VLAN switching functions are handled by physical Dell switches and the virtual 128 
environment. Routing was accomplished using the firewalls. 129 

2.2 BUILD IMPLEMENTATION DESCRIPTIONS 130 

Figure 3 depicts the build network comprising the management, VendorNet, IdAM, DMZ, IT, OT, 131 
and PACS subnetworks. VendorNet provides remote access for vendors to access, configure, 132 
demonstrate, and provide training for each of the implemented products. The IdAM network 133 
contains the central IdAM components of the build (described below). The IT, OT, and PACS 134 
networks contain the representative components of a typical electric utility enterprise, as 135 
described below. 136 
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 137 

138 
  139 

Figure 3. Build Network 140 

The IdAM network (Figure 4 and Figure 5) contains the central IdAM components for Build #1 141 
and Build #2. The IdAM components are placed into a separate network to highlight the 142 
importance of protecting these assets and to simplify the demonstration of their capabilities.143 
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 144 

Figure 4. Build #1 IdAM Network 145 

Build #1 uses the CA Identity Manager product for the IdAM system and identity store. 146 
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 147 

Figure 5. Build #2 IdAM Network148 
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Build #2 uses the RSA IMG and Adaptive Directory products for the IdAM system and identity 149 
store. 150 

The IT network (Figure 6) contains the components common in the business operations IT 151 
networks/systems in all organizations. 152 

 153 

Figure 6. IT Network 154 

The OT network (Figure 7) contains the OT components, which include representative 155 
components found in electric utility OT networks/systems. These components were chosen to 156 
demonstrate the integration capabilities of the central IdAM capability. The lab did not attempt 157 
to replicate a fully operational OT network or set of systems. Because we had a limited number 158 
of remote terminal units (RTUs) available, we used Raspberry Pi on the network to emulate an 159 
RTU.160 
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 161 

Figure 7 OT Network 162 
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The PACS network (Figure 8) contains the PACS components, which include representative 163 
components found in electric utility physical access control systems. These components were 164 
chosen to demonstrate the integration capabilities of the central IdAM capability.  165 

 166 

Figure 8 PACS Network 167 
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2.3  IP NETWORK ADDRESS ASSIGNMENTS 168 

Table 2 includes the IP address assignments used for the builds. 169 

Table 2 Build IP Address Assignments 170 

DMZ 
Network IP 

System Vendor Access 
Network 

System IdAM Mgmt 
IP Network IP 

System 

10.32.2.0/25 Subnet 10.32.2.128/25 Subnet 172.16.4.0/24 Subnet 
10.32.2.1 NCCoE 

FW/Gateway 
10.32.2.129 NCCoE 

FW/Gateway 
172.16.4.1 IdAM FW 

LAN 
10.32.2.10 Vcenter 10.32.2.130 Vendor AD 172.16.4.2 RSA IMG 
10.32.2.11 ESXi #1 10.32.2.131 Vendor RDS 172.16.4.3 RSA 

Adaptive 
Directory 

10.32.2.12 ESXi #2 10.32.2.132 RSA/SCE 172.16.4.5 AlertEnter
prise 

10.32.2.22 Border FW 
WAN 

10.32.2.133 AlertEnt 172.16.4.9 Ozone  
Console 

10.32.2.50 RS1 FTP 
Synology 

10.32.2.134 CA 172.16.4.10 Ozone 
Server 

10.32.2.X Veam Backup 
Server 

10.32.2.135 RADiFlow 172.16.4.11 Ozone 
Authority 

    10.32.2.136 MAG  172.16.4.12 Ozone 
Envoy 

    10.32.2.137 TDi 172.16.4.13 Ozone PPA 
    10.32.2.232 Border FW 

OPT1 
172.16.4.15 CA IM 

        172.16.4.22 Microsoft 
SQL 

        172.16.4.253 CentOS 
DNS 

 171 

  172 

http://nccoe.nist.gov/#Systems!A1
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Table 2. (cont.) Build IP Address Assignments 173 

IT Network 
IP 

System PAC Network 
IP 

System OT Network 
IP 

System 

172.16.5.0/
24 

subnet 172.16.7.0/25 Subnet 172.16.6.0/25 Subnet 

172.16.5.1 IT FW LAN 172.16.7.1 PACS FW 
LAN 

172.16.6.1 OT FW LAN 

172.16.5.2 IT AD, DNS, 
CA 

172.16.7.2 PACS AD, 
DNS, CA 

172.16.6.2 OT AD, DNS, 
CA 

172.16.5.6 Workstation 172.16.7.5 n/a 172.16.6.4 RADiFlow 
FW/SW 

172.16.5.7 Workstation 172.16.7.6 XTEC XNode 172.16.6.5 Schneider 
Firewall 

  172.16.7.11 PACS 
Console 

172.16.6.6 Workstation 

    172.16.7.15 PACS 
Workstation 

172.16.6.8 TDi 
ConsoleWorks 

    172.16.7.101 LAB Door 
Controller 

172.16.6.100 RADiFlow 
Terminal 

Server for SEL 
      172.16.6.202 RADiFlow 

Vendor Host 
 174 

3 BUILD INFRASTRUCTURE 175 

3.1 OPERATING SYSTEMS 176 

All machines used in the build had one of the following operating systems (OS) installed: 177 

• Windows 7 enterprise 178 
• Windows server 2008 R2 179 
• Windows server 2012 R2 180 
• MicroFocus SUSE Linux Enterprise Server 11 181 
• CentOS 7.  182 

 Windows Installation and Hardening Details 3.1.1183 
The NCCoE Windows OS images are derived from the Department of Defense (DoD) Security 184 
Technical Implementation Guide (STIG) images. The Windows systems were installed using 185 
installation files provided by the Defense Information Systems Agency (DISA). These images 186 
were chosen because they are standardized, hardened, and fully documented. The STIG 187 
guidelines are available on-line at http://iase.disa.mil/stigs/os/Pages/index.aspx. 188 

mailto:%20Energy_NCCoE@nist.gov
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Modifications to the STIG compliant OS configurations were required for each product to enable 189 
its operation. The compliance results in Section 17 identify the specific OS configuration 190 
modifications (noncompliant configuration items) needed in each case. 191 

 SUSE Linux Enterprise Server 11 Installation and Hardening Details 3.1.2192 
The SUSE OS was included as part of the virtual appliance image provided by RSA for the IMG 193 
product. The center did not make any OS configuration changes. The OS was not configured to 194 
meet the DoD CentOS 6 STIG. The STIG guidelines are available on-line at 195 
http://iase.disa.mil/stigs/os/Pages/index.aspx. The OS configurations for SUSE Linux 196 
implementation are listed in Section 17. The compliance results report for SUSE Linux is 197 
included for illustration purposes, Section 20.2. 198 

 Base Linux Installation and Hardening Details 3.1.3199 
The NCCoE base Linux OS used in the build is CentOS 7. This OS is available as an open source 200 
image. The OS was configured to meet the DoD CentOS 6 STIG, because no CentOS 7 STIG was 201 
available at the time the build was implemented. The STIG guidelines are available on-line at 202 
http://iase.disa.mil/stigs/os/Pages/index.aspx. The OS configurations for each Linux 203 
implementation are listed in section 17. The compliance results reports identify the 204 
configuration items that do not conform to the STIG configuration guide. 205 

3.2 FIREWALL CONFIGURATIONS 206 

The firewalls were deployed to minimize the allowed traffic among the silo networks as well as 207 
to minimize traffic received from the DMZ and the public Internet. The goal was to limit the 208 
cross-network traffic/connections to only those required to support the use case. 209 

The following firewall configurations include the rules that were implemented in each of the 210 
firewalls for the build implementation. These configurations are provided to enable the reader 211 
to reproduce the traffic filtering/blocking that was achieved in the build implementation.  212 

https://nistgov.sharepoint.com/sites/nccoe/Energy/Shared%20Documents/IdAM%20Practice%20Guide/Drafts/NIST_SP1800-2c_ES_IDAM-HowTo.docx
http://www.nist.gov/
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Table 3. Border Firewall Rules 213 

Aliases   
Name Values Description    
VirtualInfra 10.32.2.10-12 Virtualization Systems for Build    
VPNserver 172.16.7.253 VPN Server    
       WAN Interface 

Allow/Deny Protocol Source Port Destination Port Description 
Allow IPv4 – All 10.32.2.0/25 Any Any Any Allow all management 

network traffic 
Allow IPv4 – All 10.255.2.0/25 Any Any Any Center VPN to all 

systems 
Allow IPv4 – TCP Any Any WAN Address 80 Allow access to 

WebGUI pfSense 
Allow IPv4 – TCP 10.255.2.0/25 Any 172.16.4.8 5176 Center VPN to 

Consoleworks 
Allow IPv4 – TCP 10.255.2.0/25 Any 172.16.4.8 443 Center VPN to 

Consoleworks HTTPS 
Deny IPv4 – TCP Any Any WAN Address Any Block All access to 

pfSense 
Allow IPv4 – TCP Any Any 172.16.7.110 3389 RDP to Lab-PC on 

PACS (Backups) 
         214 
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Table 4. Border Firewall Rules (continued) 215 

LAN Interface 
Allow/Deny Protocol Source Port Destination Port Description 
Allow IPv4 – All 172.16.7.135 Any VirtualInfra Any Lab laptop to 

Virtualization 
Deny IPv4 – All Any Any VirtualInfra Any Block all to 

Virtualization 
Deny IPv4 – TCP 172.16.8.0/24 Any 10.32.2.0/25 Any Block Vendor VPN from 

Management 
Deny IPv4 – TCP 10.32.2.128/25 Any 10.32.2.0/25 Any Block Vendor VPN from 

Management 
Allow IPv4 – All LAN Net Any Any Any Default Allow Any LAN 
Allow IPv6 – All LAN Net Any Any Any Default Allow Any LAN 
Allow IPv4 – TCP 172.16.7.128/25 Any 10.32.2.117 3389 RDP to 117 
Allow IPv4 – UDP 172.16.7.128/25 Any 10.32.2.117 3389 RDP to 117 
Deny IPv4 – All Any Any Any Any Block IPv4 
Deny IPv6 – All Any Any Any Any Block IPv6 

  216 
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Table 5. IdAM Firewall Rules 217 

Aliases    
Name Values Description    

AD_DCs_All 172.16.{5,6,7},2 All DCs in 
Infrastructure 

   

LinuxSystems 172.16.4.{2,3,8,1
0,11,12,253} 

Used for SSH    

MAG_Linux 172.16.4.{10,11,
12} 

Systems for MAG    

       WAN Interface 
Allow/Deny Protocol Source Port Destination Port Description 

Allow IPv4 – All 10.32.2.0/25 Any Any Any Allow all management network traffic 
Allow IPv4 – All 10.255.2.0/25 Any Any Any Center VPN to all systems 
Allow IPv4 – TCP 172.16.7.133 Any Any Any IT to IdAm 
Allow IPv4 – TCP Any Any LinuxSystems IMG Allow SSH to Linux 
Allow IPv4 – All Any Any 172.16.4.8 161,162,514

,5176 
Allow SNMP, Syslog, default to TDi 

Allow IPv4 – All AD_DCs_All Any 172.16.4.15 Any AD DCs to IdAM-CA 
Allow IPv4 – All 172.16.8.50 Any 172.16.4.15,22 Any CA to CA_srv12, CA_SQL_srv12 
Allow IPv4 – TCP Any Any 172.16.4.2 5900-5910 VNC to IMG 
Allow IPv4 – TCP 172.16.7.2 Any 172.16.4.2 Any PACS AD to IMG 
Allow IPv4 – TCP 172.16.7.2 Any 172.16.4.3 Any PACS AD to Adaptive Directory 
Allow IPv4 – TCP 10.32.2.0/25 Any 172.16.4.8 517, 6443 MGMT to TDi Consoleworks 

       LAN Interface 
Allow/Deny Protocol Source Port Destination Port Description 

Allow IPv4 – All LAN Net Any Any Any Default Allow Any LAN 
Allow IPv6 – All LAN Net Any Any Any Default Allow Any LAN 

Table 6. IT Firewall Rules 218 

Aliases     
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Name Values Description     
Alert_Enterprise 172.16.4.5 AlertEnterprise     

CA 172.16.4.15 CA     
CA_RSA_Alert 172.16.4.{2,3,5,15}, 

172.16.7.132 
CA, RSA, Alert     

ConsoleWorks 172.15.4.8 Console Works     
IT_Network 172.16.7.132 IT network     

LinuxSystems 172.16.5.4 All Linux on IT     
Ozone 172.16.4.10-12 Ozone products     

RSA 172.16.4.2-3 IMG, Adaptive 
Dir 

    

       WAN Interface 
Allow/Deny Protocol Source Port Destination Port Description 

Allow IPv4 – All 10.32.2.0/25 Any Any Any Allow all management network traffic 
Allow IPv4 – TCP 172.16.7.132 Any Any Any IdAM to IT 
Allow IPv4 – TCP Any Any LinuxSystems 22 Allow SSH to Linux 
Allow IPv4 – All Any Any 172.16.5.2 53 Allow DNS 
Allow IPv4 – TCP IT_Network Any 172.16.5.4 25443 Alert to ITEMAIL 
Allow IPv4 – TCP ConsoleWorks Any LAN net 22,161-162 TDI to IT-Net 
Allow IPv4 – TCP CA_RSA_Alert Any 172.16.5.2 389, 636 LDAP/LDAPS to AD 

       LAN Interface 
Allow/Deny Protocol Source Port Destination Port Description 

Allow IPv4 – All LAN Net Any Any Any Default Allow Any LAN 
Allow IPv6 – All LAN Net Any Any Any Default Allow Any LAN 

 219 

Table 7. OT Firewall Rules 220 

Aliases     

Name Values Description     
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LinuxSystems 172.16.6.7 All Linux on OT     

RADiFlow 172.16.6.{4,6,202} All RADiFlow IPs     

       
WAN Interface 

Allow/Deny Protocol Source Port Destination Port Description 
Allow IPv4 – All 10.32.2.0/25 Any Any Any Allow all management network 

traffic 
Allow IPv4 – TCP Any Any 172.16.6.10 22 SSH to RPi RTU 
Allow IPv4 – TCP Any Any LinuxSystems 22 Allow SSH to Linux 
Allow IPv4 – All Any Any 172.16.6.2 53 Allow DNS 
Allow IPv4 – All 172.16.4.8 Any LAN net 22,161-

162 
TDI to OT-Net 

Allow IPv4 – TCP Any Any 172.16.6.2 389, 636 Any LDAP to AD 
Allow IPv4 – TCP 172.16.4.{2,3,15} Any 172.16.6.2 Any AdaptiveDir, IMG, CA IM to AD 
Allow IPv4 – TCP Any Any 172.16.6.100 2001-

2101 
Telnet Access through RADiFlow 

       
LAN Interface 

Allow/Deny Protocol Source Port Destination Port Description 
Allow IPv4 – All LAN Net Any Any Any Default Allow Any LAN 
Allow IPv6 – All LAN Net Any Any Any Default Allow Any LAN 

 221 

  222 
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Table 8. PACS Firewall Rules 223 

Aliases    

Name Values Description    

VirtualInfra 10.32.2.10-12 Virtualization Systems 
for Build 

   

       
WAN Interface 

Allow/Deny Protocol Source Port Destination Port Description 
Allow IPv4 – All 10.32.2.0/25 Any Any Any Allow all management network 

traffic 
Allow IPv4 – All 172.16.7.132 Any 172.16.7.{2,11} Any IdAM to PACS-Console, PACSDC 
Allow IPv4 – TCP Any Any 172.16.7.2 389, 636 Any LDAP to AD 
Allow IPv4 – All Any Any 172.16.7.2 53 Allow DNS 
Allow IPv4 – All 172.16.4.8 Any LAN net 22,161-

162 
TDI to PACS-Net 

Allow IPv4 – TCP 172.16.4.{2,3,15} Any 172.16.7.2 Any AdaptiveDir, IMG, CA IM to AD 
Allow IPv4 – TCP Any Any 172.16.7.110 3389 MRDP Nat to LAB Machine PACS 

       
LAN Interface 

Allow/Deny Protocol Source Port Destination Port Description 
Allow IPv4 – All LAN Net Any Any Any Default Allow Any LAN 
Allow IPv6 – All LAN Net Any Any Any Default Allow Any LAN 

 224 
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3.3 NETWORK SERVICES 225 

Microsoft Active Directory was used to provide directory services in each silo networks (OT, 226 
PACS, IT). Linux CentOS 7 was used to provide DNS services in the IdAM network. Microsoft 227 
Windows Server was used to provide certificate authority services in each network. 228 

 IT Network – Network Services (AD and Certificate Authority) Installation and Configuration Settings 3.3.1229 

 Active Directory 3.3.1.1230 

Use these basic domain controller configuration settings:  231 
• Hostname: ITDC 232 
• Domain: ES-IDAM-B1.TEST 233 
• IP: 172.16.5.2 234 

Step-by-step instructions: 235 

1. Launch Server Manager. 236 

2. From the dashboard, select Option 2, Add Roles and Features. 237 

3. Select Role-based or Feature-based installation. 238 

4. From the server pool, select the local server named ITDC. 239 

5. Select Active Directory Domain Service and DNS Server. 240 

6. When prompted to add features, select Add Features for each role. 241 

7. Wait for Server Manager to finishes installing,  242 

8. Select Post-Deployment Configuration for Active Directory from the Task menu.  243 

9. After Active Directory Domain Services Configuration Wizard automatically launches.  244 

• Select Add a New Forest deployment operation. 245 

• Specify ES-IDAM-B1.TEST root domain, then select Next >. 246 

• Select Windows Server 2012 R2 for both the Forest Functional Level and the 247 
Domain Functional Level, 248 

• Under Domain Controller Capabilities:  249 

o Check both DNS server and Global Catalog.  250 

o Uncheck read-only domain controller. 251 

o Specify a password for DSRM and select Next >. 252 

• Continue through the Wizard without modifying any options.  253 

• Select Install on the next window. After installation, the server automatically 254 
reboots. 255 

 Certificate Authority Role 3.3.1.2256 
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• Use these basic certificate authority configuration settings: CA Setup Type: 257 
Enterprise CA 258 

• CA Type: Root CA 259 
• Cryptographic options: RSA 2048 and SHA1 260 
• CN: IT-ES-IDAM-B1-IDAM-ITDC 261 
• DN suffix: DC=IT-ES-IDAM-B1, DC=TEST 262 

Step-by-step instructions: 263 

1. From the Server Manager dashboard, select Option 2, Add Roles and Features. 264 

2. Select Role-based or Feature-based installation (this is a single option to choose). 265 

3. From the server pool, select the local server named OTDC. 266 

4. Select Active Directory Certificate Services. 267 

5. When prompted to add features, select Add Features. 268 

6. When prompted to select roles services, check Certificate Authority. 269 

7. After the Server Manager finishes installing, select Post-deployment Configuration for 270 
Certificate Services from the Task menu. 271 

8. When prompted to specify setup type, select Enterprise CA. 272 

9. When prompted to specify CA type, select Root CA. 273 

10. When prompted to specify private key, select Create a new private key. 274 

11. When prompted to specify cryptographic options, select RSA with a key length of 2048 275 
and select SHA1 for the hash algorithm. 276 

12. Leave the CN and DN suffix, which should be based on the computers hostname and 277 
domain. 278 

13. Select 5 years for certificate validity period. 279 

14. Leave the default options for the certificate database and log location. 280 

15. After configuration is complete, restart the server. 281 

 OT Network – Network Services (AD, DNS Server, and Certificate Authority) Installation and 3.3.2282 
Configuration Settings 283 

 Active Directory Domain Services and DNS Server  3.3.2.1284 

• Use these basic certificate authority configuration settings:Hostname: OTDC 285 
• Domain: OT-ES-IDAM-B1.TEST 286 
• IP: 172.16.6.2 287 

Step-by-step instructions: 288 

1. Launch Server Manager. 289 
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2. From the dashboard, select Option 2, Add Roles and Features. 290 

3. Select Role-based or Feature-based installation. 291 

4. From the server pool, select the local server named OTDC. 292 

5. Select Active Directory Domain Service and DNS Server. 293 

6. When prompted to add features, select Add Features for each role. 294 

7. After the Server Manager finishes installing, select Post-deployment Configuration for 295 
Active Directory from the Task menu. 296 

8. The Active Directory Domain Services Configuration Wizard launches:  297 

• For the deployment operation, select Add a New Forest.  298 

• For the root domain, specify OT-ES-IDAM-B1.TEST, then select Next >. 299 

• For both the Forest Functional Level and the Domain Functional Level, select 300 
Windows Server 2012 R2.  301 

• Under Domain Controller Capabilities:  302 

o Check both DNS server and Global Catalog. 303 

o Uncheck read-only domain controller. 304 

o Specify a password for DSRM and select Next >. 305 

• Continue through the wizard without modifying any options.  306 

• On the last page, select Install. After installation, the server automatically 307 
reboots. 308 

 Certificate Authority Role 3.3.2.2309 

• Use these basic certificate authority configuration settings:CA Setup Type: 310 
Enterprise CA 311 

• CA Type: Root CA 312 
• Cryptographic options: RSA 2048 and SHA1 313 
• CN: OT-ES-IDAM-B1-IDAM-OTDC 314 
• DN suffix: DC=OT-ES-IDAM-B1, DC=TEST 315 

Step-by-step instructions: 316 

1. Ensure the domain controller installation has been completed before proceeding. 317 

2. From the Server Manager dashboard, select Option 2, Add Roles and Features. 318 

3. Select Role-based or Feature-based installation (this is a single option to choose) 319 

4. From the server pool, select the local server named OTDC. 320 

5. Select Active Directory Certificate Services. 321 

6. When prompted to add features, select Add Features. 322 
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7. When prompted to select roles services, check Certificate Authority. 323 

8. After the Server Manager finishes installing, select Post-deployment Configuration for 324 
Certificate Services from the Task menu. 325 

9. When prompted to specify setup type, select Enterprise CA. 326 

10. When prompted to specify CA type, select Root CA. 327 

11. When prompted to specify a private key, select Create a new private key. 328 

12. When prompted to specify cryptographic options, select RSA with a key length of 2048 329 
and select SHA1 for the hash algorithm. 330 

13. Leave the CN and DN suffix, which should be based on the computer’s hostname and 331 
domain. 332 

14. Select 5 years for certificate validity period. 333 

15. Leave the default options for the certificate database and log location. 334 

16. After configuration is complete, restart the server. 335 

 PACS Network – Network Services: AD, DNS Server, and Certificate Authority Installation and 3.3.3336 
Configuration Setting 337 

 Active Directory Domain Services and DNS Server  3.3.3.1338 

Use these basic domain controller configuration settings:  339 
• Hostname: PACSDC 340 
• Domain: PACS-ES-IDAM-B1.TEST 341 
• IP: 172.16.7.2 342 

Step-by-step instructions: 343 

1. Launch Server Manager. 344 

2. From the dashboard, select Option 2, Add Roles and Features. 345 

3. Select Role-based or Feature-based installation (this is a single option to choose). 346 

4. From the server pools, select the local server named PACSDC. 347 

5. Select Active Directory Domain Service and DNS Server. 348 

6. When prompted to add features, select Add Features for each role. 349 

7. After the Server Manager finishes installing, select Post-deployment Configuration for 350 
Active Directory from the Task menu. 351 

8. The Active Directory Domain Services Configuration Wizard launches:  352 

• Select Add a new forest for the deployment operation. Specify PACS-ES-IDAM-353 
B1.TEST for the root domain, then select Next. 354 
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• Select Windows Server 2012 R2 for both the forest functional level and the 355 
domain functional level. 356 

• Under domain controller capabilities:  357 

o Check both DNS server and Global Catalog. 358 

o Uncheck read-only domain controller. 359 

o Specify a password for DSRM and select Next >. 360 

• Continue through the Wizard without modifying any options.  361 

• On the last page, select Install. After installation, the server automatically 362 
reboots. 363 

 Installation of Certificate Authority Role on the PACS network 3.3.3.2364 

Use these basic domain controller configuration settings:  365 
• CA Setup Type: Enterprise CA 366 
• CA Type: Root CA 367 
• Cryptographic options: RSA 2048 and SHA1 368 
• CN: PACS-ES-IDAM-B1-IDAM-PACSDC 369 
• DN suffix: DC=PACS-ES-IDAM-B1, DC=TEST 370 

Step-by-step instructions: 371 

1. From the Server Manager dashboard, select the Option 2, Add Roles and Features. 372 

2. Select Role-based or Feature-based installation. 373 

3. From the server pools, select the local server named OTDC. 374 

4. Select Active Directory Certificate Services. 375 

5. When prompted to add features, select Add Features. 376 

6. When prompted to select roles services, check Certificate Authority. 377 

7. After the Server Manager finishes installing, select Post-deployment Configuration for 378 
Certificate Services from the Task menu. 379 

8. When prompted to specify setup type, select Enterprise CA. 380 

9. When prompted to specify CA type, select Root CA. 381 

10. When prompted to specify private key, select Create a new private key. 382 

11. When prompted to specify cryptographic options, select RSA with a key length of 2048 383 
and select SHA1 for the hash algorithm. 384 

12. Leave the CN and DN suffix, which should be based on the computer’s hostname and 385 
domain. 386 

13. Select 5 years for certificate validity period. 387 
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14. Leave the default options for the certificate database and log location. 388 

15. After configuration is complete, restart the server. 389 

 Modify the AD Lightweight Directory Access Protocol (LDAP) schema with custom PACS 3.3.3.3390 
attributes. 391 

Custom attribute details:  392 

• Common Name: pacsAllDoors 393 
• X.500 OID: 1.3.6.1.4.1.4203.666.1 394 
• Syntax: Boolean 395 
• Common Name: pacsHomeAccess 396 
• X.500 OID: 1.3.6.1.4.1.4203.666.2 397 
• Syntax: Boolean 398 
• Common Name: pacsWorkAccess 399 
• X.500 OID: 1.3.6.1.4.1.4203.666.3 400 
• Syntax: Boolean 401 

Step-by-step instructions: 402 

1. Launch Command Prompt as an administrator. 403 

2. Run the command: regsvr32 schmgmt.dll 404 

3. Launch the Microsoft Management Console. 405 

4. Select File > Add/Remove Snap-in. 406 

5. From the Snap-in menu, select Active Directory Schema, then select OK. 407 

6. Expand the Active Directory Schema, then select Attributes. 408 

7. To create an attribute for the all doors access level, right-click on Attributes, then select 409 
Create Attribute. 410 

8. Select OK when prompted with the Schema Object Creation Warning. 411 

9. Enter the following fields: 412 

• Common Name: pacsAllDoors 413 

• LDAP Display Name: pacsAllDoors 414 

• Unique X500 Object ID: 1.3.6.1.4.1.4203.666.1 415 

• Syntax: Boolean 416 

10. Select OK when finished. 417 

11. Create an attribute for the home access level by entering the following fields: 418 

• Common Name: pacsHomeAccess 419 

• LDAP Display Name: pacsHomeAccess 420 
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• Unique X500 Object ID: 1.3.6.1.4.1.4203.666.2 421 

• Syntax: Boolean 422 

12. Create an attribute for the work access level by entering the following fields: 423 

• Common Name: pacsWorkAccess 424 

• LDAP Display Name: pacsWorkAccess 425 

• Unique X500 Object ID: 1.3.6.1.4.1.4203.666.3 426 

• Syntax: Boolean 427 

13. After creating custom attributes, add the attributes to the user class so that every user 428 
contains the attribute: 429 

• Select the Classes drop-down under Active Directory Schema. 430 

• Right-click on User, then select Properties. 431 

• Select the Attributes tab, then select Add. 432 

• Select the attribute you want to add to the user class. Then select OK. Do this for 433 
the pacsAllDoors, pacsHomeAccess and pacsWorkAccess attributes. 434 

• Then select Apply and OK. 435 

• Restart the server. 436 

 IdAM Network – Network Services (DNS Server) Installation and Configuration Settings 3.3.4437 
A Linux CentOS 7 DNS server was established on the IdAM network to provide DNS services to 438 
the IdAM components. No other network service was installed in the IdAM network. 439 

System Environment Settings 440 

• CentOS 7 441 
• VM with 4 CPU Quad Core 2.199GHz. 442 
• VM with 16384MB of memory. 443 
• Virtual Hard Disk containing 98GB of storage. 444 

Linux CentOS DNS Configuration 445 

Basic DNS configuration settings are specified using three different system files that are located 446 
in the /etc and /var subdirectories of the root directory as follows. 447 

 System file 1 – named.conf in the /etc subdirectory 3.3.4.1448 

// 449 

// named.conf 450 

// 451 
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// Provided by Red Hat bind package to configure the ISC BIND named(8) DNS 452 

// server as a caching only nameserver (as a localhost DNS resolver only). 453 

// 454 

// See /usr/share/doc/bind*/sample/ for example named configuration files. 455 

// 456 

  457 

options { 458 

 listen-on port 53 { 127.0.0.1; 172.16.4.253; }; 459 

 #listen-on-v6 port 53 { ::1; }; 460 

 #listen-on-v6 { none; }; 461 

 directory  "/var/named"; 462 

 forwarders { 8.8.8.8; 8.8.4.4; }; 463 

 dump-file  "/var/named/data/cache_dump.db"; 464 

 statistics-file "/var/named/data/named_stats.txt"; 465 

 memstatistics-file "/var/named/data/named_mem_stats.txt"; 466 

 allow-query  { localhost; 172.16.4.0/22; }; 467 

 allow-transfer { localhost; 172.16.4.0/22; }; 468 

 469 

 /*  470 

  - If  you are building an AUTHORITATIVE DNS server, do NOT enable 471 
recursion. 472 

  - If  you are building a RECURSIVE (caching) DNS server, you need to 473 
enable  474 

  recursion.  475 

  - If  your recursive DNS server has a public IP address, you MUST enable 476 
access  477 

  control to limit queries to your legitimate users. Failing to do so will 478 

  cause your server to become part of  large scale DNS amplification  479 

  attacks. Implementing BCP38 within your network would greatly 480 

  reduce such attack surface  481 

 */ 482 

 recursion yes; 483 

 484 

 dnssec-enable yes; 485 
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 dnssec-validation yes; 486 

 dnssec-lookaside auto; 487 

 488 

 /* Path to ISC DLV key */ 489 

 bindkeys-file "/etc/named.iscdlv.key"; 490 

 491 

 managed-keys-directory "/var/named/dynamic"; 492 

 493 

 pid-file "/run/named/named.pid"; 494 

 session-keyfile "/run/named/session.key"; 495 

}; 496 

 logging { 497 

   channel default_debug { 498 

     file "data/named.run"; 499 

     severity dynamic; 500 

   }; 501 

 }; 502 

 503 

 zone "." IN { 504 

  type hint; 505 

  file "named.ca"; 506 

 }; 507 

 508 

 zone "idam-es-idam-b1.test" IN { 509 

 type master; 510 

 file "idam-es-idam-b1.test"; 511 

 allow-update { none; } ; 512 

 }; 513 

 514 

 zone "4.16.172.in-addr.arpa" IN { 515 

  type master; 516 

  file "4.16.172.db"; 517 

  allow-update { none; }; 518 
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 }; 519 

 520 

 zone "ot-es-idam-b1.test" IN { 521 

 type slave; 522 

 masters { 523 

  172.16.6.2; 524 

  }; 525 

 forwarders {}; 526 

 }; 527 

  528 

 zone "pacs-es-idam-b1.test" IN { 529 

 type slave; 530 

 masters { 531 

  172.16.7.2; 532 

  }; 533 

 forwarders {}; 534 

 }; 535 

 536 

 zone "es-idam-b1.test" IN { 537 

 type slave; 538 

 masters { 539 

  172.16.5.2; 540 

  }; 541 

 forwarders {}; 542 

 }; 543 

  544 

 545 

include "/etc/named.rfc1912.zones"; 546 

include "/etc/named.root.key"; 547 

 System file 2 – 4.16.172.db in the /var subdirectory 3.3.4.2548 
$TTL 86400 549 
@ IN SOA idam-dns.idam-es-idam-b1.test. root.idam-es-idam-b1.test. ( 550 
 2011071001 ;Serial 551 
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 3600 ;Refresh 552 
 1800 ;Retry 553 
 604800 ;Expire 554 
 86400 ;Minimum TTL 555 
) 556 
@ IN NS idam-dns.idam-es-idam-b1.test. 557 
@ IN PTR idam-es-idam-b1.test. 558 
idam-dns IN A 172.16.4.253 559 
 560 
 561 
101 IN PTR idam-dns.idam-es-idam-b1.test. 562 
System file – idam-es-idam-b1.test in the /etc subdirectory 563 
 564 
$TTL 86400 565 
@ IN SOA idam-dns.idam-es-idam-b1.test. root.idam-es-idam-b1.test. ( 566 
  2011071001 ;Serial 567 
  3600 ;Refresh 568 
  1800 ;Retry 569 
  604800 ;Expire 570 
  86400 ;Minimum TTL 571 
) 572 
 573 
@  IN NS idam-dns.idam-es-idam-b1.test. 574 
@  IN A 172.16.4.253 575 
idam-dns IN A 172.16.4.253 576 
idam-ca  IN A 172.16.4.15 577 
idam-sql IN A 172.16.4.22 578 
adaptivedir IN A 172.16.4.3 579 
img  IN A 172.16.4.2 580 
consoleworks IN A 172.16.4.8 581 
ozoneserver IN A 172.16.4.10 582 
ozoneenvoy IN A 172.16.4.12 583 
ozoneauthority IN A 172.16.4.11 584 
alertent IN A 172.16.4.5 585 

WIN-IPERGL2ELUD IN A 172.16.4.5 586 
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4 REMOTE TERMINAL UNITS (RTUS) 587 

Remote terminal units (RTU) provide the cyberspace to physical interface. Remote terminal 588 
units are used to collect data such as voltage, current and phase from substation equipment. 589 
They are also used to deliver commands via contact closures or output voltage to change device 590 
operations such as switches, circuit breakers or capacitors. 591 

4.1 TCP/IP RTU 592 

The TCP/IP RTU in this build is emulated with a RaspberryPi 2 system. The system was 593 
developed to simulate a Modbus protocol programmable logic controller (PLC).  594 

4.2 SERIAL RTU 595 

The serial RTU in this build is a Schweitzer Engineering Laboratory SEL-2411 programmable 596 
automation controller configured to support the Modbus protocol. It is connected to the 597 
RADiFlow ICS Firewall via serial interface. 598 

5 IDENTITY SERVICES ENGINE (ISE) AND TRUSTSEC ENABLED SWITCH: CISCO 599 

Cisco Identity Services Engine (ISE) controls the ability of devices to connect over the network. 600 
ISE expands on basic network address-based control to include the identity of the person using 601 
a device. ISE is used in the builds to provide a gateway function between IT and OT, limiting 602 
which users and devices are allowed to connect from IT to resources in OT. 603 

The Cisco ISE component should be installed in a virtual machine (VM) on the IT network. This 604 
ISE component will be used in conjunction with the TrustSec switch that is located on the IT 605 
network to control access from the IT network to the OT network. 606 

5.1 SECURITY CHARACTERISTICS 607 

Cybersecurity Framework Category: PR.PT-3: Access to systems and assets is controlled, 608 
incorporating the principle of least functionality 609 

NIST 800-53 rev 4 Security Controls: AC-3, CM-7 610 

5.2 PRE-INSTALLATION TASK 611 

1. Obtain OVA file from Cisco for Cisco ISE 1.4. 612 
2. Place OVA file in Datastore for vSphere installation. 613 
3. Ensure that the user domain has a security group (the build used OTAccess) for 614 

determining access to the OT network. 615 
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5.3 INSTALL AND CONFIGURE 616 

1. Follow the guide located at: http://www.cisco.com/c/en/us/td/docs/security/ise/1-617 
4/installation_guide/b_ise_InstallationGuide14/b_ise_InstallationGuide14_chapter_010618 
0.html 619 

● This is the Cisco Identity Services Engine Hardware Installation Guide, Release 620 
1.4, section on Installing ISE on a VMware Virtual Machine. 621 

● To deploy the OVA file, follow the instructions at the heading “Installing Cisco ISE 622 
on Virtual Machines.” 623 

● After OVA is deployed, follow instructions at heading “Installing Cisco ISE 624 
Software on a VMware System.”  625 

2. After the system is installed, type setup at the prompt. 626 
3. The following are prompts and build responses: 627 

● Enter hostname: ise 628 
● Enter IP address[]: 172.16.4.77 629 
● Enter IP netmask[]: 255.255.255.0 630 
● Enter IP default gateway[]: 172.16.4.1 631 
● Enter default DNS domain[]: idam-es-idam-b1.test 632 
● Enter primary nameserver[]: 172.16.4.253 633 
● Add secondary nameserver? Y/N[N]: <blank> 634 
● Enter NTP server[time.nist.gov]: 172.16.4.1 635 
● Add another NTP server? Y/N[N]: <blank> 636 
● Enter system time zone[UTC]: EST 637 
● Enable SSH service? Y/N [N]: Y 638 
● Enter username [admin]: admin 639 
● Enter password: <password> 640 
● Enter password again: <password> 641 

4. After ISE finishes the installation, connect to ISE through the web browser using the IP 642 
address specified during the setup phase. 643 

5. Begin the Setup Assistant. 644 
6. Select Wired for setup access services, and select the Enforce radio button. For subnets 645 

to protect, type the target network (in build, the OT network: 172.16.6.0/24). Press 646 
Next. 647 

7. Uncheck Cisco Unified IP Phone box 648 
Select AD group : es-idam-b1.test/Builtin/Users 649 
Leave the default checked boxes as is. 650 

8. Select Yes for authenticate users using Cisco ISE, select Join the Active Directory domain, 651 
and add domain credentials (in build, we used es-idam-b1.test for domain and the 652 
domain admin credentials to connect). Fill in the Employee Switched VLAN Interface box 653 
with: 172.16.5.0 /24.  Press Next. 654 
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9. Select switch (build used Cisco Catalyst 3560 Series Switches), fill in pertinent 655 
information for switch. For Employee VLAN ID, build used 104. Select a RADIUS Shared 656 
Secret (build used password). Press Next. 657 

10. Confirm all settings are correct, then select Confirm Configuration Settings. 658 

TrustSec switch configuration information: Taken from the Network Device Configuration tab in 659 
the Setup Assistant Review section, the recommended configurations to be set globally on the 660 
TrustSec-enabled switch are as follows: 661 

aaa new-model 662 
! 663 
aaa authentication dot1x default group radius 664 
aaa authorization network default group radius  665 
aaa authorization auth-proxy default group radius  666 
aaa accounting delay-start all 667 
aaa accounting auth-proxy default start-stop group radius 668 
aaa accounting dot1x default start-stop group radius 669 
aaa accounting network default start-stop group radius 670 
aaa server radius dynamic-author 671 
 client 172.16.4.77 server-key 7 15020A1F173D24362C 672 
! 673 
aaa session-id common 674 
switch 1 provision ws-c3650-48ps 675 
authentication mac-move permit 676 
ip routing 677 
! 678 
ip device tracking 679 
ip dhcp snooping vlan 102 680 
no ip dhcp snooping information option 681 
ip dhcp snooping 682 
dot1x system-auth-control 683 
! 684 
diagnostic bootup level minimal 685 
spanning-tree mode pvst 686 
spanning-tree extend system-id 687 
! 688 
redundancy 689 
 mode sso 690 
! 691 
! 692 
ip ssh version 2 693 
! 694 
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class-map match-any non-client-nrt-class 695 
 match non-client-nrt  696 
! 697 
policy-map port_child_policy 698 
 class non-client-nrt-class 699 
 bandwidth remaining ratio 10 700 
snmp trap mac-notification change added 701 
 spanning-tree portfast 702 
! 703 
ip access-list extended ACL-DEFAULT 704 
 remark Allow DHCP 705 
 permit udp any eq bootpc any eq bootps 706 
 remark Allow DNS 707 
 permit udp any any eq domain 708 
 permit icmp any any 709 
 permit tcp any host 172.16.4.77 eq 8443 710 
 permit tcp any host 172.16.4.77 eq 443 711 
 permit tcp any host 172.16.4.77 eq www 712 
 permit tcp any host 172.16.4.77 eq 8905 713 
 permit tcp any host 172.16.4.77 eq 8909 714 
 permit udp any host 172.16.4.77 eq 8905 715 
 permit udp any host 172.16.4.77 eq 8909 716 
 deny ip any any 717 
ip access-list extended ACL-WEBAUTH-REDIRECT 718 
 permit tcp any any eq www 719 
 permit tcp any any eq 443 720 
 deny ip any any 721 
! 722 
logging origin-id ip 723 
logging source-interface GigabitEthernet1/0/48 724 
! 725 
radius-server attribute 6 on-for-login-auth 726 
radius-server attribute 6 support-multiple 727 
radius-server attribute 8 include-in-access-req 728 
radius-server dead-criteria time 5 tries 3 729 
radius-server host 172.16.4.77 auth-port 1812 acct-port 1813 key 7 730 
140713181F13253920 731 
! 732 
radius server host 733 
! 734 
wsma agent exec 735 
 profile httplistener 736 
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 profile httpslistener 737 
wsma agent config 738 
 profile httplistener 739 
 profile httpslistener 740 
wsma agent filesys 741 
 profile httplistener 742 
 profile httpslistener 743 
wsma agent notify 744 
 profile httplistener 745 
 profile httpslistener 746 
! 747 
wsma profile listener httplistener 748 
 transport http 749 
! 750 
wsma profile listener httpslistener 751 
 transport https 752 
ap group default-group 753 
end 754 
 755 

For each interface that is to be controlled, the recommended configurations are as follows: 756 

interface GigabitEthernet1/0/10 757 
 switchport access vlan 101 758 
 switchport mode access 759 
 switchport block unicast 760 
 switchport voice vlan 105 761 
 ip arp inspection limit rate 2000 762 
 ip access-group ACL-DEFAULT in 763 
 authentication event fail action next-method 764 
 authentication event server dead action authorize vlan 101 765 
 authentication event server alive action reinitialize  766 
 authentication host-mode multi-auth 767 
 authentication open 768 
 authentication order dot1x mab 769 
 authentication priority dot1x mab 770 
 authentication port-control auto 771 
 authentication periodic 772 
 authentication timer reauthenticate server 773 
 authentication timer inactivity 180 774 
 authentication violation restrict 775 
 mab 776 



DRAFT 
   

41 | NIST Cybersecurity Practice Guide SP 1800-2c 
 

 dot1x pae authenticator 777 
 dot1x timeout tx-period 10 778 
 spanning-tree portfast 779 
 spanning-tree bpduguard enable 780 
 ip dhcp snooping limit rate 2048 781 
 782 

11. Go to the top tabs and click Administration > System > Deployment. (If a warning that 783 
says “This node is standby mode. To register other…Role to Primary” click OK.) Under 784 
the Deployment Nodes – Hostnames click on the ise link. Then click Profiling 785 
Configuration, and ensure that Netflow, Radius, DNS, SNMPQUERY, and SNMPTRAP are 786 
selected. If they are not selected, select them. Then click Save. 787 

12. Select Administration > Identity Management > External Identity Sources. In the frame 788 
on the left choose Active Directory, then choose ise.idam-es-idam-b1.test. Click 789 
Connections tab, select the checkbox next to the domain es-idam-b1.test. Check 790 
to see if there is a green check in the Status column. If yes click Save.  791 
If not, Click Join, and type in the AD Credentials and click Save. A green check 792 
should appear in the Status column.  793 

13. Select Administration > Identity Management > External Identity Sources > Groups tab. 794 
Click Add > Select Group From Directory. Click retrieve groups. Check the es-idam-795 
b1.test/Users/Domain Users box and the es-idam-b1.test/Builtin/Users box and the es-796 
idam-b1.test/Users/OTAccess box. These items are specified for protected access (the 797 
build used OTAccess). Then Click OK. Then click Save. Relogin as directed. 798 

14. Select Administration > System > Settings. Click on Policy Sets in the frame at the left of 799 
the screen, and click enabled (if it is not already clicked).  Click Save if needed. 800 

15. Select Policy > Policy Elements > Results. In the frame at the left of the screen, left 801 
column, click Authorization, then Downloadable ACL List. Create the following (all IP 802 
addresses are pertinent to the current build.; these addresses will need to be replaced 803 
with IP addressing that is appropriate to the target environment): 804 

o All_But_OT-Access-DACL  805 
 Name: All_But_OT-Access-DACL 806 
 DACL Content:  807 

deny ip any 172.16.6.0 0.0.0.255 808 
permit ip any any 809 

Click Save 810 
16. In the left column, select Authorization Profiles and click Add to create the 811 

following: 812 
o All_and_OT 813 

 Name: All_and_OT 814 
 Access Type: ACCESS_ACCEPT 815 
 Check DACL Name: PERMIT_ALL_TRAFFIC 816 

Click Submit 817 
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o All_But_OT_Access 818 
 Name: All_But_OT_Access 819 
 Access Type: ACCESS_ACCEPT 820 
 Check DACL Name: All_But_OT-Access-DACL 821 

Click Submit 822 
o DenyAccess 823 

 Name: DenyAccess 824 
 Access Type: ACCESS_REJECT 825 

Click Submit 826 
17. Select Policy > Policy Elements > Conditions. In the left column, select Authorization, 827 

then Simple Conditions. Click Add to create the following: 828 
o NotOTAccess 829 

 Name: NotOTAccess 830 
 Attribute: Select the domain (build uses es-idam-b1.test) > 831 

ExternalGroups 832 
 Operator: Not Equals 833 
 Value: Select the Security Group (build uses es-idam-834 

b1.test/Users/OTAccess) 835 
Click Submit 836 
o IT_DomainUsers 837 

 Name: IT_DomainUsers 838 
 Attribute: Select the domain (build uses es-idam-b1.test) > 839 

ExternalGroups 840 
 Operator: Equals 841 
 Value: Select domain users group (build uses es-idam-842 

b1.test/Users/Domain Users) 843 
Click Submit 844 

18. Select Policy > Policy Sets. Select Default and configure policies. Choose the arrow next 845 
to Authorization to expand the section. Choose the top rule and click the option arrow 846 
to the right of the Edit link within the policy. Click New rule above.  847 

o Rule 1: Click the plus sign in the Conditions box. Select Create New Condition 848 
(Advanced Option). Select Attribute > es.idam-b1.test > External Groups. Leave 849 
equals Select Attributes > es-idam-b1.test/Users/OTAccess. Click the plus sign in 850 
the Permissions box. Select item drop down choose Standard > All_and_OT. Click 851 
Done button on right. 852 
Click the arrow to the right of the Edit link within the top policy (new policy 853 
created above) Click Insert Below. 854 

o Rule 2: Click the plus sign in the Conditions box. Select Existing Condition from 855 
Library. Select arrow to choose simple conditions > NotOTAccess. Select arrow 856 
next to the gear icon (on right). Select Add Condition from Library. Select Arrow 857 
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to choose Simple conditions > IT_DomainUsers. Click on the Permissions input 858 
box. Click the plus sign in the Permissions box. Click the arrow and choose 859 
standard > All_But_OT_Access. Click Done. Click Save. 860 

6 IDENTITY MANAGER: CA TECHNOLOGIES (CA) INSTALLATION – BUILD #1 861 

CA Identity Manager implements the central IdAM workflow in Build #1. It receives input from 862 
an HR system in the form of .csv files. The access and authorization for each user is based on the 863 
business and security rules implemented in workflows within Identity Manager. The workflows 864 
include management approval chains as well as approval/denial data logging. Once Identity 865 
Manager has processed the access and authority request, the updated user access and 866 
authorization data is pushed to the central ID store. The central ID store contains the 867 
distribution mechanism for updating the various downstream (synchronized) directories with 868 
user access and authorization data. This process applies to new users, terminated users 869 
(disabled or deleted users), and any changes to a user profile. Changes include promotions, job 870 
responsibility changes, and any other change that would affect the systems a user needs to 871 
access. 872 

6.1 SECURITY CHARACTERISTICS 873 

Cybersecurity Framework Categories:  874 

• PR.AC-1: Identities and credentials are managed for authorized devices and users 875 
• PR.AC-4: Access permissions are managed, incorporating the principles of least privilege 876 

and separation of duties  877 

NIST 800-53 rev 4 Security Controls: AC-2, AC-3, AC-5, AC-6, AC-16, IA Family  878 

CA Identity Manager is installed on the IdAM network on a VM running the Windows Server 879 
2012 R2 OS. 880 
Important: The following instructions are for a single server demo environment and are not 881 
intended to be used for a production deployment. 882 
This guide walks you through a basic installation of CA Identity Manager on JBoss, on a single 883 
Windows server. For comprehensive instructions for installing CA Identity Manager, refer to the 884 
CA Identity Manager Installation Guide for JBoss at https://support.ca.com.  885 

6.2 INSTALLATION PREREQUISITES 886 

The following steps are required prior to the CA Identity Manager installation. (For supported 887 
versions of all software, review the CA Identity Manager Support Matrix at 888 
https://support.ca.com.) 889 

1. Use a server with a supported OS (e.g., Windows 2012 R2).  890 

2. Install a supported version of the JDK. (e.g., 1.7.0_71). 891 
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3. Install a supported version of JBoss. (e.g., jboss-eap-6.3). 892 

4. To install JBoss as a Windows service, follow the instructions at the following link: 893 
https://access.redhat.com/documentation/en-894 
US/JBoss_Enterprise_Application_Platform/6.3/html/Installation_Guide/Install_JBoss_En895 
terprise_Application_Platform_6_Microsoft_Windows_Service.html  896 

5. Create a Database and associated user with DBA permissions on a supported database 897 
(e.g., MSSQL 2012). 898 

6. Download and unzip CA Identity Manager software from https://support.ca.com.  899 

6.3 INSTALL CA DIRECTORY 900 

1. From the unzipped location, go to CADirectory_x64\dxserver\windows and execute 901 
dxsetup.exe. 902 

2. Select Typical installation. 903 

3. Uncheck “DXmanager will manage…” 904 

4. Accept all other defaults. 905 

6.4 INSTALL CA IDENTITY MANAGER 906 

1. From the unzipped location, execute ca-im-12.6.XX-win32.exe 907 

2. Select Components: deselect “Connect to Existing SiteMinder Policy Server” and 908 
“Extensions for Siteminder…”. Leave the rest of the checkboxes checked. 909 

3. Deployment Size: compact 910 

4. Provisioning Server Hostnames: Just click Next 911 

5. Provisioning Directory Information: enter a shared secret and confirmation. 912 

6. Destination Location: accept default 913 

7. FIPS Information: accept default 914 

8. Application Server Information: JBoss 915 

9. JBoss Application Server Information: Choose and locate the folder where JBoss is 916 
installed. Enter the fully qualified URL and Port for JBoss. Leave the Cluster fields blank. 917 

10. Select Java Virtual Machine: Click “Search for Others”. Select jdk1.7.0_71\bin\java.exe. 918 

11. Key Encryption Information: accept default 919 

12. Select Database Type: Select SQL 2005, 2008, or 2012 920 

13. Database Connection Information: Enter hostname, database and credentials as created 921 
in the prerequisites above. 922 

14. Login Information: Enter a username and password to be used for the Management 923 
Console. Leave the Enable Secure Login for Management Console checked 924 
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15. HTTP Proxy Settings: Leave blank 925 

16. Review Settings: Click Install 926 

17. After the installation completes, start JBoss by executing jboss-eap-927 
6.3\bin\standalone.bat. 928 

18. Review the log file to verify that JBoss started without error: jboss-eap-929 
6.3\standalone\log\server.log 930 

19. If you receive a timeout error such as “Timeout after [300] seconds waiting for service 931 
container stability…”, increase the timeout by modifying standalone.bat, adding the 932 
following attribute to the startup script:  933 
-Djboss.as.management.blocking.timeout=900 934 

6.5 CREATE THE SAMPLE NETEAUTO DIRECTORY 935 

1. Open a command prompt as the administrator user 936 
2. cd to “C:\Program Files (x86)\CA\Identity Manager\IAM Suite\Identity 937 

Manager\tools\samples\NeteAuto\Organization” 938 
o You will see several sample files. For this example, we will use neteauto.ldif 939 

3. Execute the following commands: 940 

dxnewdsa -s500 neteauto 3895 "dc=security,dc=com" 941 
dxserver install neteauto 942 
dxserver stop neteauto 943 
dxloaddb -v -s neteauto neteauto.ldif 944 
dxserver start neteauto 945 

4. To log in to the IM Management Console, navigate to 946 
http://<ServerName>:8080/iam/immanage and log in using the credentials you supplied 947 
in Login Information above. 948 

5. From Directories, select “Create or Update from XML”. 949 
6. Browse to C:\Program Files (x86)\CA\Identity Manager\IAM Suite\Identity 950 

Manager\tools\samples\NeteAuto\Organization. 951 
7. Select directory.xml. Click Next. 952 
8. Supply values for the fields in this window as follows: 953 

• Name - NeteAuto 954 
• Description - (Optional)  955 
• Connection Object Name - neteauto 956 
• Host - the machine name where you ran the dxserver commands above 957 
• Port - 3895 958 
• Username/User DN - uid=NeteAuto 959 

Administrator,ou=People,ou=Employee,ou=NeteAuto,dc=security,dc=com 960 
• Password/Confirm Password - test 961 
• Secure Connection - Unchecked 962 
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9. Click Next, then Finish. 963 

6.6 CREATE THE PROVISIONING DIRECTORY 964 

1. From Directories, select “Create or Update from XML”. 965 
2. Browse to C:\Program Files (x86)\CA\Identity Manager\IAM Suite\Identity 966 

Manager\tools\directoryTemplates\ProvisioningServer. 967 
3. Select directory.xml. Click Next. 968 
4. Supply values for the fields in this window as follows: 969 

• Name - Provisioning 970 
• Description - (Optional)  971 
• Connection Object Name - provisioning 972 
• Host - the machine name where IM is installed 973 
• Provisioning Domain - im 974 
• Username - the username you supplied in Login Information above 975 
• Password/Confirm Password - the password you supplied in Login Information 976 

above  977 
5. Click Next, then Finish. 978 

6.7 CREATE THE NETEAUTO ENVIRONMENT 979 

1. From Environments, select “New”.  980 
2. Supply the following information:  981 

• Environment name - NeteAuto 982 
• Description - (Optional) 983 
• URL alias - neteauto 984 
• Base URL – accept the default (make sure it is a fully qualified host name in the 985 

URL) 986 
3. Click Next. 987 
4. Select the “NeteAuto” directory. Click Next. 988 
5. Select the “Provisioning” directory. Click Next. 989 

• URL alias used to reference public tasks – neteauto_pub 990 
• User for anonomous authentication – SelfRegUser 991 

6. Click Validate. Then click Next. 992 
7. Select “Create Default Roles”. Click Next. 993 
8. Select the Checkbox for Active Directory. 994 
9. Scroll down and click the Browse button. 995 
10. Select the NIST_PXPolicies.xml file provided with this guide. (Download the file from 996 

https://nccoe.nist.gov/sites/default/files/nccoe/NIST_PXPolicies.zipx and unzip it.) 997 
11. Click Next. 998 

• System Manager – SuperAdmin 999 
12. Click Add. Then click Next. 1000 
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• Inbound Administrator – SuperAdmin 1001 
13. Click Next. 1002 

• Password/Confirm Password - the password you supplied in Login Information 1003 
above 1004 

14. Click Next. 1005 
15. Review the settings, then click Finish. 1006 
16. Allow a few minutes for the Environment to deploy. 1007 
17. When finished with “0 error(s)”, click Continue. 1008 
18. Click “NeteAuto”. 1009 
19. Click “Advanced Settings”, then “Workflow”. Enable both check boxes and click Save. 1010 
20. Click the “Restart Environment” button. 1011 
21. Verify that you can login to the environment by going to the environment URL and 1012 

logging in: 1013 
• http://<FullyQualifiedServerName>:8080/iam/im/<ProtectedAlias> 1014 
• Username: SuperAdmin 1015 
• Password: test 1016 

6.8 CONFIGURE CONNECTION TO ALERTENTERPRISES DATABASE 1017 

Generate the encrypted password for the Alert Database as follows: 1018 

1. From a command prompt, cd to C:\Program Files (x86)\CA\Identity 1019 
Manager\IAM Suite\Identity Manager\tools\PasswordTool 1020 

• Execute the following command: pwdtools -JSAFE -p 1021 
<AlertDBPassword>  1022 

• The result displays the Encrypted value with a prefix of {PBES}. 1023 

• Copy this encrypted password to be used below for EncryptedALERTDBPassword. 1024 

2. From the JBoss installation directory, create the following folder structure: 1025 
jboss-eap-6.3\modules\com\mysql\main 1026 

• Download Connector/ J from http://dev.mysql.com/downloads/connector/ 1027 

• Select Platform Independent, Compressed Zip Archive. Download. 1028 

• Unzip and copy the mysql-connector-java-5.1.35-bin.jar to the mysql\main folder 1029 
you created above. 1030 

• Under the same folder, create a text file named module.xml. Paste the 1031 
following text into the file: 1032 
 1033 
<?xml version="1.0" encoding="UTF-8"?> 1034 
<module xmlns="urn:jboss:module:1.1" name="com.mysql"> 1035 
 <resources> 1036 
  <resource-root path="mysql-connector-java-5.1.35-1037 
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bin.jar"/> 1038 
 </resources>  1039 
 <dependencies> 1040 
  <module name="javax.api"/> 1041 
 </dependencies> 1042 
</module> 1043 

3. From jboss-eap-6.3\standalone\configuration edit standalone-full.xml 1044 

4. In the “<drivers>” section, add: 1045 
<driver name="mysql" module="com.mysql"> 1046 
 <driver-class>com.mysql.jdbc.Driver</driver-class> 1047 
</driver> 1048 

5. Just above the “<drivers>” section, add a new data source: 1049 
<datasource jndi-name="java:/iam/im/jdbc/jdbc/AlertDB" 1050 
pool-name="MySQLPool" use-java-context="true"> 1051 
 <connection-url>                1052 
jdbc:mysql://ALERTDBServerName:3306/ALERTDBName 1053 
 </connection-url> 1054 
 <driver> 1055 
   mysql 1056 
 </driver> 1057 
 <pool> 1058 
   <max-pool-size>30</max-pool-size> 1059 
 </pool> 1060 
 <security> 1061 
   <security-domain>mysqldb</security-domain> 1062 
 </security> 1063 
</datasource> 1064 

6. In the “<security-domains>” section, add the following security domain: 1065 
<security-domain name="mysqldb"> 1066 
<authentication> 1067 
   <login-module 1068 
code="com.netegrity.jboss.datasource.PicketBoxPasswordEncry1069 
ptedLogin" flag="required" module="com.ca.iam.idmutils"> 1070 
     <module-option name="userName" 1071 
value="ALERTDBUserName"/> 1072 
     <module-option name="password" value=" 1073 
EncryptedALERTDBPassword "/> 1074 
     <module-option name="managedConnectionFactoryName" 1075 
value="jboss.jca:name=iam/im/jdbc/jdbc/WPDS,service=LocalTx1076 
CM"/> 1077 
   </login-module> 1078 
 </authentication> 1079 
</security-domain> 1080 
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7. Restart the JBoss service 1081 

8. Review the log file to verify that JBoss started without error: jboss-eap-1082 
6.3\standalone\log\server.log 1083 

6.9 POLICY XPRESS POLICY REVIEW 1084 

1. Log in to the NeteAuto Environment that you created above by navigating to 1085 
http://<FullyQualifiedServerName>:8080/iam/im/<ProtectedAlias> 1086 

2. For NeteAuto the username/password is superadmin/test. 1087 

3. Navigate to Policies > Policy Xpress > Modify Policy Xpress Policy, and click Search. 1088 

4. Select the desired Policy to review and modify as desired. 1089 

• Check for Duplicates on Create: Stops the task with a message to the user if 1090 
duplicates are detected for the CardNumber or the UserID on the Alert Database 1091 

• Check for Duplicates on Modify: Stops the task with a message to the user if the 1092 
CardNumber is already used by another user on the Alert Database. 1093 

• Check for Numeric on Create and Modify: Stops the task with a message to the 1094 
user if the PIN, FacilityCode, or CardNumber is not an integer. 1095 

• Check PACs fields on Create and Modify: Stops the task with a message to the 1096 
user if none of the PACs checkboxes are selected. At least one must be selected. 1097 

• Create AE User: Creates User on the Alert Database if all above checks pass. 1098 
Provisions user to Active Directory. 1099 

• Disable AE User: Disables User on the Alert Database, by setting the UserStatus 1100 
to “Inactive” 1101 

• Enable AE User: Enables User on the Alert Database, by setting the UserStatus to 1102 
“Active” 1103 

• Modify AE User: Modifies User on the Alert Database if all above checks pass. 1104 

6.10 UPDATE CREATE USER AND MODIFY USER SCREENS 1105 

1. From Roles and Tasks > Admin Tasks > Modify Admin Task, search and select Create User. 1106 

2. Go to the Tabs tab and click the edit pencil next to Profile. 1107 

3. Click Browse Next to the Create User Profile. 1108 

4. Select the Default User Profile, and click the Edit button. 1109 

5. Click the edit pencil next to each of the following fields: 1110 

• Office: Change Name to PIN 1111 

• Postal Code: Change Name to Facility Code. Change Permission to 1112 
Read/Write Required. 1113 

• Cell Phone: Change Name to Home Phone. 1114 
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• Business Phone: Change Name to Work Phone. 1115 

• State: Change Name to Pacs All Door. Change Style to Checkbox. Set Check 1116 
value to 1. Set Unchecked Value to 0. 1117 

• City: Change Name to Pacs Work Access. Change Style to Checkbox. Set 1118 
Check value to 1. Set Unchecked Value to 0. 1119 

• Address: Change Name to Pacs Home Access. Change Style to Checkbox. Set 1120 
Check value to 1. Set Unchecked Value to 0. 1121 

• Employee Number: Change Name to Card Number. Change Permission to 1122 
Read/Write Required. 1123 

• For any non-required fields that you don’t want to display: Change Style to 1124 
Hidden. 1125 

6. Click OK. 1126 

7. Select the Create User Profile, and click the Edit button. 1127 

8. Repeat Step 5 for this profile. When finished, click OK. 1128 

9. Navigate to Users >Manage Users >Create User, and click “Yes” for the warning message 1129 
about losing changes. 1130 

10. Select Create New User, and click OK. 1131 

11. Verify that the fields you updated are changed as desired. 1132 

12. Navigate to Users >Manage Users >Modify User, and click “Yes” for the warning message 1133 
about losing changes. 1134 

13. Select Create Modify User, and click OK. 1135 

14. Verify that the fields you updated are changed as desired. 1136 

6.11 INSTALL ACTIVITY DIRECtORY CERTIFICATE 1137 

1. Obtain the Active Directory certificate(s) from the domain controller(s) you want to 1138 
connect to and copy them to the Identity Manager server. 1139 

2. Double-click on the certificate, and click Install Certificate. 1140 
3. Select Local Machine, then Place all Certificates in the following store. Click Browse. 1141 
4. Select Trusted Root Certification Authorities. Click OK twice. 1142 

6.12 ACQUIRE ACTIVITY DIRECTORY ENDPOINT 1143 

1. From Endpoints >Manage Endpoints >Create Endpoint, select Create a new endpoint of 1144 
Endpoint type ActiveDirectory. Click OK. 1145 

• Endpoint: Give your endpoint a name 1146 

• Hostname: Fully qualified host name for the Active 1147 
Directory Domain Controller 1148 
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• User ID: Fully qualified User ID, for example: domain\userid. 1149 

• Password/Confirm Password: Password for the AD User 1150 

2. Click the Security tab. Check the “Use LDAP – SSL Encryption” checkbox. 1151 

3. Click Submit. 1152 

6.13 EXPLORE AND CORRELATE ACTIVE DIRECTORY 1153 

1. From Endpoints >Explore and Correlate Definitions >Create Explore and Correlate 1154 
Definition, select Create a New Object of Type Explore and Correlate and click OK. 1155 

2. Explore and Correlate Name: Give it a name such as “Explore AD <domain 1156 
controller name>” 1157 

3. Select the Explore endpoint… checkbox. Uncheck the rest of the checkboxes. 1158 

4. Click the Select Container/Endpoint/Explore Method button. 1159 

5. Select Active Directory and click Search. 1160 

6. Select the endpoint you created above. Click Select. 1161 

7. Click Search. 1162 

8. Select the containers that you want to be connected to Identity Manager. 1163 

9. Click Select, then Submit. 1164 

10. From Endpoints > Execute Explore and Correlate, select Execute Now and click Next. 1165 

11. Browse for the Explore and Correlate Definition you just created, then click Finish. 1166 

12. Repeat the steps above to create and execute a Correlate Definition, with only one 1167 
difference: On the step Explore endpoint step, uncheck Explore endpoint, and check 1168 
Update User Fields, Correlate Accounts to Users, and Create Users as needed. 1169 

13. From System > View Submitted tasks, click Search. 1170 

14. Verify that both the Explore and Correlate definitions completed successfully. 1171 

6.14 CREATE THE ACTIVE DIRECTORY ACCOUNT TEMPLATE AND PROVISIONING ROLE 1172 

1. From Endpoints > Account Templates > Create Account Template, select Create a new 1173 
Account Template of Endpoint Type “Active Directory”. Click OK. 1174 

2. Give the Account Template a name, such as “<domain controller name> Account 1175 
Template”. 1176 

3. From the Endpoints tab, add the Active Directory Endpoint you created above. 1177 

4. From the Groups tab, add the Active Directory groups you want to provision to the user. 1178 

5. When finished, click Submit. 1179 
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6. From Roles >Provisioning Roles >Create Provisioning Role, select Create a new 1180 
provisioning role, click OK. 1181 

7. Give the Provisioning Role a name such as “<domain controller name> Provisioning 1182 
Role” 1183 

8. From the Account Templates tab, add the Account Template you just created above. 1184 

9. From the Administrators tab, select a user, or group of users that you want to be the 1185 
Administrators of this role. For example, to make the members of a certain Admin role 1186 
the administrators of this provisioning role: 1187 

• Click Add. 1188 

• From the Users drop-down select a group of users, such as Users who are 1189 
members of <role-rule>, then admin role. 1190 

• Browse, search, and select the Admin Role you want to add. 1191 

• From the Owners tab, select a user, or group of users that you want to be the 1192 
Owners of this role, using the same process as used for the Administrators tab. 1193 

• Click Submit. 1194 

6.15 MODIFY CREATE AE USER POLICY to INCLUDE THE NEW PROVISIONING ROLE 1195 

1. From Policies >Policy Xpress >Modify Policy Xpress Policy, search and select the Create 1196 
AE User policy. 1197 

2. From the Action Rules tab, click the edit pencil next to Create User 1198 

3. Click the edit pencil next to Add otdc. Click the Browse “…” button next to the 1199 
Provisioning Role Name. Select the Provisioning Role you just created. 1200 

4. Click Select, OK, OK, Submit. 1201 

6.16 ADD WORKFLOW CONTROL OVER CREATE USER AND ANY OTHER TASK AS DESIRED 1202 

1. From Roles and Tasks >Admin Tasks >Modify Admin Task, search and select Create User. 1203 

2. From the Events tab, click the edit pencil next to the CreateUserEvent workflow process. 1204 

3. Select the Non-Policy Based workflow process “SingleStepApproval.” 1205 

4. For the approval, select “Approve Create User” * 1206 

5. For the Participant resolver select the type of members you want to assign. For example, 1207 
Admin Role Members. * 1208 

6. Click Add Admin Roles. Search and select the Admin Roles you want to have approve this 1209 
workflow. * 1210 

7. Repeat the above 3 steps with * for the Primary Approver. 1211 

8. When finished with both approvers, click OK, then Submit. 1212 



DRAFT 
   

53 | NIST Cybersecurity Practice Guide SP 1800-2c 
 

The above steps can be used for the Modify User and Enable/Disable User tasks (or any 1213 
other task). 1214 

6.17 TEST CREATION OF A USER MANUALLY 1215 

1. From Users >Manage Users > Create User, select Create a New User, click OK. 1216 

2. Fill out the fields as desired for the new user, keeping in mind the policy rules explained 1217 
above. For example, PIN, Facility Code, and Card Number must be integers, and at least 1218 
one Pacs access checkbox must be checked. 1219 

3. Click Submit, then OK. 1220 

4. From Home > View My Worklist, select and approve the workflow for the Create User 1221 
task * 1222 

5. From System >View Submitted tasks, click Search. Verify that the Create User task 1223 
completed successfully. * 1224 

6. Connect to the AE Database. Verify that the user was created successfully. * 1225 

7. Connect to the Active Directory Domain Controller. Verify that the user was created 1226 
successfully. * 1227 

Repeat all the steps above for Modify User, Enable User, and Disable User. 1228 

6.18 TEST CREATION OF A USER WITH A CSV FILE 1229 

1. Download the file HRBulkUsers4.csv from 1230 
https://nccoe.nist.gov/sites/default/files/nccoe/HRBulkUsers4.csv. 1231 

2. Modify the CSV file to enter the desired values for the new users to be created. Keep in 1232 
mind the policy rules that must be followed as described above.  1233 

3. From System > Bulk Loader, Browse for the CSV file. 1234 

4. What field represents the action to perform on the object: action. 1235 

5. What field will be used to uniquely identify the object: uid.  1236 

6. Click Next. 1237 

7. What is the Primary Object: USER. 1238 

8. Select a task to execute for action 'create': Create User 1239 

9. Click Finish. 1240 

Repeat the steps from Section 9.17 (above) with an asterisk (*) to approve the users and 1241 
verify that they were successfully created. 1242 
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7 IDENTITY MANAGEMENT AND GOVERNANCE (IMG): RSA (BUILD #2) 1243 

RSA IMG implements the central IdAM workflow in Build #2. It receives input from an HR system 1244 
in the form of .csv files. The access and authorization for each user is based on the business and 1245 
security rules implemented in workflows within RSA IMG. The workflows include management 1246 
approval chains as well as approval/denial data logging. Once IMG has processed the access and 1247 
authority request, the updated user access and authorization data is pushed to the central ID 1248 
store. The central ID store contains the distribution mechanism for updating the various 1249 
downstream (synchronized) directories with user access and authorization data. This process 1250 
applies to new users, terminated users (disabled or deleted users), and any changes to a user 1251 
profile. Changes may include promotions, job responsibility changes, and any other change that 1252 
would affect the systems a user needs to access. 1253 

7.1 SECURITY CHARACTERISTICS 1254 

Cybersecurity Framework Categories:  1255 

• PR.AC-1: Identities and credentials are managed for authorized devices and users 1256 
• PR.AC-4: Access permissions are managed, incorporating the principles of least privilege 1257 

and separation of duties  1258 

NIST 800-53 rev 4 Security Controls: AC-2, AC-3, AC-5, AC-6, AC-16, IA Family  1259 

7.2 IMG INSTALLATION 1260 

Install IMG using the included installation guide on a server running SUSE Linux OS or from an 1261 
IMG virtual appliance image. The RSA Installation guide is available for licensed customers at 1262 
http://www.emc.com/domains/rsa/index.htm. 1263 

7.3 IMG CONFIGURATION AND INTEGRATION WITH DIRECTORIES 1264 

After install, open a web browser and point it to the IP Address or DNS name of the RSA IMG 1265 
server. The following instructions are provided along with screenshots depicting each step. 1266 
Unless stated otherwise the settings are included in each screenshot. 1267 

Log in with the default credentials: 1268 

Username: AveksaAdmin (case sensitive) 1269 
Password: aveksa123 1270 

Change the password when prompted to change.  1271 

 Set Up Custom Attributes 7.3.11272 
1. Navigate to ‘Admin’ then ‘Attributes’: 1273 

http://www.emc.com/domains/rsa/index.htm
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 1274 

Figure 9. IMG Attributes Window 1275 

1. Click on ‘User’ then ‘Edit’ as shown in Figure 10. 1276 

 1277 

 Figure 10. IMG Edit User 1278 

1 

2 
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2. Modify your attributes to match Figures 11-13. 1279 

Figure 11. IMG Attributes Examples 
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 1280 

 1281 

Figure 12. IMG Attributes Examples 1282 

 1283 

Figure 13. IMG Attributes Examples 1284 

3. Click on OK. 1285 
4. Click on ‘Account’ then ‘Edit’ as shown in Figure 14. 1286 

 1287 

Figure 14. IMG Edit Attributes 1288 

5. Modify your attributes to match those shown in Figure 15. IMG Attribute Example. 1289 

1 2 
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 1290 

Figure 15. IMG Attribute Example 1291 

6. Click on ‘OK’. 1292 

 Set up Organization Users 7.3.21293 
The next step is to set up the organization’s existing users. In the example solution, we used a 1294 
CSV file that contains all the users in the organization. This CSV file needs to be copied to a 1295 
convenient location on the IMG server. You can get a sample CSV file, HR_Data_Move.csv at 1296 
https://nccoe.nist.gov/sites/default/files/nccoe/HR_Data_Move.csv. 1297 

1. Once the CSV file is copied to the server, perform the following actions: 1298 
2. Navigate to ‘Resources’ and under resources, select ‘Directories’ as shown in Figure 16. 1299 

 1300 
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Figure 16. IMG Resources Directories 1301 

3. Click ‘Create Directory’ as shown in Figure 17. 1302 

 1303 

Figure 17. IMG Create Directory 1304 

4. Select ‘Other Directory’ and click ‘Next’ as shown in Figure 18. 1305 

1306 
  1307 

Figure 18. IMG Create Directory 1308 

 1309 

5. Enter ‘HR’ in the ‘Directory Raw Name’ field. Click ‘Finish’ as shown in Figure 19 . 1310 
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 1311 

Figure 19. IMG Directory Information 1312 

You have now created your first directory which will serve as a repository for all the HR Data for 1313 
the organization.  1314 

6. Repeat the above steps, creating a second directory. This one will be named ‘RSA 1315 
Adaptive Directory’. This container will be used to pull AD accounts from the Adaptive 1316 
Directory server. In this case be sure to select the two options as shown in Figure 20. 1317 
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 1318 

Figure 20. IMG Create Directory 1319 

 1320 

  1321 



DRAFT 
   

62 | NIST Cybersecurity Practice Guide SP 1800-2c 
 

 Populate the HR Directory 7.3.31322 
The next step is to populate the HR directory with users. 1323 

1. Click on ‘Resources’ and ‘Directories’ again as shown in Figure 21. 1324 

 1325 

Figure 21. IMG Directories 1326 

2. Click on your new HR directory you just created as shown in Figure 22. 1327 

 1328 

Figure 22. IMG Directories 1329 

 1330 



DRAFT 
   

63 | NIST Cybersecurity Practice Guide SP 1800-2c 
 

3. Click on ‘Collectors’ then click ‘Create Identity Collector’ as shown in Figure 23Figure 23. 1331 
IMG Create Identity Collector. 1332 

 1333 

Figure 23. IMG Create Identity Collector 1334 

4. Enter details as below as shown in Figure 24. 1335 

 1336 
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Figure 24. IMG HR Identities 1337 

5. Click ‘Next’, and enter details as below as shown in Figure 25. 1338 

 1339 

Figure 25. IMG HR Identities (cont.) 1340 

6. Use the same username and password you use to log into the IMG management web 1341 
page. 1342 

The URL will point to the folder that the CSV file is located in. In this example, the full field is: 1343 

jdbc:csv://///home/oracle/database/SampleData/Demo/HR/?_CSV_Header=true;tmpdir=/hom1344 
e/oracle 1345 

The CSV file is located in home/oracle/database/SampleData/Demo/HR 1346 

7. Click ‘Next’. 1347 
8. Leave ‘Users’ selected and click ‘Next’ as shown in Figure 26. 1348 

 1349 
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Figure 26. IMG HR Identities - Users 1350 

1. Enter details as shown in Figure 27 and Figure 28 , below. The full text of the ‘User Data 1351 
Query’ is as follows: 1352 

select fname, lname, case when substr(lname,1,2) = 'IT' then 1353 
'it' when substr(lname,1,2) = 'OT' then 'ot' else 'pacs' end as 1354 
OU, login, email as sAMAccountName, email, location, bu, 1355 
department, title, supervisor, job_level, job_status, login as 1356 
SR, is_terminated, previous_manager, jobcode, previous_manager 1357 
as backjp_supervisor, job_family,concat(lname,', ',fname)as 1358 
fullname, is_manager, email as UniqueID from HR_Data_Move 1359 

The highlighted section is specific to this example, based off of our sample data, the OU that the 1360 
user needs to be provisioned in is based off of the last name. Basically, when the 1st two letters 1361 
of the last name = IT, the user will have ‘it’ set to the OU attribute, if it’s OT, then ‘ot’ is set as 1362 
the OU attribute, any other scenario the OU attribute is set to ‘pacs’. 1363 

 1364 



DRAFT 
   

66 | NIST Cybersecurity Practice Guide SP 1800-2c 
 

 1365 

Figure 27. IMG HR Identities 1366 

 1367 
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 1368 

Figure 28. IMG HR Identities (cont.) 1369 

9. Click ‘Finish’ 1370 

 Configure Adaptive Directory Container 7.3.41371 
The next step is to configure the Adaptive Directory Container with Identity and Account 1372 
collectors. 1373 

 1374 

1. Navigate to the Adaptive Directory Container as shown in Figure 29. 1375 
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 1376 

Figure 29. IMG Adaptive Directory Container 1377 

 1378 

This identity collector will tie together user identities in Adaptive Directory to user identities in 1379 
the HR CSV file. 1380 

2. Click on ‘Collectors’ and ‘Create Identity Collector’ as shown in Figure 30. 1381 

 1382 
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Figure 30. IMG Identity Collector 1383 

3. Create the ID collector as follows, clicking ‘Next’ between each screen shown in Figure 1384 
31, Figure 32, Figure 33, Figure 34 and Figure 35. 1385 

 1386 

Figure 31. IMG AD Identity Collector 1387 

 1388 
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 1389 

Figure 32. IMG AD Identity Collector  1390 

 1391 

 1392 

Figure 33. IMG AD Identity Collector 1393 

 1394 
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 1395 

Figure 34. IMG AD Identity Collector 1396 

 1397 
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 1398 

Figure 35. IMG AD Identity Collector 1399 

 1400 

4. Click Finish 1401 

 Create an Account Collector 7.3.51402 
The next step is to create an account collector which pulls all relevant attributes from Adaptive 1403 
Directory. 1404 

1. Click on ‘Collectors’ and ‘Create Account Collector’ as shown in Figure 36. 1405 
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 1406 

Figure 36. IMG AD Create Account Collector 1407 

2. Create the Account collector as follows, clicking ‘Next’ between each screenshot, Figure 1408 
37 through Figure 46 below. 1409 

 1410 
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Figure 37. IMG Edit Collector 1411 

 1412 

Figure 38. IMG Edit Collector 1413 

 1414 

 1415 

Figure 39. IMG Edit Collector 1416 

 1417 
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 1418 

Figure 40. IMG Edit Collector 1419 

 1420 

 1421 

Figure 41. IMG Edit Collector 1422 
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 1423 

Figure 42. IMG Edit Collector 1424 

 1425 

 1426 
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Figure 43. IMG Edit Collector 1427 

 1428 

Figure 44. IMG Edit Collector 1429 

 1430 

Figure 45. IMG Edit Collector 1431 

 1432 

Figure 46. IMG Edit Collector 1433 

3. Click ‘Finish’ 1434 

A Test button is provided with each account collector and identity collector. 1435 

4. Test each account collector you created using the test button. This action verifies that 1436 
IMG can retrieve the account information for each directory added as shown in Figure 1437 
47 below. 1438 
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 1439 

Figure 47. IMG Account Test 1440 

A successful test will look something like Figure 48. 1441 

 1442 

Figure 48. IMG Successful Test Example 1443 

You can see valid data in an XML format. A failed test will generate an error message that can 1444 
help you isolate the problem. 1445 
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 Edit the Unification Configuration Participating Collectors 7.3.61446 
The next step is to configure Unification – this is the process of joining Identities from the HR 1447 
CSV and the Adaptive Directory collectors. 1448 

1. Click on ‘Collectors’ and ‘Unification Config’ as shown in Figure 49. 1449 

 1450 

Figure 49. IMG Unification Configuration 1451 

2. Choose the Participating Collectors tab. Click on Edit as shown in Figure 50. 1452 

 1453 

Figure 50. IMG Participating Collectors 1454 

3. Configure as shown in Figure 51 and Figure 52. Click Next on each screen. 1455 
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 1456 

Figure 51. IMG Edit Participating Collectors 1457 

 1458 

Figure 52. IMG Edit Participating Collectors 1459 

In the above example, we have HR Identities at the top. This indicates that HR Identities is 1460 
authoritative source – if there are any discrepancies between the data between the two, then 1461 
the one at the top will win by default, but this can be overridden, which we will see later. 1462 

4. Click Finish. 1463 

 Edit Unification Configuration Attribute Source 7.3.71464 
The next step is to change the default behavior of the authoritative source for the necessary 1465 
attributes.  1466 

1. Choose the Attribute Sources tab. Click on Edit as shown in Figure 53. 1467 

 1468 
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Figure 53. IMG Unification Configuration Attribute Sources 1469 

2. Edit the Attributes shown in Figure 54 and Figure 55. Leave alone any attribute shown as 1470 
‘Not Set’. These attributes will use the default behavior: 1471 

 1472 
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Figure 54. IMG Edit User Attribute Mapping 1473 

 1474 

Figure 55. IMG Edit User Attribute Mapping 1475 

3. Click on OK. 1476 

 Edit Unification Configuration Attribute Source 7.3.81477 
The next step is to configure which attribute to use from each directory so IMG knows how to 1478 
tie users together. 1479 

1. Choose the Joins tab. Click on Edit as shown in Figure 56. 1480 

 1481 
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 1482 

Figure 56. IMG Unification Configuration Joins 1483 

2. Choose the HR Identities from the Primary Identity Collector dropdown box as shown in 1484 
Figure 57. 1485 

 1486 

Figure 57. IMG Edit Joins 1487 

3. Click ‘Finish’. 1488 

 Start Data Collection 7.3.91489 
The next step is to start collecting identity data. 1490 

1. From the home page choose the Resources > Directories tab. Click Collect Data (all) 1491 
button as shown in Figure 58. 1492 

 1493 
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 1494 

Figure 58. IMG Start Data Collection 1495 

2. Click OK on the next window as shown in Figure 59. 1496 

 1497 

Figure 59. IMG Collect Data 1498 

3. The process will take 30 seconds or so to complete. You can check the progress under 1499 
‘Admin’ and ‘Monitoring’ as shown in Figure 60. 1500 
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 1501 

Figure 60. IMG Data Collection Monitoring 1502 

You will see all the processes change to ‘Complete’ when done. 1503 

 Review Data Collected 7.3.101504 
Now you can look at this data by going to ‘Users’ then ‘Users’ and ‘Groups’. 1505 

1. From the home page choose the Users > Groups tab as shown in Figure 61 to review the 1506 
data collected. 1507 

 1508 
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 1509 

Figure 61. IMG Data Collection Review 1510 

 Configure Business Rules 7.3.111511 
The next step is to configure Business Roles. 1512 

1. Click on Roles > Roles as shown in Figure. 1513 

 1514 

Figure 62. IMG Roles 1515 

2. Click on ‘Create / Discover’ and ‘Discover Roles’ as shown in Figure 63. 1516 
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 1517 

Figure 63. IMG Discover Roles 1518 

3. Configure as follows as shown in Figure 64 through Figure 66. 1519 

 1520 
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Figure 64. IMG Discover Roles 1521 

 1522 

Figure 65. IMG Discover Roles 1523 

 1524 

Figure 66. IMG Discover Roles 1525 

4. Notice how there are some duplicates – the job codes are the same, but the descriptions 1526 
are slightly different. You can combine these rolls into one as shown in Figure 67: 1527 
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 1528 

Figure 67. IMG Discover Roles 1529 

5. When you are done combining duplicates, click Finish. 1530 

 Create Automated Rules 7.3.121531 
The next step is to create rules for automatically detecting and invoking work flows for new 1532 
users and terminations. 1533 

1. Click on ‘Rules’ and ‘Definitions’ as shown in Figure 68. 1534 

 1535 
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Figure 68. IMG Roles Definitions 1536 

2. Click on ‘Create Rule’ and configure as shown in Figure 69 and Figure 70 for New Users. 1537 

 1538 

Figure 69. IMG New User 1539 

 1540 
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 1541 

Figure 70. IMG New User 1542 

3. Click on ‘Create Rule’ and configure as shown in Figure 71 and Figure 72 for User 1543 
Terminations. 1544 
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 1545 

Figure 71. IMG User Termination 1546 

 1547 
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Figure 72. IMG User Termination 1548 

 1549 

4. Click ‘OK’. 1550 

 Create Provisioning Template 7.3.131551 
The next step is to create a template that IMG uses when provisioning accounts in Adaptive 1552 
Directory: 1553 

1. Click on ‘Requests’, ‘Configuration’, ‘Account Template’ tab, then ‘Create Account 1554 
Template’ as shown in Figure 73 . 1555 

 1556 

Figure 73. IMG Request Configuration 1557 

2. Enter a name, and click OK as shown in Figure 74. 1558 

 1559 

Figure 74. IMG Account Template 1560 

3. Click on the name of the account template you just created and add parameters as 1561 
shown in Figure 75. 1562 
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 1563 

Figure 75. IMG IT Account Template 1564 

Next configure the IMG AFX module which will allow IMG to provision to Adaptive Directory: 1565 

4. Click on ‘AFX’ and ‘Connectors’ as shown in Figure 76. 1566 

 1567 

Figure 76. IMG AFX Connectors 1568 

5. Click on ‘Create Connector’ as shown in Figure 77. 1569 
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 1570 

Figure 77. IMG Create Connector 1571 

6. Configure the ‘General’ tab as shown in Figure 78. 1572 

 1573 

Figure 78. IMG AD Connector AFX Server 1574 

7. Configure the ‘Settings’ tab as shown in Figure 79 through Figure 81. 1575 
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 1576 
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Figure 79. IMG AD Connector AFX Server 1577 

 1578 
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Figure 80. IMG AD Connector AFX Server 1579 

 1580 

Figure 81. IMG AD Connector AFX Server 1581 

8. Configure the ‘Capabilities’ tab as shown in Figure 82. 1582 

 1583 
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Figure 82. IMG AD Connector IT 1584 

 1585 

9. Check all capabilities needed for to the connector. Once all are selected, click on the 1586 
capability name one by one and configure as shown in Figure 83 through Figure 96. 1587 
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 1588 

Figure 83. IMG AD Connector IT Capability Configuration 1589 

 1590 
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 1591 

 1592 

 Figure 85. IMG AD Connector IT Capability Configuration 1593 

Figure 84. IMG AD Connector IT Capability Configuration 
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 1594 

Figure 86. IMG AD Connector IT Capability Configuration 
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1595 
Figure 87. IMG AD Connector IT Capability Configuration 1596 

1597 
Figure 88. IMG AD Connector IT Capability Configuration 1598 

1599 
  1600 

Figure 89. IMG AD Connector IT Capability Configuration 1601 
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 1602 

Figure 90. IMG AD Connector IT Capability Configuration 1603 

1604 
  1605 

Figure 91. IMG AD Connector IT Capability Configuration 1606 
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Figure 92. IMG AD Connector IT Capability Configuration 1607 

 1608 

 1609 

Figure 93. IMG AD Connector IT Capability Configuration 1610 

 1611 
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 1612 

Figure 94. IMG AD Connector IT Capability Configuration 1613 

 1614 
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1615 
  1616 

Figure 95. IMG AD Connector IT Capability Configuration 1617 

 1618 

 Figure 96. IMG AD Connector IT Capability Configuration 1619 

10. Click OK. 1620 
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 Configure Adaptive Directory to Use AFX Connector 7.3.141621 
The next step is to configure the RSA Adaptive Directory ‘Directory’ to use the new AFX 1622 
Connector. 1623 

1. Click on Resources > Directories tab as shown in Figure 97 and select HR and click OK. 1624 

 1625 

Figure 97. IMG Resources Directories 1626 

2. Then in the next window choose the AFX Connector Binding tab as shown in Figure 98. 1627 
3. Click the Edit Connector Binding as shown in Figure 98. 1628 

 1629 
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Figure 98. IMG AD Accounts 1630 

 1631 

Figure 99. IMG AD AFX Connector Binding 1632 

4. Click OK as shown in Figure 99. 1633 

Now the system is ready.  1634 

7.4 USING RSA IMG 1635 

 Adding a New User 7.4.11636 
1. Open the HR CSV file and add a user. 1637 
2. Go to ‘Resources’, ‘Directories’ and click ‘Collect Data (all)’ as shown in Figure 100. 1638 

 1639 
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Figure 100. IMG Resources Directories 1640 

 1641 

1. Click ‘OK’ as shown in Figure 101. 1642 

 1643 

Figure 101. IMG Collect Data 1644 

2. After about 30 seconds go to ‘Requests’, ‘Activities’ and click ‘Perform’ next to the 1645 
request to add a new user as shown in Figure 102. 1646 

 1647 
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Figure 102. IMG Requests Activities 1648 

3. Select a group you would like to add the user to, Click ‘Next’, then ‘Accepted’ as shown in 1649 
Figure 103. 1650 

 1651 

Figure 103. IMG Accepted Access Request 1652 

4. Enter a description if you wish, and click ‘Finish’. 1653 
5. Go to ‘Requests’, and click ‘Requests’. Click the name of the request as shown in Figure 1654 

104. 1655 
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 1656 

Figure 104. IMG Requests 1657 

 1658 

6. After about 30 seconds, your new user will be provisioned to AD and added to the group 1659 
you selected as shown in Figure 105. 1660 

 1661 
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Figure 105. IMG New User Provisioned 1662 

Note: The state of the group add will remain pending, and the overall status will remain at 50% 1663 
until you recollect data from the Directories page so that IMG can detect that the user has been 1664 
added to the group successfully as shown in Figure 106. 1665 

 1666 

Figure 106. IMG Successful User Add 1667 

 Moving a User 7.4.21668 
1. Open your CSV file and change the attribute that defines the OU that the user is in to a 1669 

different OU. 1670 
2. Collect data again. 1671 
3. The OU change is detected, and IMG deletes the user from the original OU and adds the 1672 

user to the new OU.  1673 
4. Go to ‘Requests’ and ‘Activities’ and click ‘Perform’ as shown in Figure 107. 1674 
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 1675 

Figure 107. IMG Requests Activities 1676 

5. Select the group you would like the moved user to have access to, click ‘Next’ and 1677 
‘Accepted’, then ‘Finish’ on the final screen. As you did before for adding a new user. 1678 

6. Collect data again so IMG can confirm that the user is added to the appropriate group in 1679 
the new OU. 1680 

7. Terminating a user 1681 
8. Delete the user from the HR CSV file. 1682 
9. Collect data again. 1683 
10. The user is automatically removed.  1684 
11. Collect data again, so IMG can confirm the user is no longer in Adaptive Directory. 1685 
12. Check the Status in ‘Requests’, and ‘Requests’ as shown in Figure 108. 1686 
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 1687 

Figure 108. IMG Request Status 1688 

8 INSTALLATION OF ADAPTIVE DIRECTORY: RSA (BUILD #2) 1689 

RSA Adaptive Directory implements the central IdAM ID store in Build #2. It receives input from 1690 
central IdAM system (RSA IMG). The central ID store contains the distribution mechanism for 1691 
updating the various downstream (synchronized) directories with user access and authorization 1692 
data. This process applies to new users, terminated users (disabled or deleted users), and any 1693 
changes to a user profile. Changes include promotions, job responsibility changes, and any 1694 
other change that would affect the systems a user needs to access. 1695 

8.1 SECURITY CHARACTERISTICS 1696 

Cybersecurity Framework Categories: PR.AC-1: Identities and credentials are managed for 1697 
authorized devices and users 1698 

NIST 800-53 rev 4 Security Controls: AC-2, IA Family  1699 

8.2 RSA ADAPTIVE DIRECTORY IS INSTALLED ON THE IDAM NETWORK, ON A VM THAT IS RUNNING  1700 

CENTOS 7 1701 

The following lines detail the command line installation procedure for RSA Adaptive Directory, 1702 
including displayed responses: 1703 
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[root@localhost ~]# ls 1704 
anaconda-ks.cfg reports xml 1705 
[root@localhost ~]# cd .. 1706 
[root@localhost /]# ls 1707 
bin dev home lib64 mnt proc run srv tmp var 1708 
boot etc lib media opt root sbin sys usr 1709 
[root@localhost /]# cd media 1710 
[root@localhost media]# ls 1711 
cdrom 1712 
[root@localhost media]# cd cdrom 1713 
[root@localhost cdrom]# ls 1714 
Documentation rsa_7.1.5_linux_64.bin rsa_7.1.5_windows_64.exe 1715 
[root@localhost cdrom]# su root ./rsa_7.1.5_linux_64.bin 1716 
Preparing to install... 1717 
WARNING: /tmp does not have enough disk space! 1718 
   Attempting to use /root for install base and tmp dir. 1719 
Extracting the JRE from the installer archive... 1720 
Unpacking the JRE... 1721 
Extracting the installation resources from the installer archive... 1722 
Configuring the installer for this system's environment... 1723 
Launching installer... 1724 
 1725 
Graphical installers are not supported by the VM. The console mode will be used instead... 1726 
======================================================================= 1727 
RSA Adaptive Directory 7.1.5      (created with InstallAnywhere) 1728 
------------------------------------------------------------------------------- 1729 
Preparing CONSOLE Mode Installation... 1730 
 1731 
 1732 
======================================================================= 1733 
License Agreement 1734 
----------------- 1735 
Please read the following License Agreement carefully. 1736 
 LICENSE AGREEMENT 1737 
*** IMPORTANT INFORMATION - PLEASE READ CAREFULLY *** 1738 
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(...Lic agreement text omitted…) 1739 
DO YOU ACCEPT THE TERMS OF THIS LICENSE AGREEMENT? (Y/N): Y 1740 
======================================================================= 1741 
Choose Install Folder 1742 
--------------------- 1743 
Please choose a destination folder for this installation 1744 
Where would you like to install? 1745 
Default Install Folder: /root/rsa/adaptivedirectory 1746 
ENTER AN ABSOLUTE PATH, OR PRESS <ENTER> TO ACCEPT THE DEFAULT: Enter 1747 
======================================================================= 1748 
Choose Install Set 1749 
------------------ 1750 
Please choose the Install Set to be installed by this installer. 1751 
 >1- RSA Adaptive Directory New Cluster / Standalone 1752 
 2- RSA Adaptive Directory Cluster Node 1753 
 3- Customize... 1754 
ENTER THE NUMBER FOR THE INSTALL SET, OR PRESS <ENTER> TO ACCEPT THE DEFAULT: 1755 
Enter 1756 
======================================================================= 1757 
New Cluster settings 1758 
-------------------- 1759 
Enter information below about the new cluster to create: 1760 
- The cluster name 1761 
- The ZooKeeper ports that will be used 1762 
Cluster name: (DEFAULT: cluster1): cluster1 1763 
ZooKeeper Ensemble Port: (DEFAULT: 2888): 2888 1764 
ZooKeeper Leader Election Port: (DEFAULT: 3888): 3888 1765 
ZooKeeper Client Port: (DEFAULT: 2181): 2181 1766 
 1767 
 1768 
======================================================================= 1769 
Administrator name 1770 
------------------ 1771 
Please provide the administrator name: 1772 
Admin User Name (DEFAULT: cn=Directory Manager): Directory Manager 1773 
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 1774 
======================================================================= 1775 
Server administrator password 1776 
----------------------------- 1777 
Please provide a password for the administrator user : 1778 
Password (DEFAULT: ): secretsecret 1779 
Confirm Password (DEFAULT: ): secretsecret 1780 
 1781 
======================================================================= 1782 
Adaptive Directory port numbers 1783 
------------------------------- 1784 
Please enter port numbers for Adaptive Directory: 1785 
Adaptive Directory Port (DEFAULT: 2389): 2389 1786 
Scheduler Port (DEFAULT: 1099): 1099 1787 
Adaptive Directory SSL Port: (DEFAULT: 1636): 1636 1788 
 1789 
===================================================================== 1790 
TLS Configuration 1791 
----------------- 1792 
 1793 
Enable TLS (Y/N)? (DEFAULT: N): N 1794 
 1795 
====================================================================== 1796 
Adaptive Directory HTTP port numbers 1797 
------------------------------------ 1798 
Please enter port numbers for Adaptive Directory HTTP services: 1799 
Adaptive Directory HTTP Port (DEFAULT: 8089): 8089 1800 
Adaptive Directory HTTPS Port (DEFAULT: 8090): 8090 1801 
 1802 
=================================================================== 1803 
Certificate configuration 1804 
------------------------- 1805 
Use an existing certificate (Y/N)? (DEFAULT: N): N 1806 
 1807 
==================================================================== 1808 
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Application Server Configuration 1809 
-------------------------------- 1810 
Enter information below to configure the Application Server 1811 
- Administrator user name for initial server instance. 1812 
- Administrator password for initial server instance (must be at least 8 1813 
characters in length). 1814 
- Administration server port number for initial server instance. 1815 
- HTTP/HTTPS port number for initial server instance. 1816 
- JMX port number for initial server instance. 1817 
Admin User (DEFAULT: admin): admin 1818 
Password (DEFAULT: ): secretsecret 1819 
Confirm Password (DEFAULT: ): secretsecret 1820 
Admin Port (DEFAULT: 4848): 4848 1821 
HTTP Port (DEFAULT: 9090): 9090 1822 
HTTPS Port (DEFAULT: 9191): 9191 1823 
JMX Port (DEFAULT: 8686): 8686 1824 
 1825 
======================================================================= 1826 
Control Panel Configuration 1827 
--------------------------- 1828 
These are the settings for the Web Server hosting the Control Panel. 1829 
Enter the HTTP/HTTPS ports to configure the Web Server on the main instance: 1830 
These are the settings for the Web Server hosting the Control Panel. 1831 
HTTP Port (DEFAULT: 7070): 7070 1832 
Enter the HTTP/HTTPS ports to configure the Web Server on the main instance: 1833 
HTTPS Port (DEFAULT: 7171): 7171 1834 
 1835 
====================================================================== 1836 
Port validation failed 1837 
---------------------- 1838 
Control Panel HTTP port These are the settings for the Web Server hosting the 1839 
Control Panel. is invalid. 1840 
Please select a new one. 1841 
PRESS <ENTER> TO ACCEPT THE FOLLOWING (OK): Enter 1842 
 1843 
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==================================================================== 1844 
Control Panel Configuration 1845 
--------------------------- 1846 
These are the settings for the Web Server hosting the Control Panel. 1847 
Enter the HTTP/HTTPS ports to configure the Web Server on the main instance: 1848 
HTTP Port (DEFAULT: 7070): 7070 1849 
HTTPS Port (DEFAULT: 7171): 7171 1850 
 1851 
=================================================================== 1852 
Pre-Installation Summary 1853 
------------------------ 1854 
Please Review the Following Before Continuing: 1855 
Product Name: RSA Adaptive Directory 7.1.5 1856 
Install Folder: /root/rsa/adaptivedirectory 1857 
Install Set: RSA Adaptive Directory New Cluster / Standalone 1858 
Product Features: Application, Sample Data 1859 
Java VM Installation Folder: /root/rsa/adaptivedirectory/jdk 1860 
Administrator User: cn=Directory Manager 1861 
Adaptive Directory Ports: 2389 8089 8090 1862 
Scheduler Port: 1099 1863 
SSL Configuration: 1636 1864 
Start TLS Configuration: TLS is disabled. 1865 
Certificate Configuration: Self signed certificate. 1866 
App Server Configration: 4848 9090 9191 8686 1867 
Web Server Configuration: 7070 7171 1868 
Disk Space Information (for Installation Target): 1869 
 Required: 1,164.03 MegaBytes 1870 
 Available: 49,030.86 MegaBytes 1871 
PRESS <ENTER> TO CONTINUE: Enter 1872 
 1873 
=================================================================== 1874 
Installing... 1875 
------------- 1876 
[================================|==================|==================] 1877 
[------------------|------------------|------------------|------------------] 1878 
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 1879 
=================================================================== 1880 
Installation Complete 1881 
--------------------- 1882 
Congratulations. RSA Adaptive Directory 7.1.5 has been successfully installed to: 1883 
/root/rsa/adaptivedirectory In order to start working with RSA Adaptive Directory 7.1.5, please 1884 
follow these steps: 1885 
- LOG OFF 1886 
Then 1887 
- LOG IN 1888 
- Copy and paste your license key when prompted after running RSA Adaptive 1889 
Directory 7.1.5 1890 
- Run /root/rsa/adaptivedirectory/bin/openControlPanel.sh 1891 
PRESS <ENTER> TO EXIT THE INSTALLER: Enter 1892 

8.3 ADDITIONAL STEPS REQUIRED AFTER INSTALLATION IS COMPLETE 1893 

Then you need to install netstat: yum install net-tools 1894 
Copy the license.lic file to: /root/rsa/adaptivedirectory/vds_server 1895 
Open all relevant firewall ports on the CentOS server 1896 
Run /root/rsa/adaptivedirectory/bin/openControlPanel.sh 1897 
Run /root/rsa/adaptivedirectory/bin/runContextBuilder.sh 1898 
From a web browser go to: http:IPADDRESS:7070 1899 
Start the server by clicking the Start button. 1900 
Click on Tools menu item, and start the Application Server. 1901 
 1902 
Configuration Procedure: 1903 
From a web browser, connect to the Adaptive Directory server and log in (Note the URL with 1904 
port number) using the following credentials: (Default credentials) See Figure 109. 1905 
Username: cn=Directory Manager 1906 
Password: secretsecret 1907 
 1908 
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 1909 

Figure 109. Adaptive Directory Login Page 1910 

On the main page, Figure 110, start the Adaptive Directory server: 1911 

 1912 

Figure 110. Adaptive Directory Main Page 1913 

On the Tools tab, Figure 111, click Start it to start the Persistent Cache service: 1914 
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 1915 

Figure 111. Adaptive Directory Tools Page 1916 

Now go to the Settings tab, Figure 112 and click Server Backend Settings and then click LDAP 1917 
Data Sources. 1918 

 1919 

Figure 112. Adaptive Directory Server Backend Settings 1920 

Click Add. 1921 
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 1922 

Figure 113. Adaptive Directory LDAP Data Source 1923 

Enter details for your “backend AD” as shown in Figure 113. Click the Test Connection button to 1924 
be sure your settings are correct. Repeat this process for all the AD clusters, i.e., for the backend 1925 
ADs on the IT, OT, and PACS networks. You can Clone your first connection to make repeat 1926 
additions easier. 1927 

Now click on Directory, click on Configuration, right-click on Root Naming Contexts, and select 1928 
Naming context as shown in Figure 114. 1929 
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 1930 

Figure 114. Adaptive Directory Configuration of Naming Context 1931 

You are presented with this screen, Figure 115: 1932 

 1933 

Figure 115. Adaptive Directory New Naming Context 1934 

Enter the “name” you would like your new Virtual LDAP directory to be configured with. Select 1935 
Virtual Tree and click Next. 1936 
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 1937 

Figure 116. Adaptive Directory Configure Virtual Tree 1938 

Leave the defaults selected as shown in Figure 116, and click OK. You will see the following 1939 
screen, Figure 117. 1940 

 1941 

Figure 117. Adaptive Directory Virtual Tree 1942 

You now have a virtual directory naming context created, and the next step is to configure this 1943 
virtual directory to include all the backend AD clusters. 1944 

Right-click on your newly created Virtual Directory and select New Level as shown in Figure 118: 1945 
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 1946 

Figure 118. Adaptive Directory Create New Level 1947 

Enter a “name” for this LDAP backend mapping. This name will be an OU in the Virtual 1948 
Directory as shown in Figure 119. 1949 

 1950 

Figure 119. Adaptive Directory New Level Name 1951 

Right-click this new OU in your Virtual Directory and select Backend Mapping as shown in Figure 1952 
120. 1953 
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 1954 

Figure 120. Adaptive Directory Backend Mapping 1955 

Leave LDAP Backend selected and click Next as shown in Figure 121. 1956 
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 1957 

Figure 121. Adaptive Directory Backend Mapping 1958 

Now select one of your backend AD clusters we configured earlier and click OK as shown in 1959 
Figure 122. 1960 

 1961 

Figure 122. Adaptive Directory Configure LDAP Backend 1962 

Repeat this procedure for all your backend AD clusters (i.e., for the backend ADs on the IT, OT, 1963 
and PACS networks). 1964 

By default, the Adaptive Directory server will return default AD attributes.  1965 
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8.4 CUSTOM ATTRIBUTE CONFIGURATION 1966 

Custom attributes are required and are configured as follows: 1967 

Click on Directory, then Configuration, and then expand the virtual directory you are working 1968 
with and select the backend mapping to AD to which you want to make changes. Then click the 1969 
Attributes tab and Add as shown in Figure 123. 1970 

 1971 

Figure 123. Adaptive Directory Addition Attributes 1972 

Find the attribute you would like to add in the top drop-down list, and enter a “name” (it could 1973 
be the same or different) for the attribute you want Adaptive Directory to return. Then select 1974 
DN Remapping and click OK as shown in Figure 124. 1975 

 1976 

Figure 124. Adaptive Directory Add/Edit Main Attribute 1977 

Complete this procedure for any additional custom attributes that are required and for any 1978 
additional AD backends to which you may need to add attributes. 1979 



DRAFT 
   

131 | NIST Cybersecurity Practice Guide SP 1800-2c 
 

Your Adaptive Directory virtual directory is now complete and can be accessed from RSA IMG / 1980 
Aveksa or any other application that can access LDAP directories. 1981 

You can address this virtual directory by configuring the connecting application with the IP 1982 
address or DNS name of the Adaptive Directory server and using port 2389. For the base DN, 1983 
you would use the name of your virtual directory—in the above example, ‘dc=master,dc=test’ 1984 
and the relevant OU (backend AD cluster) you want to access. You would use the same 1985 
username (cn=Directory Manager) and password you use to log in to the application. 1986 

For example, Figure 125 and Figure 126 show the connection information from RSA IMG to 1987 
Adaptive Directory. 1988 

 1989 

Figure 125. Adaptive Directory Edit Collector 1990 

 1991 

Figure 126. Adaptive Directory Search Configuration for Accounts 1992 

8.5 RSA AD OPTIMIZATION AND TUNING 1993 

 Disable Referral Chasing 8.5.11994 
Referral chasing should be disabled for performance reasons. Check the Disable Referral Chasing 1995 
option when you define the LDAP data source.  1996 
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 Limit Attributes Requested from the LDAP Backend 8.5.21997 
Whenever RSA Adaptive Directory queries a backend LDAP, the default behavior is to ask for all 1998 
attributes (although only the attributes requested in the query will be returned to the client). 1999 
This default behavior of RSA Adaptive Directory is for the following reasons: 2000 

• Joins have been configured and the filter in the search request involves attributes from 2001 
both the primary and secondary sources (i.e., the query filter contains conditions on 2002 
both primary and secondary objects). 2003 

• Interception scripts may involve logic based on attributes from the backend and so 2004 
require these attributes. These attributes may not be specifically requested or searched 2005 
for by the client. However, RSA Adaptive Directory must retrieve them from the backend 2006 
in order for the script logic to be valid. 2007 

• Access Control List (ACL) checking. You can set up ACLs based on attribute/values of an 2008 
entry (e.g., mystatus=hidden), so RSA Adaptive Directory may need the whole entry to 2009 
check the authorization. 2010 

• For entry caching. The entire entry needs to be in the entry cache.  2011 

If your virtual view does not require all attributes to be requested for any of the conditions 2012 
mentioned above, you can enable the option to limit the attributes that are requested for 2013 
better performance. If this option is enabled, RSA Adaptive Directory will query the backend 2014 
server only for attributes requested from the client in addition to attributes set as Always 2015 
Requested on the Attributes tab. 2016 

 Process Joins and Computed Attributes Only When Necessary 8.5.32017 
The default behavior of RSA Adaptive Directory is to process associated joins and build 2018 
computed attributes whenever a virtual object is reached from a query regardless of whether 2019 
the attributes requested come from a secondary source or computation. If you enable the 2020 
option to process joins and computed attributes only when necessary, RSA Adaptive Directory 2021 
will not perform joins or computations when a client requests or searches for attributes from a 2022 
primary object only. If a client requests or searches for attributes from secondary objects or 2023 
computed attributes, RSA Adaptive Directory will process the join(s) and computations 2024 
accordingly. Use caution when enabling this option if you have interception scripts defined on 2025 
these objects or if access controls based on filters are being used (both of which may require 2026 
other attributes returned from secondary sources or computations regardless of whether or not 2027 
the client requested or searched for them).  2028 

 Use the Client Sizelimit Value to Query the Backend 8.5.42029 
Whenever Adaptive Directory queries a backend LDAP, the default behavior is to ask for all 2030 
entries (sizelimit=0) even if the client to Adaptive Directory indicates a sizelimit. This is the 2031 
default behavior because the entries returned by the backend are possible candidates but may 2032 
not be retained for the final result that is sent to the client. For example, if an ACL has been 2033 
defined in Adaptive Directory, not all entries from the backend may be authorized for the user 2034 
(who is connected to Adaptive Directory) to access. As another example, when joins or 2035 
interception scripts are involved with the virtual view, they may also alter the entries that match 2036 
the client's search. To limit the number of entries from the backend, using paging is the 2037 
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recommended approach. If the backend supports paging, Adaptive Directory will not get all the 2038 
results at once; rather, it will get only one page at a time (pagesize is indicated in the 2039 
configuration). In this case, if Adaptive Directory has returned to the client the sizelimit 2040 
required, Adaptive Directory will not go to the next page. 2041 

If your virtual view does not involve any of the conditions mentioned above (joins, 2042 
interceptions, ACL), and using paging between Adaptive Directory and the backend is not 2043 
possible, you can enable the Client Sizelimit value option to limit the number of entries 2044 
requested from the backend. If this option is enabled, Adaptive Directory will use the sizelimit 2045 
specified by the client instead of using sizelimit=0 when querying the backend. 2046 

9 PRIVILEGED USER ACCESS CONTROL: ALERTENTERPRISE GUARDIAN INSTALLATION 2047 

AlertEnterprise Guardian is installed on the IdAM network, in a VM running the Windows Server 2048 
2012 R2 OS. Guardian is used to control privileged user access to the components located on 2049 
the network OT systems. Guardian collects user authorization information from the AD located 2050 
within the OT network. There are three parts to the AlertEnterprise Guardian How-To guide, 2051 
each of which is provided in the subsections below: Subsection 12.2 provides general product 2052 
installation and set-up information. Subsection 12.3 provides the AlertEnterprise configuration 2053 
information as configured in the RSA build. Subsection 12.4 provides the AlertEnterprise 2054 
configuration information as configured in the CA build. 2055 

9.1 SECURITY CHARACTERISTICS 2056 

Cybersecurity Framework Categories: PR.AC-1: Identities and credentials are managed for 2057 
authorized devices and users 2058 

NIST 800-53 rev 4 Security Controls: AC-2, IA Family  2059 

9.2 INSTALLATION ON TOMCAT AND WINDOWS  2060 

This section describes the detailed procedure of installing AlertEnterprise products on Tomcat 2061 
on a Windows platform. It lists the hardware and software pre-requisites as well as the steps to 2062 
install and use the AlertEnterprise suite of applications.  2063 

When copying text from this guide, it is recommended that you first paste text to a Notepad file 2064 
and then copy it from there to use it for running scripts. You should use the “Notepad++” 2065 
application for this purpose. 2066 

Installation Prerequisites  2067 

The AlertEnterprise Suite is delivered as a WAR (Web application Archive) file that needs to be 2068 
deployed on the client’s application server. Before you actually start deploying on your 2069 
application server, you must check for the pre-requisites. Refer to AlertEnterprise Systems 2070 
Requirements document included in the installation package.  2071 

Pre-Installation Verification  2072 
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Before you start installing AlertEnterprise product, verify the proper functioning of the 2073 
underlying software systems. Verify that:  2074 

• Your system meets all the software and hardware prerequisites as described in Systems 2075 
Requirement Specification document.  2076 

• Compatible version of Java Runtime Environment (JRE) is installed and working on the 2077 
system.  2078 

• Compatible version of the web server is installed and running.  2079 

• Compatible version of the database server is installed and running.  2080 

• Supported Internet Browser (for example, Microsoft Internet Explorer) is working 2081 
properly.  2082 

Zip extracting software is required. You can download WinZip from 2083 
www.winzip.com/downwz.com.  2084 

Installing Mandatory Software Applications  2085 
Before deploying the AlertEnterprise application, install JRE and a Web Application Server (for 2086 
example, Tomcat). You must also install the latest version of Adobe Flash Player to enable the 2087 
Internet browser you will be using to access the AlertEnterprise application.  2088 

Installing JRE  2089 
To install JRE:  2090 

1. Download the application server-compatible JRE.  2091 

2. Double-click the setup launcher to start the installation process.  2092 

Setting Java Home  2093 
1. Make sure that JAVA_HOME variable is set to the folder where Java is installed and 2094 

%JAVA_HOME%/bin is in the system’s path.  2095 

2. Open the Command Prompt in Administrator Mode (Right Click > Run As Administrator) 2096 
and issue:  2097 

 2098 
Set JAVA_HOME=<PATH OF JDK/JRE>  2099 

 2100 
Where <PATH OF JDK/JRE> is the path where Java is installed, for example, 2101 
C:\Program Files\Java\JDK1.6  2102 

 2103 
3. Setting Path:  2104 

 2105 
PATH= C:\Program Files\Java\JDK1.6.0-21\bin;%PATH%  2106 
 2107 

4. Checking JAVA_HOME and PATH:  2108 
 2109 
Echo %JAVA_HOME%  2110 
Echo %PATH% 2111 
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Checking JAVA Version: Java –version 2112 

Running ActiveMQ as Windows Service  2113 
After extracting the folder, the folder name appears as “apache-activemq” at the specified 2114 
location.  2115 
 2116 

1. Go to the folder apache-activemq and move to bin/win32 in Windows 2117 
Explorer and right-click on InstallService.bat file and select Run as 2118 
Administrator. Refer to . 2119 

2. Once the above batch file gets executed, verify that the ActiveMQ is added as Windows 2120 
Services.  2121 

3. Go to Run command and enter services.msc. The Services window appears. Refer 2122 
to the following screen shot.  2123 

 2124 

Figure 127. Adaptive Directory Search Configuration for Accounts 2125 

 2126 
4. The Apache ActiveMQ service has an administrative console. To check if the service is 2127 

running correctly, you simply need to connect to the admin console.  2128 
URL: <IP address of the server where Active MQ is 2129 
installed>:8161/admin 2130 
 2131 

5. Perform the following if Active MQ is on a server other than AlertEnterprise server:  2132 
• Search for the URL that starts with TCP ://<IP Address>:61616 in 2133 

activemq.log located in Apache ActiveMQ home directory/data folder. 2134 
Refer to the following screen shot:  2135 
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 2136 

Figure 128. Guardian ActiveMQ Home/Data Directory 2137 

 2138 
• Copy the URL and update the context.xml file in the <Tomcat 2139 

Home>/conf and appContextDB.properties file located in 2140 
<Tomcat Home/webapps/AlertEnterprise/WEB-INF/classes>.  2141 

 2142 
Steps for Failure Case:  2143 
If the system throws an error message while executing the bat file or the ActiveMQ Services 2144 
screen does not appear, follow these steps:  2145 

1. Navigate to the folder <ActiveMQ home directory>\bin\win32.  2146 

2. Open the InstallService.bat file in a local text editor.  2147 

3. Modify the bottom part of the script to look like the following. Note that your 2148 
JAVA_HOME environment variable needs to already be set and also need to pass it as a 2149 
variable to the wrapper.  2150 

 2151 
:conf  2152 
set WRAPPER_CONF="%ACTIVEMQ_HOME%\bin\win32\wrapper.conf"  2153 
set ACTIVEMQ_HOME="set.ACTIVEMQ_HOME=%ACTIVEMQ_HOME%" 2154 
set ACTIVEMQ_BASE="set.ACTIVEMQ_BASE=%ACTIVEMQ_BASE%"  2155 
set JAVA_HOME="set.JAVA_HOME=%JAVA_HOME%"  2156 
rem  2157 
rem Install the Wrapper as an NT service.  2158 
Rem  2159 
:startup  2160 
"%ACTIVEMQ_HOME%\bin\win32\wrapper.exe" -i %_WRAPPER_CONF% 2161 
%_ACTIVEMQ_HOME% %_ACTIVEMQ_BASE% %_JAVA_HOME%  2162 
if not errorlevel 1 goto :eof  2163 
pause  2164 
 2165 

4. Open the <ActiveMQ home directory>\bin\win32\wrapper.conf in a 2166 
local text editor and change this:  2167 

 2168 
# Java Application  2169 
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wrapper.java.command=java  2170 
to this:  2171 
# Java Application  2172 
wrapper.java.command=%JAVA_HOME%\bin\java.exe  2173 
 2174 
After you have performed these steps, you should be able to run the InstallService.bat 2175 
successfully.  2176 
 2177 

5. To also use the UninstallService.bat file, open it and hard-code the path to 2178 
the wrapper:  2179 

 2180 
rem  2181 
rem Uninstall the Wrapper as an NT service.  2182 
rem  2183 
:startup  2184 
"%ACTIVEMQ_HOME%\bin\win32\wrapper.exe" -r %_WRAPPER_CONF%  2185 
if not error level 1 goto : eof  2186 
pause  2187 
After executing the InstallService.bat file, you can see the ActiveMQ in Services.  2188 
 2189 

6. If the ActiveMQ server is not up and the system throws the following error:  2190 
 2191 
| WARN | tmpdir | org.eclipse.jetty.util.log | WrapperSimpleAppMainjava.io.IOException: The 2192 
system cannot find the path specified  2193 

at java.io.WinNTFileSystem.create File Exclusively (Native Method)  2194 

at java.io.File.check And Create (File.java:1343)  2195 

at java.io.File.create Temp File (File.java:1431)  2196 

 2197 
Solution:  2198 
You must manually create two folders: <ActiveMQ home directory>/work and 2199 
<ActiveMQ home directory>/temp.  2200 
 2201 
To check whether ActiveMQ is started, access the following link as shown in Figure 129.  2202 
http://<Server IP Address>:8161/admin/ 2203 
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 2204 

Figure 129. Guardian ActiveMQ 2205 

 2206 
Installing Apache Tomcat  2207 
You must install hardware and operating system versions specific to Apache Tomcat:  2208 

1. Double-click the setup launcher to start the setup. It will start the installation process.  2209 

2. Click Next to start the installation process.  2210 

3. Click I Agree to accept the license terms. It displays the Choose Components screen.  2211 

4. Select Custom as install type and uncheck the Examples option.  2212 

5. Click Next to specify the Destination Folder for installation. We strictly recommend using 2213 
D:\AlertEnterprise\Tomcat location.  2214 

6. Click Next to specify configuration parameters.  2215 

7. Enter the desired port in the Connector Port text area. 8080 is the default port.  2216 

8. Specify the User Name and Password in the respective fields.  2217 

9. Click Next to select the path of JRE installed on the system.  2218 

10. Select the path of JDK/JRE you just installed. For example, C:\Program 2219 
Files\Java\jre1.6.  2220 

11. Click Install to start the file copying process. Uncheck Run Apache Tomcat and Show 2221 
Readme options in the final dialog box.  2222 

12. Click Finish to finish the installation.  2223 
 2224 
Apache Tomcat Configuration  2225 
You need to specify Tomcat configuration as specified in the following steps:  2226 
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1. Click Start > Programs > Apache Tomcat > Configure Tomcat option.  2227 

2. Click Java tab in the Apache Tomcat Properties dialog box.  2228 

3. Enter the following settings:  2229 

• Initial memory pool: 1024  2230 

• Maximum memory pool: 1024  2231 

• Thread stack size: 300  2232 
 2233 
Note: These settings may vary with the volume of random access memory (RAM) in 2234 
the server. 2235 

 2236 
4. Click Apply and OK to close the dialog box. 2237 

 2238 
Configuring Database Server  2239 
You need to perform some configurations in the database server to install AlertEnterprise 2240 
applications. You must perform these configurations through the database administrator login. 2241 
The current version of AlertEnterprise products supports Oracle and MS SQL Server databases. 2242 
The NCCoE build also supports MySQL server database. 2243 
 2244 
To configure the database server:  2245 

1. Create a schema/SID as per your naming convention in the database server. The steps to 2246 
create schema can be different with different database management systems. Refer to 2247 
the administrators guide for the database management system installed at your 2248 
landscape.  2249 

2. Create a new user with full access to the created schema.  2250 

3. Run the included SQL files AlertReport471.ddl or AlertReport471.sql 2251 
and AlertQuartz.sql on the new schema created. This step should be performed 2252 
while installing the AlertEnterprise application for the first time.  2253 

Avoiding Case-sensitivity Issues in Alert DB  2254 
To avoid case-sensitivity issues while using the search and sort functionalities in the 2255 
AlertEnterprise applications, enable “Case Insensitiveness” search in the database. By default, it 2256 
is set as case-sensitive.  2257 
 2258 
Follow these steps to avoid case-sensitivity issues:  2259 

1. Create a trigger to support case insensitiveness.  2260 
 2261 
/***********/  2262 
create or replace  2263 
trigger set_nls_onlogon  2264 
AFTER LOGON ON SCHEMA  2265 
DECLARE  2266 
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BEGIN  2267 
EXECUTE IMMEDIATE 'ALTER SESSION SET NLS_SORT="BINARY_CI"';  2268 
EXECUTE IMMEDIATE 'ALTER SESSION SET NLS_COMP="LINGUISTIC"';  2269 
END set_nls_onlogon;  2270 
/************/ 2271 

2. Restart the AlertEnterprise Application server.  2272 
 2273 
The effect may not be visible in some client tools like SQL Developer. To see the effect in the 2274 
SQL Developer tool: :  2275 

1. Open SQL Developer and click Tools > Preferences.  2276 

2. Click Database > NLS and do the following:  2277 

• Set the Sort option to BINARY_CI.  2278 

• Set the Comparison option to LINGUISTIC.  2279 
 2280 
Enabling Support for International Characters  2281 
Storage of character data is controlled by character-set setting at database level. It is 2282 
recommended to have the following database settings to support international characters:  2283 
 2284 
For Oracle:  2285 
NLS_CHARACTERSET = AL32UTF8  2286 
NLS_NCHAR_CHARACTERSET = AL16UTF16  2287 
 2288 
For SQL Server:  2289 

• Server Collation = SQL_Latin1_General_CP1_CI_AS  2290 
 2291 
Deploying the Application  2292 
After you have successfully configured the database, proceed to deploy the AlertEnterprise 2293 
product on your web application server. The following deployment steps are required for the 2294 
Tomcat 6.0 version:  2295 
 2296 

1. Stop the Tomcat server from the Windows services if it is already running. Click Start > 2297 
Run and type services.msc then click OK. Select the Apache Tomcat and click the 2298 
Stop Service icon to stop the service.  2299 

2. Copy the AlertEnterprise.war, AccessMap.war (if you possess AlertInsight 2300 
license), and AlertEnterpriseHelp.war, and jasperserver-pro.war files 2301 
to <Tomcat installation folder>\webapps\ path.  2302 

3. You need to copy password management war file AIPM.war to <Tomcat 2303 
installation folder>/webapps if you possess license for the Password 2304 
Management application.  2305 

4. Create a new folder AlertCommonLib and AlertExternalLib under 2306 
<Tomcat Installation Folder>.  2307 
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5. Extract AlertCommonLib.zip under AlertCommonLib folder. You will see 2308 
many new files in this folder.  2309 

6. Edit the <Tomcat Installation Folder>\conf\catalina.properties 2310 
using any editor and add append the following to the common.loader as described 2311 
below:  2312 
common.loader=${catalina.base}/lib,${catalina.base}/lib/*.jar,${catalina.home}/lib,${cat2313 
alina.home}/lib/*.jar,${catalina.home}/AlertCommonLib/*.jar,${catalina.home}/AlertExt2314 
ernalLib/*.jar (bold path added). Save the file and close the editor.  2315 

7. Add Database Connection. Add a new <resource> entry as below with name 2316 
"jdbc/alntdb" in < Tomcat installation folder>\conf\context.xml. 2317 
Replace the code in <> with relevant information.  2318 
 2319 
For MY-SQL Server: 2320 

 2321 
<Resource  2322 
description="DB Connection"  2323 
name="jdbc/alntdb" auth="Container"  2324 
type="com.mchange.v2.c3p0.ComboPooledDataSource" 2325 
factory="org.apache.naming.factory.BeanFactory"  2326 
user="username"  2327 
password="password" 2328 
jdbcUrl="jdbc:mysql://<IP of DB Server>:3306/<DB Instance Name>"  2329 
driverClass="com.mysql.jdbc.Driver"  2330 
maxPoolSize="100" minPoolSize="5" acquireIncrement="5"  2331 
numHelperThreads="20" maxIdleTime="600" 2332 
maxIdleTimeExcessConnections="300"  2333 
debugUnreturnedConnectionStackTraces="true" 2334 
unreturnedConnectionTimeout="900"  2335 
/> 2336 
 2337 

For repository setting in same context.xml, add the following entry: 2338 
  2339 
<ResourceLink name="AlertEnterpriseRepo" global="AlertEnterpriseRepo" 2340 
type="javax.jcr.Repository" />  2341 
 2342 

For ActiveMQ settings in same context.xml, add the following entry: 2343 
  2344 

<Resource name="jms/connectionFactory"  2345 
   auth="Container" 2346 
      type="org.apache.activemq.ActiveMQConnectionFactory" 2347 
      description="JMS Connection Factory" 2348 
      factory="org.apache.activemq.jndi.JNDIReferenceFactory" 2349 
      brokerURL="tcp://localhost:61616" 2350 
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      brokerName="LocalActiveMQBroker" 2351 
      useEmbeddedBroker="false"/> 2352 
    2353 
   <Resource name="jms/requestSubmissionQueue"  2354 
    auth="Container" 2355 
     type="org.apache.activemq.command.ActiveMQQueue" 2356 
     description="JMS Queue requestSubmissionQueue" 2357 
     factory="org.apache.activemq.jndi.JNDIReferenceFactory" 2358 
     physicalName="requestSubmissionQueue"/> 2359 
       2360 
   <Resource name="jms/requestApprovalQueue"  2361 
  auth="Container" 2362 
    type="org.apache.activemq.command.ActiveMQQueue" 2363 
    description="JMS Queue requestApprovalQueue" 2364 
    factory="org.apache.activemq.jndi.JNDIReferenceFactory"  2365 
    physicalName="requestApprovalQueue"/> 2366 
       2367 
   <Resource name="jms/autoApprovalQueue"  2368 
    auth="Container" 2369 
     type="org.apache.activemq.command.ActiveMQQueue" 2370 
     description="JMS Queue autoApprovalQueue" 2371 
     factory="org.apache.activemq.jndi.JNDIReferenceFactory" 2372 
     physicalName="autoApprovalQueue"/> 2373 
      2374 
   <Resource name="jms/queue/taskSubmissionQueue"  2375 
        auth="Container" 2376 
        type="org.apache.activemq.command.ActiveMQQueue" 2377 
        description="JMS Queue taskSubmissionQueue" 2378 
        factory="org.apache.activemq.jndi.JNDIReferenceFactory" 2379 
        physicalName="taskSubmissionQueue"/> 2380 
         2381 
   <Resource name="jms/queue/taskRejectionQueue"  2382 
        auth="Container" 2383 
        type="org.apache.activemq.command.ActiveMQQueue" 2384 
        description="JMS Queue taskRejectionQueue" 2385 
        factory="org.apache.activemq.jndi.JNDIReferenceFactory" 2386 
        physicalName="taskRejectionQueue"/> 2387 
    2388 
   <Resource name="jms/queue/projectCancelQueue"  2389 
        auth="Container" 2390 
        type="org.apache.activemq.command.ActiveMQQueue" 2391 
        description="JMS Queue projectCancelQueue" 2392 
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        factory="org.apache.activemq.jndi.JNDIReferenceFactory" 2393 
        physicalName="projectCancelQueue"/> 2394 
    2395 
   <Resource name="jms/queue/projectCompleteQueue"  2396 
        auth="Container" 2397 
        type="org.apache.activemq.command.ActiveMQQueue" 2398 
        description="JMS Queue projectCompleteQueue" 2399 
        factory="org.apache.activemq.jndi.JNDIReferenceFactory" 2400 
        physicalName="projectCompleteQueue"/> 2401 
         2402 
   <Resource name="jms/eventRequestQueue" 2403 
        auth="Container" 2404 
  type="org.apache.activemq.command.ActiveMQQueue" 2405 
  description="JMS Queue eventRequestQueue" 2406 
  factory="org.apache.activemq.jndi.JNDIReferenceFactory" 2407 
  physicalName="eventRequestQueue"/> 2408 
 2409 
<Resource auth="Container" description="my Queue" 2410 
factory="org.apache.activemq.jndi.JNDIReferenceFactory" 2411 
name="jms/reqQueue" physicalName="requestQueue" 2412 
type="org.apache.activemq.command.ActiveMQQueue"/> 2413 
 2414 
<Resource auth="Container" description="my Queue" 2415 
factory="org.apache.activemq.jndi.JNDIReferenceFactory" 2416 
name="jms/resQueue" physicalName="responseQueue" 2417 
type="org.apache.activemq.command.ActiveMQQueue"/> 2418 
 2419 

8. Edit <Tomcat installation folder>\conf\server.xml. Replace the 2420 
code in <> with relevant information: 2421 

  2422 
<GlobalNamingResources> 2423 
 <! -- Editable user database that can also be used by 2424 
   UserDatabaseRealm to authenticate users 2425 
 -> 2426 
<Resource auth="Container" 2427 
configFile="/AlertEnterpriseRepo/repository.xml"  2428 
description="AlertEnterprise Repository" 2429 
factory="com.alnt.repository.jndi.JackrabbitRepositoryFactory"  2430 
homeDir="/AlertEnterpriseRepo" name="AlertEnterpriseRepo" 2431 
type="javax.jcr.Repository"/> 2432 
 2433 
<Resource auth="Container" description="Rule Engine Service" 2434 
factory="com.sae.ruleengine.jndi.RuleEngineFactory"  2435 
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name="Sedna" password="MANAGER" type="com.sae.ruleEngine.RuleEngine" 2436 
username="SYSTEM"/> 2437 
<Resource name="UserDatabase" auth="Container" 2438 
type="org.apache.catalina.UserDatabase" 2439 
description="User database that can be updated and saved" 2440 
factory="org.apache.catalina.users.MemoryUserDatabaseFactory" 2441 
pathname="conf/tomcat-users.xml"/> 2442 
</GlobalNamingResources> 2443 
 2444 
 2445 

9. Open <Webserver installation folder>\bin location and double-click tomcat5w.exe. Click 2446 
Java tab and under Java options add the following lines at the end:  2447 

 2448 
-XX:PermSize=512m 2449 
-XX:MaxPermSize=512m 2450 
-Xms1024m 2451 
-Xmx1024m 2452 
-Djs.license.directory=C:\AlertApplication\Tomcat 2453 
6.0\webapps\jasperserver-pro 2454 
-Dcom.alnt.fabric.loadInitData=force 2455 
-Dalert.db.update=update 2456 
 2457 

Note: These settings may vary with the volume of RAM in the server.  2458 
 2459 

10. Start the Tomcat server.  2460 
11. Start the AlertEnterprise application by using the address, which is of the form 2461 

http://<Server IP Address>:8080/AlertEnterprise.  2462 
Note: The name and contents of the init script will vary depending on the database 2463 
management system of the organization. 8080 is the default port on local host. If you 2464 
want to change it, then change it in the sever.xml.  2465 

12. Log on to the application by using admin credentials. You should be able to view Home 2466 
screen of the application.  2467 

9.3 ALERTENTERPRISE APPLICATION CONFIGURATIONS FOR THE RSA BUILD 2468 

Systems/Connectors 2469 

 System Type Import of DB Connector: 9.3.12470 

1. Log in to Application. 2471 

2. Go to Setup tab > Manual Configuration > Import/Export. 2472 

3. Check System Types and click on Import.  2473 
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4. Select the .csv files, which are there in the software build package under connector 2474 
\ALNTDbconnector\InitDataFiles folder. 2475 

5. After selecting all the files, click on the Upload button. 2476 

6. Refresh page until it shows as success or failed. 2477 

7. Restart the server if required. 2478 

 System Types Param of DB Connector: 9.3.22479 

1. Log in to Application. 2480 

2. Go to Setup tab >Manual Configuration >Systems > System Types. 2481 

3. Search for Connector named “DBConnector” and click on Modify button. 2482 

4. Click on Next button. 2483 

5. Add the following attributes one by one and click on the ADD button – 2484 
The following fields need to be provided under Name field and Label can be any user-2485 
friendly name see Figure 130. 2486 

CREATE_USER0 2487 
UPDATE_USER0 2488 
LOCK_USER0 2489 
UNLOCK_USER0 2490 
DELIMIT_USER0 2491 
USER_PROVISIONED0 2492 
ADD_ROLES0 2493 
DEPROVE_ROLES0 2494 
CREATE_USER1 2495 
LOCK_USER1 2496 

 2497 

 2498 
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 2499 

 2500 

Figure 130. Guardian DB Connector Attributes 2501 

CONFIGURATION: Create “PACS AD” System 2502 

1. Setup > Manual Configuration > Systems > System. 2503 

2. Click on New to create a new system. 2504 

3. Definition…Enter the following: 2505 

• System Type – LDAP from drop-down 2506 

• Connector Name – PACS AD 2507 

• Connector Description - PACS AD 2508 

• Connector Long Description - PACS AD 2509 

• Connector Type – LDAP (default) 2510 

4. Click on Next. 2511 

5. Parameters…Enter the following: 2512 

Table 9. Guardian PACS AD Parameters 2513 

System Param Name System Param Value 

bindPass o60ypIUQT3IOqHmbuRWeuw== 

useSSL FALSE 

baseDns DC=pacs-es-idam-b1,DC=test 

groupBaseDn DC=pacs-es-idam-b1,DC=test 

reconBaseDN 

 getIncrementGrpChanges FALSE 
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System Param Name System Param Value 

wsdlURL   

wsUserName   

wsPwd   

rootLevelDomain   

cookieLocation   

adUserName   

SYS_CON_ATTR_POST_CREATE_SCRIPT   

SYS_CON_ATTR_POST_CREATE_SCRIPT_PARAMS   

objectClass User 

Skipprovisioning Yes 

lastModifiedColumnRole whenChanged 

lastModifiedColumn whenChanged 

host 172.16.7.2 

port 389 

bindDn 
CN=AlertEnterprise, 
CN=Users,DC=pacs-es-idam-b1,DC=test 

6. Click on Next. 2514 

7. Attributes…Enter the following: 2515 

• Application – Alert Access 2516 

• Check the following boxes – Provisioning, Role Management, Offline System. 2517 

• Leave Connector Category as Production. 2518 

• Time Zone – Greenwich Mean Time from drop-down 2519 

8. Click on Next. 2520 

9. Click on Save. 2521 

CONFIGURATION: Create “Identity DB” System 2522 
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1. Setup > Manual Configuration > Systems > System. 2523 

2. Click on New to create a new system. 2524 

3. Definition…Enter the following: 2525 

• System Type – Database (JDBC J2EE) from drop-down 2526 

• Connector Name – IDENTITYDB 2527 

• Connector Description - IDENTITYDB 2528 

• Connector Long Description - IDENTITYDB 2529 

• Connector Type – Database (JDBC J2EE) (default) 2530 

4. Click on Next. 2531 

5. Parameters…Enter the following: 2532 

Table 10. Guardian Identity DB Parameters 2533 

System Param Name System Param Value 

driverName   

url   

userName   

password   

whereClause 

 jndiName java:comp/env/jdbc/alntdb 

6. Click on Next. 2534 

7. Attributes…Enter the following: 2535 

• Application – All 2536 

• Check the following boxes – Provisioning, Certification, Identity Provider, Allow 2537 
Modify Role and Allow Time Change. 2538 

• Leave Connector Category as Production. 2539 

• Time Zone – Eastern Daylight Time from drop-down 2540 

8. Click on Next. 2541 

9. Click on Save. 2542 

CONFIGURATION: Create “ACCESSIT PACS” System 2543 



DRAFT 
   

149 | NIST Cybersecurity Practice Guide SP 1800-2c 
 

1. Setup > Manual Configuration > Systems > System. 2544 

2. Click on New to create a new system. 2545 

3. Definition…Enter the following: 2546 

• System Type – DBConnector from drop-down 2547 

• Connector Name – ACCESSIT PACS 2548 

• Connector Description - ACCESSIT PACS 2549 

• Connector Long Description - ACCESSIT PACS 2550 

• Connector Type – DBConnector (default) 2551 

4. Click on Next. 2552 

5. Parameters…Enter the following: 2553 

Table 11. Guardian ACCESSIT PACS Parameters 2554 

System Param Name System Param Value 

driverName   

URL  jdbc:sqlserver://<HOST_NAME>:<PORT>;databaseName=AI
Universal 

userName  DB User Name 

password  DB User Password 

Date and Time Format CardholderID 

External UserId Attribute CardholderID 

Create CardHolder Query INSERT INTO 
[AIUniversal].[dbo].[Cardholders]([CardholderID],[LastName],[FirstName],[MiddleInitial],[C
ompanyID],[Notes],[LastModified],[LastModifiedByUser],[DateCreated],[CreatedByUser],[
MemberOfAllSites],[UserText1],[UserText2],[UserText3],[UserText4],[UserText5],[UserText6
],[UserText7],[UserText8],[UserText9],[UserText10],[UserText11],[UserText12],[UserText13],
[UserText14],[UserText15],[UserText16],[UserText17],[UserText18],[UserText19],[UserText2
0],[Department],[UserDate1],[UserDate2],[UserDate3],[UserDate4],[UserDate5],[UserNum
eric1],[UserNumeric2],[UserNumeric3],[UserNumeric4],[UserNumeric5],[CardholderStatus
],[CardholderActiveDate],[CardholderExpireDate]) VALUES 
(NEWID(),$LastName,$FirstName,$MiddleInitial,$CompanyID,$Notes,GetUTCDate(),'alerte
nt',GetUTCDate(),'alertent','1',$UserText1,$UserText2,$UserText3,$UserText4,$UserText5,$
UserText6,$UserText7,$UserText8,$UserText9,$UserText_10,$UserText_11,$UserText_12,$
UserText_13,$UserText_14,$UserText_15,$UserText_16,$UserText_17,$UserText_18,$User
Text_19,$UserText_20,$Department,$UserDate1,$UserDate2,$UserDate3,$UserDate4,$Us
erDate5,$UserNumeric1,$UserNumeric2,$UserNumeric3,$UserNumeric4,$UserNumeric5,'
1',$CardholderActiveDate,$CardholderExpireDate) 

 

Update CardHolder Query update [dbo].[Cardholders] set LastModified=GetUTCDate() where 
CardholderID=$CardholderID 
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System Param Name System Param Value 

Lock CardHolder Query update [dbo].[Cardholders] set CardholderStatus='0' where CardholderID=$CardholderID 

Unlock Card Holder Query update [dbo].[Cardholders] set CardholderStatus='1' where CardholderID=$CardholderID 

Check Card Holder Provisioned 
Query 

select CardholderID from [dbo].[Cardholders] where CardholderID =$CardholderID 

Assign Roles to Card Holder Query INSERT INTO [dbo].[CardholderAccessLevels] ( [CardholderAccessLevelID],  
[CardholderID], [AccessLevelID],[LastModified],[ActivateDate],[DeactivateDate]) VALUES ( 
NEWID(), $CardholderID,(select AccessLevelID from [dbo].[AccessLevels] where 
AccessLevelName=$ROLE_NAME),GetUTCDate(), NULL, NULL) 

Remove Roles From Card Holder 
Query 

delete from [dbo].[CardholderAccessLevels] where CardholderID=$CardholderID and 
AccessLevelID=(select AccessLevelID from [dbo].[AccessLevels] where 
AccessLevelName=$ROLE_NAME) 

Retrieve User Id Query select CardholderID from [dbo].[Cardholders] where UserText1=$UserText1 

CREATE_USER1 INSERT INTO [AIUniversal].[dbo].[Cards] 
([CardID],[CardholderID],[CardNumber],[FacilityCode],[PINNumber],[PINExempt],[APBExe
mpt],[UseExtendedAccessTimes],[CardStatus],[ActiveDate],[ExpireDate],[UserLevel],[UseC
ustomReporting],[EventInfo],[Notes],[LastModified],[LastModifiedByUser],[DateCreated],[
CreatedByUser],[IssueLevel],[DeactivateExempt],[VacationDate],[VacationDuration],[UseCo
unt],[TempDeactivateStart],[TempDeactivateEnd],[Classification],[IPLocksetUserType],[IPLo
cksetAccessMode],[IPLocksetCredentialFormat],[IPLocksetAccessAlways],[RawPrimaryCred
ential],[LargeEncodedCardID],[EmbossedNumber])  VALUES (NEWID(),(select CardholderID 
from [dbo].[Cardholders] where 
UserText1=$UserText1),$CardNumber,$FacilityCode,$PIN,'0','0','0','1',NULL,NULL,'0','0',NUL
L,NULL,SYSDATETIME(),'alertent',SYSDATETIME(),'alertent','0','0',NULL,'0','255',NULL,NULL,'
Active',NULL,NULL,NULL,NULL,NULL,NULL,'') 

LOCK_USER1 update [AIUniversal].[dbo].[Cards] set CardStatus='0',Classification='InActive' where 
[CardNumber]=$CardNumber 

6. Click on Next. 2555 

7. Attributes…Enter the following: 2556 

• Application – All 2557 

• Check the following boxes – Provisioning, Role Management, and Offline System. 2558 

• Leave Connector Category as Production. 2559 

• Time Zone – Eastern Daylight Time from drop-down 2560 

8. Click on Next. 2561 

9. Click on Save. 2562 

Identity & Access– Enable Identity 2563 

1. Setup > Manual Configuration >Identity & Access>Enable Identity. 2564 

2. Enable the following for “Identity DB” system, see Figure 131. 2565 

https://support.ca.com/?x=DJYF4f1B6N9tKHZ2JT30Sg?x=DJYF4f1B6N9tKHZ2JT30Sg
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 2566 

Figure 131. Guardian Identity Configuration 2567 

 Identity & Access– User Field Mapping 9.3.32568 

1. Setup > Manual Configuration > Identity & Access > User Field Mapping. 2569 

2. Select User = Identity (from drop-down) and click on Go. 2570 

3. Click the Create New button. 2571 
Select values for respective fields and hit on save (Refer to below sheet for values 2572 
selection.) 2573 

4. Repeat Steps 1–4 for all fields in the sheet.  2574 

Follow the steps above to configure the User Field mappings manually. You can match the 2575 
values in the file at https://nccoe.nist.gov/sites/default/files/nccoe/UserFieldMapping_data.csv. 2576 

Identity & Access > Recon Authoritative Fields 2577 

1. Setup > Manual Configuration > Identity & Access > Recon Authoritative Fields. 2578 

2. Click on Create. 2579 

3. Enter the following shown in Figure 132. 2580 

 2581 

Figure 132. Guardian Recon Authoritative Fields 2582 

Identity & Access > Request Categories 2583 

1. Setup > Manual Configuration > Identity & Access > Request Categories. 2584 

2. Click on New. 2585 

3. Enter following at define Request Category screen: 2586 

• Name – New Hire 2587 

• Description – New Hire 2588 
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• Visible – Yes 2589 

• Hover Text –  2590 

• Provisioning Actions – Create User, Change Roles 2591 

• Request Category Type - Resources 2592 

• Display the following in USS – Enterprise Roles 2593 

4. Click on Save. 2594 

5. Repeat similar to above for following Request Categories: 2595 

Termination 2596 

• Name – Change Access 2597 

• Description – Change of Access 2598 

• Visible – Yes 2599 

• Hover Text –  2600 

• Provisioning Actions – Create User, Change Roles, Change User 2601 

• Display the following in USS – Resources 2602 

• Add Existing – Systems and Remove Roles 2603 

6. Click on Save. 2604 

ChangeAccess 2605 

o Name – Terminate 2606 

o Description – Terminate User 2607 

o Visible – Yes 2608 

o Hover Text –  2609 

o Provisioning Actions – Lock User, Change Roles 2610 

o Display the following in USS – Resources 2611 

o Add Existing – Systems 2612 

7. Click on Save. 2613 

Identity & Access>Provisioning>Provisioning Mapping 2614 

1. Setup > Manual Configuration > Identity & Access > Provisioning > Provisioning Mapping. 2615 

2. On the next screen select System and click Next. 2616 
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3. Follow the mapping shown in Figure 133 to Create/Update provisioning mappings for 2617 
the ACCESS IT PACS system. 2618 

 2619 

Figure 133. Guardian DB Connector Attribute Mapping 2620 

User Data> User Data Source 2621 

1. Setup > Manual Configuration > User Data > User Data Source. 2622 

2. Follow the mappings and configurations found in the files at 2623 
https://nccoe.nist.gov/sites/default/files/nccoe/UserManagement-UserDataSource.zip. 2624 
Create/Update accordingly.  2625 

User Data> User Mapping 2626 

1. Setup > Manual Configuration > User Data > User Mapping. 2627 

2. Select “Identity DB” system from the list and click on Save button. 2628 

Policy Engine> Rules 2629 

1. Setup > Manual Configuration > Policy Engine > Rules. 2630 

2. Click on New and add the following: 2631 

Table 12. Guardian Policy Engine Rules 2632 

 2633 

 2634 
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Policy Engine> Suggest/Default Access 2635 

1. Setup > Manual Configuration > Policy Engine > Suggest/Default Access. 2636 

2. Click on New and enter the following: 2637 

Table 13. Guardian Policy Engine Suggest/Default Access 2638 

Name Type Rule Name Search 
By 

Default 
System 

Selected 
Role 

All Door Access Default All Door Access NEW Systems ACCESSIT 
PACS 

ALL DOORS 

Home Access Level Default Home Access Level Systems ACCESSIT 
PACS 

Home 
Access 
Level 

WO Access Level Default Home Access Level Systems ACCESSIT 
PACS 

WO Access 
Level 

NewHireDefaultSystems Default NewHireDefaultSyst
ems 

Systems ACCESSIT 
PACS 

 

 2639 

Policy Engine>Rule Action Handler 2640 

1 – Setup > Manual Configuration > Policy Engine > Rule Action Handler. 2641 

 2 – Click New and create the following Action Handlers: 2642 

Table 14. Guardian Policy Engine Rule Action Handler 2643 

Action Handler 
Name Workflow Task Type Value Priority 

Update 
Identity 

Info 

Evaluate 
Enterprise 

Role 

Recon New Hire AlertAccess Recon Create 
Request 

New Hire 0 Yes No 

Recon terminate 
Handler 

AlertAccess Recon Create 
Request 

Terminate 0 Yes No 

Recon Error 
Handler 

AlertAccess Recon 
Exception 
Record Task 

 0   
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ReconChangeHa
ndler 

AlertAccess Recon Create 
Request 

Change 
Access 

0 Yes No 

 2644 

Policy Engine>Policy Designer 2645 

1. Setup > Manual Configuration > Policy Engine > Policy Designer 2646 

2. Select New to create new Policy designer as: 2647 

User Policy New 2648 

1. Name – User Policy New 2649 
2. Rule Type – AlertAccess 2650 
3. Description – User Policy 2651 
4. Priority – 29 2652 
5. Active – Yes  2653 
6. Default Process – No 2654 

Figure 134 depicts the new policy interface to create the User Policy described above. 2655 



DRAFT 
   

156 | NIST Cybersecurity Practice Guide SP 1800-2c 
 

 2656 

Figure 134. Guardian User Policy 2657 

The following table describes User Policy New. 2658 

Table 15. Guardian User Policy 2659 

Step Name Type Condition Is Task 
handler Task Handler Update 

Query 

1 
User ID 
Check Decision 

$masterUser[UserId]
.size='0'    

2 Create User 
Task 

Handler  Yes 
Recon New 

Hire  

3 
Terminate 

Check Decision 

$checkStatus[UserSt
atus,Active,InActive]

.action='LOCK'    

4 Terminate 
Task 

Handler  Yes Recon 
Terminate 
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Step Name Type Condition Is Task 
handler Task Handler Update 

Query 

Handler 

5 

Remove 
Access 
Check Decision 

$checkAuthFields[].s
tatus='Yes'    

6 
Error 

Handler 
Task 

Handler  Yes 
Recon Error 

Handler  

7 
Change 
Handler 

Task 
Handler  Yes 

Recon Change 
Handler  

 2660 

Job Scheduler>Triggers Field Map 2661 

1. Setup > Manual Configuration > Job Scheduler > Triggers Field Map 2662 

2. Click on New. 2663 

3. Enter Group Name – PACSAD Field Map 2664 

4. Description – PACSAD Field Mapping 2665 

5. Select Type – Reconciliation 2666 

6. After creating Field Map, select the newly created map and select Configure. 2667 

7. Click New and create mapping per below table.  2668 
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Table 16. Guardian Job Scheduler Triggers Field Map 2669 

 2670 

Job Scheduler>Triggers 2671 

1. Setup > Manual Configuration > Job Scheduler > Triggers 2672 

2. Click New and create the following Triggers: 2673 
AlertDbConnectorTrigger 2674 
 2675 

Table 17. Guardian Job Scheduler Triggers 2676 

Name PACSAD Trigger 

Description PACSAD Trigger 

Type Reconciliation 

Batch Size 100 

Number of Attempts 3 

Policy Designer for User policy New 

AE Attribute 
Mapped 

Key userType 
roleTyp

e 
userRol

e 
userBadg

e 

userEnt 
RoleTyp

e 

User 
Trainin

g 
Type 

sAMAccountName UserId TRUE FALSE FALSE FALSE FALSE FALSE 

accountExpires ValidTo TRUE FALSE FALSE FALSE FALSE FALSE 

givenName FirstName TRUE FALSE FALSE FALSE FALSE FALSE 

sn LastName TRUE FALSE FALSE FALSE FALSE FALSE 

userAccountContr
ol statusLDAP TRUE FALSE FALSE FALSE FALSE FALSE 

pacsAllDoors PacsAllDoors TRUE FALSE FALSE FALSE FALSE FALSE 

pacsHomeAccess 
PacsHomeAcces
s TRUE FALSE FALSE FALSE FALSE FALSE 

pacsWorkAccess PacsWorkAccess TRUE FALSE FALSE FALSE FALSE FALSE 
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Users/Roles 

System: 
Reconciliation From 

PACS AD 

Reconciliation System PACS AD 

Field Mapping Group PACSAD Field Map 

User Type True 

User Role True 

 2677 
Job Scheduler>Scheduler 2678 

1. Setup > Manual Configuration > Job Scheduler > Scheduler. 2679 

2. Click New and enter the following as shown in Figure 135: 2680 

● Job Type – Reconciliation Job 2681 

● Job Name - <Job Name> 2682 

● Reconciliation for – User 2683 

● Reconciliation Type – Incremental Reconciliation 2684 

● Reconciliation Triggers – PACSAD Trigger 2685 

● Select the schedule as Immediate, Once, periodic or Advance.For Periodic Job, 2686 
specify the Job Start date, End date, and duration of job frequency. 2687 
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 2688 

Figure 135. Guardian Reconciliation Job 2689 

3. Click Save. 2690 

9.4 SECTION 3. ALERTENTERPRISE APPLICATION CONFIGURATIONS FOR THE CA BUILD 2691 

 System Type Import of DB Connector: 9.4.12692 

1. Log in to Application. 2693 

2. Go to Setup tab > Manual Configuration > Import/Export 2694 

3. Check System Types and click on Import.  2695 

4. Select the .csv files, which are there in software build package under Connector 2696 
\ALNTDbconnector\InitDataFiles folder. 2697 

5. After selecting all the files, click on Upload button. 2698 
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6. Refresh page until it shows as success or failed. 2699 

7. Restart the server if required. 2700 

 System Types Param of DB Connector: 9.4.22701 

1. Log in to Application. 2702 

2. Go to Setup tab> Manual Configuration _> Systems > System Types 2703 

3. Search for Connector named “DBConnector” and click on Modify button. 2704 

4. Click on Next. 2705 

5. Add the following attributes one by one and click on the ADD button. 2706 

The following fields in Table 18 need to be provided under Name field and Label can 2707 
be any user-friendly name as shown in 2708 

2709 
 and Figure 136: (If the name or label already exists do not add) 2710 

Table 18. Guardian Name and Label Fields 2711 

Name Label 

jndiName Jndi Name 

DATE_TIME_FORMAT Date and Time Format 

DATE_TIME Date Format 

passwordColumnName Passwrd Column Name 

userIdColumnName UserId Column Name 

EXTERNAL_USER_ID_ATTRIBUTE External UserId Attribute 

MODIFIED_ENTITLEMENTS Fetch User Entitlement based on last 
modified date(not by user) 

GET_ALL_USERS0 GET_ALL_USERS0 

GET_INCREMENTAL_USERS0 GET_INCREMENTAL_USERS0 
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CREATE_USER0 Create CardHolder Query 

UPDATE_USER0 Update CardHolder Query 

LOCK_USER0 Lock CardHolder Query 

UNLOCK_USER0 Unlock Card Holder Query 

DELIMIT_USER0 Change CardHolder Validity Query 

USER_PROVISIONED0 Check Card Holder Provisioned Query 

ADD_ROLES0 Assign Roles to Card Holder Query 

DEPROVE_ROLES0 Remove Roles From Card Holder Query 

GET_GENERATED_USERID0 Retrieve User Id Query 

driverName driverName 

url URL 

userName userName 

password password 

CREATE_USER1 CREATE_USER1 

LOCK_USER1 LOCK_USER1 

 2712 

 2713 

 2714 
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 2715 

Figure 136. Guardian DB Connector Attributes 2716 

 Create System Connectors for all Target Systems 9.4.32717 
 2718 

1. CONFIGURATION: Create connector for “Alert User Database (External)” 2719 

This connector is required to connect the Alert user table exposed to third-party systems (CA in 2720 
this case) and get the data. 2721 

Steps to create this connector: 2722 

1. Setup Tab > Manual Configuration > Systems > System. 2723 

2. Click New to create a new system. 2724 

3. Definition…Enter the following: 2725 

● System Type – DBConnector 2726 

● Connector Name – ALERTDBCONNECTOR 2727 

● Connector Description – ALERT DB CONNECTOR 2728 

● Connector Long Description – ALERT DB CONNECTOR 2729 

● Connector Type – DbConnector (Label) 2730 

4. Click on Next. 2731 

5. Parameters…Enter the following: 2732 

Table 19. Guardian Manual Configuration System Parameters 2733 

System Param Name System Param Value 

Jndi Name  java:comp/env/jdbc/alertdb 

Date and Time Format  MM/dd/yyyy HH:mm:ss 

GET_ALL_USERS0 

select UserId, 
FirstName,LastName,Email,WorkPhone,HomePhone,Department,EmployeeType,PacsAllDoor,Case 
WHEN PacsAllDoor='1' then 'TRUE' Else 'FALSE' END as PacsAllDoor,CASE WHEN 
PacsHomeAccess='1' then 'TRUE'else 'FALSE' END as PacsHomeAccess , CASE WHEN 
PacsWorkAccess='1' then 'TRUE' else 'FALSE' END as 
PacsWorkAccess,CardNumber,FacilityCode,LastModifiedDate,ValidFrom,ValidTo,Title,UserStatus,PIN 
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System Param Name System Param Value 

from alnt_idm_user_dtls 

GET_INCREMENTAL_USERS0 

 select UserId, 
FirstName,LastName,Email,WorkPhone,HomePhone,Department,EmployeeType,PacsAllDoor,Case 
WHEN PacsAllDoor='1' then 'TRUE' Else 'FALSE' END as PacsAllDoor,CASE WHEN 
PacsHomeAccess='1' then 'TRUE'else 'FALSE' END as PacsHomeAccess , CASE WHEN 
PacsWorkAccess='1' then 'TRUE' else 'FALSE' END as 
PacsWorkAccess,CardNumber,FacilityCode,LastModifiedDate,ValidFrom,ValidTo,Title,UserStatus,PIN 
from alnt_idm_user_dtls where LastModifiedDate> STR_TO_DATE($LAST_RUN_DATE,'%m/%e/%Y 
%H:%i:%s') and UserStatus='Active' 

External UserId Attribute  UserId 

UserId Column Name UserId 

 2734 

6. Click on Next. 2735 

7. Attributes…Enter the following: 2736 

● Application – Alert Access 2737 

● Check the following boxes – Provisioning, Role Management, Offline System. 2738 

● Leave Connector Category as Production 2739 

● Time Zone – Eastern Daylight Time from drop-down 2740 

Note: TimeZone should be same as the TimeZone where application is hosted. 2741 

8. Click on Next. 2742 

9. Click on Save. 2743 

 2744 

2. CONFIGURATION: Create “Identity DB” System 2745 

This is connector is required for internal purposes. Ignore this step if Identity DB Connector 2746 
already setup 2747 

Steps to create this connector: 2748 

1. Setup Tab > Manual Configuration > Systems > System. 2749 

2. Click New to create a new system. 2750 

3. Definition…Enter the following: 2751 

● System Type – Database (JDBC J2EE) from drop-down 2752 

● Connector Name – IDENTITYDB 2753 

● Connector Description - IDENTITYDB 2754 
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● Connector Long Description - IDENTITYDB 2755 

● Connector Type – Database (JDBC J2EE) (default) 2756 

4. Click on Next. 2757 

5. Parameters…Enter the following: 2758 

  2759 
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Table 20. Guardian Identity DB Parameters 2760 

System Param Name System Param Value 

driverName  (use default) 

url  (use default) 

userName  (use default) 

password  (use default) 

whereClause (use default) 

jndiName java:comp/env/jdbc/alntdb 

6. Click on Next. 2761 

7. Attributes…Enter the following: 2762 

• Application – All 2763 

• Check the following boxes – Provisioning, Certification, Identity Provider, Allow 2764 
Modify Role and Allow Time Change. 2765 

• Leave Connector Category as Production 2766 

• Time Zone – Eastern Daylight Time from drop-down 2767 

8. Click on Next. 2768 

9. Click on Save. 2769 

3. CONFIGURATION: Create “ACCESSIT PACS” System 2770 

This is connector is required for integrating with RS2 PACS system and performing various 2771 
provisioning operations. 2772 

Steps to create this connector: 2773 

1. Setup Tab > Manual Configuration > Systems > System. 2774 

2. Click New to create a new system. 2775 

3. Definition…Enter the following: 2776 

● System Type – DBConnector from drop-down 2777 

● Connector Name – ACCESSIT PACS 2778 

● Connector Description - ACCESSIT PACS 2779 

● Connector Long Description - ACCESSIT PACS 2780 
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● Connector Type – DBConnector (default) 2781 

4. Click on Next. 2782 

5. Parameters…Enter the following: 2783 

Table 21. Guardian PACS DBConnector Parameters 2784 

System Param Name System Param Value 

driverName  com.microsoft.sqlserver.jdbc.SQLServerDriver 

URL jdbc:sqlserver://<HOST_NAME>:<PORT>;databaseName=AI
Universal 

<HOST_NAME> should be replaced with the hostname of 
the RS2 PACS system 

username  Login User Name to connect to RS2 PACS database 

Password  Login password to connect to RS2 PACS database 

Date and Time Format MM/dd/yyyy HH:mm:ss 

External UserId Attribute CardholderID 

Create CardHolder Query INSERT INTO 
[AIUniversal].[dbo].[Cardholders]([CardholderID],[LastName],[FirstName],[MiddleInitial],[C
ompanyID],[Notes],[LastModified],[LastModifiedByUser],[DateCreated],[CreatedByUser],[
MemberOfAllSites],[UserText1],[UserText2],[UserText3],[UserText4],[UserText5],[UserText6
],[UserText7],[UserText8],[UserText9],[UserText10],[UserText11],[UserText12],[UserText13],
[UserText14],[UserText15],[UserText16],[UserText17],[UserText18],[UserText19],[UserText2
0],[Department],[UserDate1],[UserDate2],[UserDate3],[UserDate4],[UserDate5],[UserNum
eric1],[UserNumeric2],[UserNumeric3],[UserNumeric4],[UserNumeric5],[CardholderStatus
],[CardholderActiveDate],[CardholderExpireDate]) VALUES 
(NEWID(),$LastName,$FirstName,$MiddleInitial,$CompanyID,$Notes,GetUTCDate(),'alerte
nt',GetUTCDate(),'alertent','1',$UserText1,$UserText2,$UserText3,$UserText4,$UserText5,$
UserText6,$UserText7,$UserText8,$UserText9,$UserText_10,$UserText_11,$UserText_12,$
UserText_13,$UserText_14,$UserText_15,$UserText_16,$UserText_17,$UserText_18,$User
Text_19,$UserText_20,$Department,$UserDate1,$UserDate2,$UserDate3,$UserDate4,$Us
erDate5,$UserNumeric1,$UserNumeric2,$UserNumeric3,$UserNumeric4,$UserNumeric5,'
1',$CardholderActiveDate,$CardholderExpireDate) 

Update CardHolder Query update [dbo].[Cardholders] set LastModified=GetUTCDate() where 
CardholderID=$CardholderID 

 

Lock CardHolder Query update [dbo].[Cardholders] set CardholderStatus='0' where CardholderID=$CardholderID 

 

Unlock Card Holder Query update [dbo].[Cardholders] set CardholderStatus='1' where CardholderID=$CardholderID 
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System Param Name System Param Value 

Check Card Holder Provisioned 
Query 

select CardholderID from [dbo].[Cardholders] where CardholderID =$CardholderID 

 

Assign Roles to Card Holder Query INSERT INTO [dbo].[CardholderAccessLevels] ( [CardholderAccessLevelID],  
[CardholderID], [AccessLevelID],[LastModified],[ActivateDate],[DeactivateDate]) VALUES ( 
NEWID(), $CardholderID,(select AccessLevelID from [dbo].[AccessLevels] where 
AccessLevelName=$ROLE_NAME),GetUTCDate(), NULL, NULL) 

 

Remove Roles From Card Holder 
Query 

delete from [dbo].[CardholderAccessLevels] where CardholderID=$CardholderID and 
AccessLevelID=(select AccessLevelID from [dbo].[AccessLevels] where 
AccessLevelName=$ROLE_NAME) 

 

Retrieve User Id Query select CardholderID from [dbo].[Cardholders] where UserText1=$UserText1 

CREATE_USER1 INSERT INTO [AIUniversal].[dbo].[Cards] 
([CardID],[CardholderID],[CardNumber],[FacilityCode],[PINNumber],[PINExempt],[APBExe
mpt],[UseExtendedAccessTimes],[CardStatus],[ActiveDate],[ExpireDate],[UserLevel],[UseC
ustomReporting],[EventInfo],[Notes],[LastModified],[LastModifiedByUser],[DateCreated],[
CreatedByUser],[IssueLevel],[DeactivateExempt],[VacationDate],[VacationDuration],[UseCo
unt],[TempDeactivateStart],[TempDeactivateEnd],[Classification],[IPLocksetUserType],[IPLo
cksetAccessMode],[IPLocksetCredentialFormat],[IPLocksetAccessAlways],[RawPrimaryCred
ential],[LargeEncodedCardID],[EmbossedNumber])  VALUES (NEWID(),(select CardholderID 
from [dbo].[Cardholders] where 
UserText1=$UserText1),$CardNumber,$FacilityCode,$PIN,'0','0','0','1',NULL,NULL,'0','0',NUL
L,NULL,SYSDATETIME(),'alertent',SYSDATETIME(),'alertent','0','0',NULL,'0','255',NULL,NULL,'
Active',NULL,NULL,NULL,NULL,NULL,NULL,'') 

LOCK_USER1 update [AIUniversal].[dbo].[Cards] set CardStatus='0',Classification='InActive' where 
[CardNumber]=$CardNumber 

 

6. Click on Next. 2785 

7. Attributes…Enter the following: 2786 

● Application – All 2787 

● Check the following boxes – Provisioning, Role Management, and Offline System. 2788 

● Leave Connector Category as Production 2789 

● Time Zone – Eastern Daylight Time from drop-down 2790 

8. Click on Next. 2791 

9. Click on Save. 2792 

Form customization – Attributes 2793 

Create New Custom Form Attributes 2794 
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1. Setup > Manual Configuration > Form customization > Attributes 2795 
2. Click on New Button 2796 
3. Create new attribute called PacsAllDoors based on the information provided below in 2797 

Table 22. 2798 
4. Click Save 2799 

Table 22. PacsAllDoors Attributes 2800 

Field Name Field Value 

Name  PacsAllDoors 

Label  PacsAllDoors 

Description  PacsAllDoors 

Visible  Yes 

Mandatory  No 

Read Only  No 

Field Type  TextField (Select this value from drop down) 

USS Create Request  Yes(Select CheckBox) 

USS User Information Yes(Select CheckBox) 

Approver View  Yes(Select CheckBox) 

Provisioning  Yes(Select CheckBox) 

Create Request 
Sequence 

10 

User Info Sequence  10 

Approver Sequence  10 

Group Name  Personnel Information (Select this value from drop down) 

 2801 
5. Repeat Steps 1-4 to create the following custom form attributes  2802 

1. Create PacsHomeAccess Attributes (See Table 23) 2803 
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Table 23. PacsHomeAccess Attributes 2804 

Field Name Field Value 

Name  PacsHomeAccess 

Label  PacsHomeAccess 

Description  PacsHomeAccess 

Visible  Yes 

Mandatory  No 

Read Only  No 

Field Type  TextField (Select this value from drop down) 

USS Create Request  Yes(Select CheckBox) 

USS User Information Yes(Select CheckBox) 

Approver View Yes(Select CheckBox) 

Provisioning  Yes(Select CheckBox) 

Create Request 
Sequence 

11 

User Info Sequence  11 

Approver Sequence  11 

Group Name  Personnel Information (Select this value from drop down) 

 2805 

2. Create PacsWorkAccess Attributes (as shown in Table 24) 2806 

Table 24. PacsWorkAccess Attributes 2807 

Field Name Field Value 

Name  PacsWorkAccess 

Label  PacsWorkAccess 

Description  PacsWorkAccess 
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Field Name Field Value 

Visible  Yes 

Mandatory  No 

Read Only  No 

Field Type  TextField (Select this value from drop down) 

USS Create Request  Yes(Select CheckBox) 

USS User Information Yes(Select CheckBox) 

Approver View  Yes(Select CheckBox) 

Provisioning  Yes(Select CheckBox) 

Create Request 
Sequence 

12 

User Info Sequence  12 

Approver Sequence  12 

Group Name  Personnel Information (Select this value from drop down) 

 2808 

3. Create FacilityCode Attributes as shown in Table 25. 2809 

Table 25. FacilityCode Attributes 2810 

Field Name Field Value 

Name  FacilityCode 

Label  Facility Code 

Description  Facility Code 

Visible  Yes 

Mandatory  Yes 

Read Only  No 

Field Type  TextField (Select this value from drop down) 
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Field Name Field Value 

USS Create Request  No 

USS User Information No 

Approver View No 

Provisioning  Yes(Select CheckBox) 

Create Request 
Sequence 

 

User Info Sequence  

Approver Sequence  

Group Name  Personnel Information (Select this value from drop 
down) 

 2811 
4. Create PIN Attributes as shown in Table 26. 2812 

Table 26. PIN Atributes 2813 

Field Name Field Value 

Name  PIN 

Label  PIN 

Description  PIN 

Visible  Yes 

Mandatory  No 

Read Only  No 

Field Type  TextField (Select this value from drop down) 

USS Create Request  Yes(Select CheckBox) 

USS User Information  No(Select CheckBox) 

Approver View  No(Select CheckBox) 

Provisioning  Yes(Select CheckBox) 

Create Request 12 
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Field Name Field Value 

Sequence 

User Info Sequence  

Approver Sequence  

Group Name  Personnel Information (Select this value from drop down) 

 2814 

Modify Employee Type Attribute 2815 

1. Setup > Manual Configuration > Form customization > Attributes 2816 
2. Select Employee Type Field from list of Attributes and Click Modify 2817 
3. Click on DropDown Values Icon 2818 
4. On the popup window, Click on New and Provide Employee in both Name and Label 2819 

fields, Figure 137. 2820 

Figure 137. Create DropDownValues 2821 

5. Similarly configure values for Contractor field, Figure 138. 2822 

Figure 138. Contractor Field 2823 

6. Click Save and then Click Save to save the configuration 2824 
7. Ignore this step if these values already exists 2825 

Modify Status Attribute 2826 

1. Setup > Manual Configuration > Form customization > Attributes 2827 
2. Select Status field from list of Attributes and Click Modify 2828 
3. Click on DropDown Values Icon 2829 
4. On the popup window Click on New and provide Active in both Name and Label 2830 

fields, Figure 139. 2831 
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Figure 139. DropDownValues 2832 

 2833 

Figure 140. InActive 2834 

5. Similarly configure values for InActive field, Figure 140 2835 
6. Click Save and then Click Save to save the configuration 2836 
7. Ignore this step if these values already exists for Status field 2837 

Identity & Access– Enable Identity 2838 

1. Setup > Manual Configuration >Identity & Access>Enable Identity 2839 

2. Enable the following for Identity DB system as shown in Figure 141. 2840 

 2841 

Figure 141. Guardian Identity Configuration 2842 

 Identity & Access– User Field Mapping 9.4.42843 

1. Setup > Manual Configuration > Identity & Access > User Field Mapping. 2844 

2. Select User = Identity (from drop-down) and click Go. 2845 

3. Click the Create New button. 2846 

4. Select Custom Field, Primary Key, Visible In List, IsSearchable fields based on the table 2847 
listed below. Select checkbox for these fields if it is specified as “Yes” otherwise, keep it 2848 
as unselected.  2849 

5. Click on Save button to save the record 2850 

6. Repeat Steps 1–5 for all fields in the following table, Table 27. Ignore fields if pre-existing 2851 
mapping already exists for a particular field. 2852 

http://172.16.33.88:9080/AlertEnterprise/?x=DJYF4f1B6N9tKHZ2JT30Sg
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Table 27. User Field Mapping Table 2853 

Custom Field Primary Key Visible In List IsSsearchable 

UserId No Yes No 
ValidFrom No Yes No 
ValidTo No Yes No 
FirstName No Yes Yes 
LastName No Yes Yes 
Email No No No 
Building No No No 
ManagerId No No No 
BadgeStatus No No No 
BadgeType No No No 
BadgeValidFrom No No No 
BadgeValidTo No No No 
Location No No No 
BadgeId No No No 
EmployeeType No No No 
Department No No No 
Password No No No 
Groups No No No 
ManagerName No No No 
ManagerLN No No No 
Manager No No No 
ManagerId No Yes No 
Status No No No 
Telephone No No No 
ImageUpload No No No 
Password_AD No No No 
PacsAllDoors No Yes No 
PacsHomeAccess No Yes No 
PacsWorkAccess No Yes No 

 2854 

Identity & Access > Recon Authoritative Fields 2855 

1. Setup > Manual Configuration > Identity & Access > Recon Authoritative Fields. 2856 

2. Click on New. 2857 



DRAFT 
   

176 | NIST Cybersecurity Practice Guide SP 1800-2c 
 

3. Select ALERTDBCONNECTOR from Systems Drop down and select Authoritative field as 2858 
PacsAllDoors as shown in 2859 

 2860 

Figure 142. Authoritative Fields 2861 

4. Click Save button to save the mapping. 2862 

5. Repeat Steps 1-4 to configure mapping other fields PacsWorksAccess and 2863 
PacsHomeAccess as listed in the screenshot shown in Figure 139. 2864 

 2865 

Figure 143. Guardian Recon Authoritative Fields 2866 

Identity & Access > Request Categories 2867 

1. Setup > Manual Configuration > Identity & Access > Request Categories 2868 

2. Select ChangeAccess Category name and Click Modify 2869 

3. On the Modify screen make following changes 2870 

a. In the Provisioning Actions section Un select Delimit user and Change Validity 2871 
Dates check boxes if they are selected 2872 

b. Go to Add Existing section and select System and Remove Role option for 2873 
Resources/Roles Drop down field 2874 

4. Click Save Button to save the configuration 2875 

Identity & Access>Provisioning>External Provisioning Attributes 2876 

1. Setup > Manual Configuration > Identity & Access > Provisioning > External Provisioning 2877 
Attributes 2878 



DRAFT 
   

177 | NIST Cybersecurity Practice Guide SP 1800-2c 
 

2. Select ACCESSIT PACS system from the list and Click Configure 2879 

3. On the Next screen, Click on New Button and provide “LastName” in both Name and 2880 
description fields  2881 

4. Click Save to save the configurations as shown in Figure 144. 2882 

 2883 

Figure 144. External Provisioning Attribute 2884 

 2885 

Repeat the Steps 1-4 to configure the following fields listed in the following screenshot, 2886 
Figure 145. Note: The Fields Names are case sensitive.  2887 

5.  2888 

 2889 

Figure 145. Attribute Fields 2890 

 2891 
Identity & Access>Provisioning>Provisioning Mapping 2892 

1. Setup > Manual Configuration > Identity & Access > Provisioning > Provisioning Mapping. 2893 

2. Select ACCESSIT PACS and click on Configure.  2894 

3. On the Next Screen, Figure 146, Click New Button and select UserText1 from  2895 
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 2896 

Figure 146. Provisioning Mapping 2897 

4. Click on Save button to save the mapping 2898 

5. Repeat the steps 1-4 to configure other fields as shown in Figure 140. 2899 

 2900 

Figure 147. Guardian DB Connector Attribute Mapping 2901 

Policy Engine> Rules 2902 

1. Setup > Manual Configuration > Policy Engine > Rules 2903 

2. Click New Button 2904 

3. On the Next screen provide following information. See Figure 148. 2905 
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  2906 

Figure 148. Policy Rules 2907 

4. Click Next Button 2908 

5. On the next screen, Figure 149, click New to define a new Rule Condition for NewHire 2909 
request category 2910 

 2911 

Figure 149. Rule Conditions 2912 

 2913 
6. Repeat the step 5 to define rule condition for other request categories Remove User 2914 

Access and ChangeAccess as shown in Figure 150. 2915 
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 2916 

Figure 150. Rule Conditions 2917 

 2918 
7. Repeat Step 1-6 to configure Other Rules Home Access Level New and WO Access Level 2919 

New as shown in following Table 21. 2920 

Table 28. Guardian Manual Configuration Policy Engine Rules 2921 

 2922 

Policy Engine> Suggest/Default Access 2923 

1. Setup > Manual Configuration > Policy Engine > Suggest/Default Access. 2924 

2. Click New and enter the following information to create All Door Access criteria, shown 2925 
in Figure 151 . 2926 

http://172.16.33.88:9080/AlertEnterprise/?x=JKlhwekaD0jFR9hQhkxipQ
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 2927 

Figure 151. Default Access 2928 

3. Click Next Button  2929 

4. On the Next screen, Enter ACCESSIT PACS in System Name Field and hit Search button 2930 

5. The System will appear in Search Results pane. Click Add link under Action column to 2931 
add the system to Selected Systems section 2932 

6. Click Next Button 2933 

7. On the next screen, enter ALL DOORS in Role Name Field and hit Search button 2934 

8. The Role will appear in Search Results pane. Click Add link under Action column to add 2935 
the role to Selected Roles section 2936 

9. Click Save button to save the configuration 2937 

10. Repeat the steps 1-9 to configure other criteria for Home Access Level,  2938 

WO Access Level, NewHireDefaultSystems as listed in Table 29. Manual Configuration 2939 
Policy Engine Suggest/Default Access 2940 

 2941 

Table 29. Manual Configuration Policy Engine Suggest/Default Access 2942 

Name Type Condition Search By 
System 

Selected 
System 

Selected 
Role 

All Door Access Default All Door Access 
NEW 

Yes 

(Select 
check box) 

ACCESSIT 
PACS 

ALL 
DOORS 
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Home Access Level Default Work Access Level 
New 

Yes 

(Select 
check box) 

ACCESSIT 
PACS 

Home 
Access 
Level 

WO Access Level Default Home Access 
Level New 

Yes 

(Select 
check box) 

ACCESSIT 
PACS 

WO 
Access 
Level 

NewHireDefaultSy
stems 

Default NewHireDefaultSy
stems 

Yes 

(Select 
check box) 

ACCESSIT 
PACS 

 

 2943 
11. Select all existing Suggest Default Access criterias other than the one listed in Table 22 2944 

and Click Delete button to delete them. 2945 
Policy Engine>Rule Action Handler 2946 

1. Setup > Manual Configuration > Policy Engine > Rule Action Handler. 2947 

2. In Action Handlers List page select ReconChangeHandler and Click Modify 2948 

3. On the next screen Select Recon Create Request Task Type and Click Update Task 2949 

4. On the popup window Click on Value drop down field and select ChangeAccess from the 2950 
list as shown in Figure 152. 2951 

 2952 

Figure 152. Modify Task 2953 

5. Click on Save Task and then Click Save Button  2954 
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 2955 
Policy Engine>Policy Designer 2956 

1. Setup > Manual Configuration > Policy Engine > Policy Designer 2957 

2. Select New to create new Policy designer as shown in Figure 153. 2958 

Name – User Policy New 2959 

Rule Type – AlertAccess 2960 

Description – User Policy 2961 

 2962 

 2963 

Figure 153. Policy Designer 2964 

3. Click Next 2965 
4. Drag the elements from the tool bar section, available on top of the page and place 2966 

them onto the layout page and connect each node as shown in  2967 
Figure 154. 2968 
 2969 

 2970 

Figure 154. Toolbar 2971 

 2972 
 2973 

 represents Start button 2974 

 represents End Button 2975 

 represents Decision 2976 
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 represents transition 2977 

 represents Task 2978 
 2979 

5. Guide lines to configure the policy  2980 

a. To place an element/node on the layout page, drag it from the toolbar and place 2981 
it. 2982 

b. To connect two nodes, select transition icon from tool bar and then mouse over 2983 
to the first node and connect to the other node in the same direction specified in 2984 
the Figure 23) 2985 

c. To provide text for a Decision or Task or Line, double click on the corresponding 2986 
node and enter the text. Hit Enter after that to come out of the edit mode. 2987 

  2988 
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 2989 

Figure 155. Guardian User Policy 2990 

6. Click on Step 1 decision box and it will open popup window with some fields. See Figure 2991 
156 2992 

7. Enter $masterUser[UserId].size='0' in the Condition text box and hit Enter 2993 

 2994 

Figure 156. Tasks Popup 2995 

8. Similarly, click on other Steps (2 to 7) and configure the data based on Table 30. 2996 

9. For decision nodes provide Condition value and for Task nodes like Create User, 2997 
Terminate User, Change Handler, Error Handler provide IsTaskHandler and Task Handler 2998 
fields 2999 

 3000 
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Table 30. Condition Decision Values 3001 

Step Name Type Condition Is Task 
handler 

Task 
Handler 

Update 
Query 

1 
User ID 
Check Decision $masterUser[UserId].size='0'    

2 
Create 
User 

Task 
Handler  Yes 

Recon New 
Hire  

3 
Terminat
e Check Decision 

$checkStatus[UserStatus,Acti
ve,InActive].action='LOCK'    

4 
Terminat

e 
Task 

Handler  Yes 

Recon 
Terminate 
Handler  

5 

Remove 
Access 
Check Decision 

$checkAuthFields[].status='Ye
s'    

6 
Error 

Handler 
Task 

Handler  Yes 

Recon 
Error 

Handler  

7 
Change 
Handler 

Task 
Handler  Yes 

Recon 
Change 
Handler  

 3002 
Job Scheduler>Triggers Field Map 3003 

1. Setup > Manual Configuration > Job Scheduler > Triggers Field Map. 3004 

2. Click New 3005 

3. Enter Group Name – Alert DbConnector Field Mapping 3006 

4. Description – Alert DbConnector Field Mapping 3007 

5. Select Type – Reconciliation 3008 

6. After creating Field Map, select the newly created map and select Configure 3009 

7. Click New and create mapping per below, Table 31 3010 
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Table 31. Guardian Job Scheduler Triggers Field Map 3011 

 3012 
 3013 
Job Scheduler>Triggers 3014 

1. Setup > Manual Configuration > Job Scheduler > Triggers 3015 

2. Click New and create the following Triggers in Table 32. 3016 
 3017 
AlertDbConnectorTrigger 3018 
 3019 

Table 32. Guardian AlertEnterprise DB Trigger 3020 

Name AlertDbConnectorTrigger 
Description AlertDbConnectorTrigger 
Type Reconciliation 
Batch size 100 
Number of Attempts 3 
Policy Designer for Users/ Roles User policy New 
System: Reconciliation From ALERTDBCONNECTOR 
Reconciliation System ALERTDBCONNECTOR 
Field Mapping Group ALERTDBCONNECTOR Field Mapping 
User Type True 
User Role True 

 3021 
Job Scheduler>Scheduler 3022 

1. Setup > Manual Configuration > Job Scheduler > Scheduler. 3023 
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2. Click New and enter the following, shown in Figure 142. 3024 

3. Click Save. 3025 

● Job Type – Reconciliation Job 3026 

● Job Name - <Job Name> 3027 

● Select Global check box 3028 

● Reconciliation for – User 3029 

●  Reconciliation Type – Incremental Reconciliation 3030 

● Reconciliation Triggers – AlertDbConnectorTrigger 3031 

● Select the schedule as Immediate, Once, periodic or Advance. 3032 

● For a periodic job, specify the job start date, end date, and duration of job 3033 
frequency. 3034 
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 3035 

Figure 157. Guardian Reconciliation Job 3036 

3. Click Save. 3037 

10 PACS SERVER: RS2 ACCESS IT UNIVERSAL SERVER INSTALLATION 3038 

The Access It Universal RS2 Technologies PACS Server is installed on the PACS Network to help 3039 
control physical access to simulated facilities, rooms, etc. RS2 Technologies cards and card 3040 
readers were also included in both builds. The RS2 Technologies PACS Server is installed on a 3041 
VM that is running the Windows Server 2012 R2 OS. 3042 

10.1 SECURITY CHARACTERISTICS 3043 

Cybersecurity Framework Categories: PR.AC-2: Physical access to assets is managed and 3044 
protected  3045 

NIST 800-53 rev 4 Security Controls: PE-2, PE-3, PE-4, PE-5, PE-6, PE-9 3046 
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10.2 SYSTEM ENVIRONMENT 3047 

The system for the PACS-Console Server configured by the NCCoE contains the following 3048 
configuration settings and environmental constraints: 3049 

• Windows Server 2012 R2 3050 
• VM with CPU Quad Core 2.199GHz 3051 
• VM with 8192MB of memory 3052 
• Virtual Hard Disk containing 240 GB of storage. 3053 

10.3 AIUNIVERSAL INSTALLATION 3054 

1. Insert the AIUNIVERSAL CD into the CD-ROM drive. 3055 

2. Launch Setup64.exe as Administrator. 3056 

3. Follow install instructions: 3057 

• Select I do not have a SQL Server installed. 3058 

• When prompted to install SQL Server 2008 R2 Express Edition select Yes. 3059 

• After installation of SQL Server. Select Install Access It! Universal. 3060 

• When prompted to install a Stand-Alone Server version of Access It! select OK. 3061 

• When prompted by the install wizard select Next >. 3062 

• Read the license agreement and select Next > if you agree with the terms of the 3063 
agreement. 3064 

• Use default installation folder C:\Program Files(x86)\RS2 Technologies\Access It! 3065 
Universal\ then select Next >. 3066 

• When the installer is ready select Next > to continue. 3067 

• Select Close to exit the installer after completion. 3068 

10.4 POST INSTALLATION 3069 

1. Launch Access It! by selecting it from the Start menu. 3070 

2. When prompted to select server, enter the host name of server: PACS-CONSOLE. 3071 

3. Log in with the default user name and password. 3072 

 Connect Access It! Universal to Door Controller 10.4.13073 

1. Under the Main > Hardware tab, select Channels. 3074 

2. Create a new Channel. 3075 

3. For Channel Type select IP Server. 3076 

4. Ensure Protocol Type is SCP. 3077 
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5. Select Save. 3078 

6. Create a new SCP. 3079 

7. Under the General tab ensure that Model is set to EP-1501Plus. 3080 

8. Under the Comm tab ensure that Channel is set to Channel 000 (the channel just 3081 
created). 3082 

9. TCP/IP Settings: 3083 

• IP Address: 172.16.7.101 3084 

• Port Number: 3001 3085 

10. Encryption Settings: None. 3086 

11. Under the Card Formats tab: 3087 

• Format Name: 26 Bit Wiegand Facility code: 20 3088 

• Format Name: 26 Bit Wiegand Facility code: 219 3089 

12. Save changes to SCP 000. 3090 

13. Under SIOs 3091 

14. Edit SCP 000 – SIO 00 3092 

15. Under General tab ensure Model is set to EP-1501. 3093 

16. Edit SCP 000 – SIO 01 3094 

17. Under General tab ensure Model is set to MR-52. 3095 

18. Under Main > Hardware select Installed Readers 3096 

19. Create SCP 000 – SIO 00-Reader 1 3097 

20. Create SCP 000 – SIO 01-Card Reader 3098 

21. Create SCP 000 –SIO 01-MRDT Keypad 3099 

22. Under Configuration > Access Levels create New Access Level. 3100 

23. Create new access levels. 3101 

• Access Level Name: All Doors. 3102 

• Assigned Readers for All Doors: SCP 000 – SIO 01-Card Reader and SCP 000 – SIO 3103 
01-MRDT Keypad. 3104 

• Access Level Name: Home Access Level. 3105 

• Assigned Reader for Home Access Level: SCP 000 – SIO 01-MRDT Keypad. 3106 

• Access Level Name: Work Order Access Level. 3107 

• Assigned Reader for Work Order Access Level: SCP 000 – SIO-Card Reader 3108 
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 Enable TCP/IP to SQL 2008 R2 Server 10.4.23109 

1. Launch Microsoft SQL Server Configuration Manager. 3110 

2. Expand SQL Server Network Configuration (32-bit). 3111 

3. Select Protocols for AIUNIVERSAL. 3112 

4. Right-click on TCP/IP and then select Properties. 3113 

5. Select tab IP Addresses. 3114 

6. Under IP1 ensure IP Address is set to 0.0.0.0 and TCP Port is set to 1433. 3115 

7. Under IPALL ensure TCP Dynamic Ports is set to 52839 and TCP Port is set to 1433. 3116 

8. Restart the SQL server by selecting SQL Server Services then right click on SQL Server 3117 
(AIUNIVERSAL) and select Restart. 3118 

11 PRIVILEGED USER ACCESS CONTROL:  TDI CONSLEWORKS SERVER INSTALLATION 3119 

The TDi ConsoleWorks server was installed in two different locations in the builds. It was 3120 
installed on the OT network to control and monitor access between OT technicians and physical 3121 
devices such as the RTUs and the RADiFlow ICS firewall. The following two sections provide 3122 
details on the steps needed to install and configure each of these servers.  3123 

11.1 SECURITY CHARACTERISTICS 3124 

Cybersecurity Framework Categories:  3125 

• PR.PT-1: Audit/log records are determined, documented, implemented, and reviewed in 3126 
accordance with policy  3127 

• PR.PT-3: Access to systems and assets is controlled, incorporating the principle of least 3128 
functionality  3129 

NIST 800-53 rev 4 Security Controls: AU Family, AC-3, CM-7 3130 

11.2 CONSOLEWORKS SERVER INSTALLATION 3131 

ConsoleWorks was installed on the OT network to control and monitor access between OT 3132 
technicians and physical devices such as the RTUs and the RADiFlow ICS firewall. ConsoleWorks 3133 
uses the OT directory to authenticate users requesting access to these devices. It also 3134 
establishes a permanent SSH or telnet connection to each of the RTUs and ICS firewall using 3135 
pre-established usernames and passwords. As users request access and are authenticated 3136 
ConsoleWorks makes the cross-connection from the user to the specific SSH or telnet session to 3137 
allow access. Once the cross-connection is established the user has access to the device to 3138 
make any changes needed. When the user completes their task they log-off of the connection 3139 
and ConsoleWorks removes the cross-connect between the user and the SSh or telnet session. 3140 



DRAFT 
   

193 | NIST Cybersecurity Practice Guide SP 1800-2c 
 

ConsoleWorks logs all user access requests, all of the traffic on the session, and can alert on any 3141 
pre-defined aspect of the traffic. Directory based authentication is used to manage the user 3142 
access in near real time. 3143 

On the OT network, the ConsoleWorks Server is installed on a VM that is running the Windows 3144 
Server 2012 R2 (hardened server OS) image, as explained in Section 1.  3145 

 System Environment 11.2.13146 
The system for the OT Network ConsoleWorks Server configured by the NCCoE contains the 3147 
following configuration settings and environmental constraints: 3148 

• Windows Server 2012 R2 OS 3149 
• VM with CPU Quad Core 2.199GHz 3150 
• VM with 8192MB of memory 3151 
• Virtual Hard Disk containing 240 GB of storage. 3152 

 ConsoleWorks Server Installation on the OT Network 11.2.23153 

1. After installing the OS, download the TDi Technologies Installer from 3154 
http://support.tditechnologies.com/get_consoleworks. 3155 

2. Launch the cw_server_v4.9-0u0.exe application. The installer requires administrative 3156 
privileges to execute. 3157 

3. When prompted by Windows User Account Control, select Yes to continue. 3158 

4. The ConsoleWorks Server InstallShield Wizard should display a welcome message. Select 3159 
Next > to continue. 3160 

5. When prompted by the InstallShield Wizard to accept the license agreement, read 3161 
carefully. If you agree with the license terms, select Next > to continue with the 3162 
installation. 3163 

6. Enter the User Name and Organization fields, then select Next > to continue. 3164 

7. Select Complete when prompted for setup type, then select Next > to continue. 3165 

8. Click Install to begin installation of ConsoleWorks Server. 3166 

9. After the InstallShield Wizard has completed, ensure that Launch upgrade script (if 3167 
upgrading from 32 bit) is unchecked. 3168 

10. Select Finish. 3169 

 Post-installation Configuration of ConsoleWorks on the OT Network 11.2.33170 

1. Copy TDi Technologies license key files into 3171 
C:\ProgramData\ConsoleWorks/Server\LMF\TDI_Licenses 3172 

2. Go to Start > Run > services.msc.  3173 

3. Right-click on the ConsoleWorks Server Service, then select Properties.  3174 

http://support.tditechnologies.com/get_consoleworks
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4. Select Start to start the service. Then change the Startup Type from Manual to 3175 
Automatic.  3176 

5. Select Apply to save changes. Both the ConsoleWorks Server and ConsoleWorks LMF 3177 
Server services should be running.  3178 

6. Test browser connectivity by going to http://localhost:5176. The default account is 3179 
CONSOLE_MANAGER. The default password is: Setup 3180 

 Configuring External Authentication for the OT Network ConsoleWorks Server 11.2.43181 

1. From the left menu, select the SECURITY tab. 3182 

2. Select External Authentication. 3183 

3. Ensure the Enable External Authentication checkbox has been selected. 3184 

4. Select Add. 3185 

• Parameter 1: OT-ES-IDAM-B1  3186 

• Parameter 2: CW_ 3187 

• Required Profile: CONSOLE_WORKS 3188 

• Template User: CONSOLE_MANAGER 3189 

• Leave all other fields blank. 3190 

5. Then select Next.  3191 
6. Enter a Username and Password to test External Authentication settings. 3192 

7. Then select Next. 3193 

8. Then select Save. 3194 

12 ICS/SCADA FIREWALL: RADIFLOW 3195 

A RADiFlow switch is installed on the physical network that represents the industrial control 3196 
system component that can be accessed and controlled via the OT network. A RADiFlow 3197 
management workstation is installed on the OT network. The RADiFlow Management 3198 
Workstation is installed on a VM that is running the Windows 7 Enterprise OS. 3199 

12.1 SECURITY CHARACTERISTICS 3200 

Cybersecurity Framework Categories: PR.PT-3: Access to systems and assets is controlled, 3201 
incorporating the principle of least functionality 3202 

NIST 800-53 rev 4 Security Controls: AC-3, CM-7 3203 
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12.2 OT Network RADiFlow Management Workstation INSTALLATION 3204 

 Installing iSIM 12.2.13205 

1. Launch the iSIM installer as an administrator 3206 

2. Set the Destination Directory to C:\Program Files (x86). 3207 

3. Leave default settings for all other options 3208 

 iEMS 12.2.23209 

1. Launch iEMS from the Start menu. 3210 

2. From the menu items, select System > Switch Initialization > Force Switch Model > 3180. 3211 

3. In the main windows dialog box, enter the switches IP address 172.16.6.4 and then 3212 
select Refresh. 3213 

4. From the menu items, select Configuration > Interfaces > Serial Ports… 3214 

5. Select the Terminal Server tab and ensure Service 1 and Service 2 dialog boxes are 3215 
checked. 3216 

6. Under Service 1, enter these settings: 3217 

• Service ID: 1 3218 

• Local IP Address: 172.16.6.100 3219 

• Telnet Port: 2050 3220 

• Null CR Bit Mode: OFF 3221 

7. Under Service 2, enter these settings: 3222 

• Service ID: 2 3223 

• Local IP Address: 172.16.6.100 3224 

• Telnet Port: 2051 3225 

• Null CR Bit Mode: OFF 3226 
8. Then Select Create/Update. 3227 

9. Select the Serial Ports tab ensure Port-1 and Port-2 dialog boxes are checked. 3228 

10. Under Port 1 enter these settings: 3229 

• Application: Terminal Server 3230 
• Local Position: Slave 3231 
• Service-id: 1 3232 
• Operation Mode: Transparent 3233 
• Buffer Mode: byte 3234 
• Protocol: any 3235 
• Baudrate: 9600 3236 
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• Databits: 8 3237 
• Stopbits: 1 3238 
• Parity: no 3239 
• Allowed-latency: 6 3240 
• Bus-idle-time: 30 3241 
• Dtr-dsr: enable 3242 
• Rts-cts: enable 3243 
• Local-dsr-delay: 0 3244 
• Local-cts-delay: 0 3245 
• Tx-delay: 10 3246 
• Bits-for-sync1: 28 3247 
• Bits-for-sync2: 1 3248 
• Unit-id length: 2 3249 
• Iec101-link-address-len: 2 3250 

11. Under Port 2 enter these settings: 3251 

• Application: Terminal Server 3252 
• Local Position: Slave 3253 
• Service-id: 2 3254 
• Operation Mode: Transparent 3255 
• Buffer Mode: byte 3256 
• Protocol: any 3257 
• Baudrate: 9600 3258 
• Databits: 8 3259 
• Stopbits: 2 3260 
• Parity: no 3261 

• Allowed-latency: 6 3262 
• Bus-idle-time: 30 3263 
• Dtr-dsr: enable 3264 
• Rts-cts: enable 3265 
• Local-dsr-delay: 0 3266 
• Local-cts-delay: 0 3267 
• Tx-delay: 10 3268 
• Bits-for-sync1: 28 3269 
• Bits-for-sync2: 1 3270 
• Unit-id length: 2 3271 
• Iec101-link-address-len: 2 3272 

12. Then Select Create/Update. 3273 

13 OZONE: MAG INSTALLATION 3274 

Four Ozone components are installed on the IdAM network: Console, Authority, Server, and 3275 
Envoy. These components are installed on VMs running the CentOS 7 image. 3276 
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13.1 SECURITY CHARACTERISTICS 3277 

Cybersecurity Framework Categories: PR.AC-4: Access permissions are managed, incorporating 3278 
the principles of least privilege and separation of duties  3279 

NIST 800-53 rev 4 Security Controls: AC-2, AC-3, AC-5, AC-6, AC-16 3280 

13.2 OZONE CONSOLE INSTALLATION AND AUTHORITY CONFIGURATION 3281 

1. Install CA Certificate into trusted root store (MAG_DEV_CA.crt). 3282 

2. Install Ozone Authority Certificate into Trusted People store (ozoneauthority.crt). 3283 

3. Install Administrator keys into Personal store (admin1.crt and admin2.crt). 3284 

4. Run Setup Ozone Console.exe 3285 

• Run Ozone Console. 3286 

• Go to Configuration>Ozone Authority>New…see Figure 158. 3287 

• In the Proof Settings tab: 3288 

o Select SHA256 for the Entity Digest Algorithm. 3289 

o Select SHA256withRSA for the Proof Signature Algorithm. 3290 

 3291 

Figure 158. Ozone Proof Settings 3292 

5. In the Authority Web Service tab, Figure 159. 3293 
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• Set the HTTPS Port to 443. 3294 

• Select SHA1withRSA for the Message Signature Algorithm. 3295 

 3296 

Figure 159. Ozone Authority Web Service 3297 

• Click Save. 3298 

6. Select a certificate to be used to digitally sign the configuration (Admin 1). 3299 

7. Save the file as AuthorityConfiguration.xml. 3300 

8. SCP the file to Ozone Authority machine. 3301 

13.3 OZONE AUTHORITY INSTALLATION 3302 

Create keys and certificates and store in Java Keystore (JKS) 3303 
 3304 
Install java 3305 
[root@ozone ~]# yum install java 3306 
 3307 
Install mariaDB 3308 
[root@ozone ~]# yum install mariadb-server 3309 
[root@ozone ~]# reboot 3310 
[root@ozone ~]# systemctl start mariadb 3311 
[root@ozone ~]# systemctl enable mariadb 3312 
 3313 
Secure the mysql installation 3314 
[root@ozone ~]# mysql_secure_installation 3315 
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 3316 
Create the Ozone Authority database and user 3317 
[root@ozone ~]# mysql -u root –p 3318 
 3319 
MariaDB> create database ozone; 3320 
Query OK, 1 row affected (0.02 sec) 3321 
 3322 
MariaDB> create user 'ozone'@'localhost' identified by 'password'; 3323 
Query OK, 0 rows affected (0.00 sec) 3324 
 3325 
MariaDB> grant all privileges on ozone.* to 'ozone'@'localhost'; 3326 
Query OK, 0 rows affected (0.00 sec) 3327 
 3328 
MariaDB> flush privileges; 3329 
Query OK, 0 rows affected (0.00 sec) 3330 
 3331 
Install the Ozone Authority  3332 
[root@ozone local]# cd /usr/local/ 3333 
[root@ozone local]# tar -xzf ~/Ozone\ Authority-2014.tar.gz  3334 
 3335 
Copy AuthorityConfiguration.xml to conf directory 3336 
[root@ozone local]# mv ~/AuthorityConfiguration.xml authority/conf/ 3337 
 3338 
Copy AuthorityLicense.xml to conf directory 3339 
[root@ozone local]# mv ~/AuthorityLicense.xml authority/conf/ 3340 
 3341 
Copy JKS to keystores directory 3342 
[root@ozone local]# mv ~/authority.jks authority/keystores/ 3343 
 3344 
Copy administrator certificates to bin directory 3345 
[root@ozone local]# mv ~/admin1.cer authority/bin/ 3346 
[root@ozone local]# mv ~/admin2.cer authority/bin/ 3347 
 3348 
Run the Ozone Authority script 3349 
[root@ozone local]# cd authority/bin/ 3350 
[root@ozone bin]# ./startAuthority.sh  3351 
Configuration file not found, would you like to create a new 3352 
installation? [Y] Y  3353 
 3354 
***WARNING*** 3355 
This product MUST be installed by an Ozone Certified 3356 
Engineer. Pericore, Inc. cannot be held liable for damages resulting 3357 
from negligent or fraudulent actions of unauthorized or unqualified 3358 
administrators. Please review all documentation thoroughly before 3359 
continuing. Continuation of this configuration process represents an 3360 
agreement to abide by the Pericore EULA. 3361 
Do you wish to continue? [N] : y 3362 
 3363 
Please select the license file for this Ozone Authority.: 3364 
1: /usr/local/authority/conf/AuthorityLicense.xml 3365 
2: Other... 3366 
Choice [1] : 1 3367 
 3368 
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Please select the configuration file for this Ozone Authority.: 3369 
1: /usr/local/authority/conf/AuthorityConfiguration.xml 3370 
2: Other... 3371 
Choice [1] : 1  3372 
 3373 
Do you wish to set any passphrase complexity requirements? [N] : N 3374 
 3375 
Note: If you require passphrase at start, you will not be able to 3376 
restart this Ozone Authority without user intervention. 3377 
Do you wish to require a passphrase to start this Ozone Authority? [N] N  3378 
 3379 
Using keystore type: RSA 3380 
 3381 
Do you have an existing keystore you wish to use for this Ozone Authority? 3382 
[Y] : Y 3383 
 3384 
Please select the keystore file for this Ozone Authority:: 3385 
1: /usr/local/authority/keystores/authority.jks 3386 
2: Other... 3387 
Choice [1] : 1 3388 
Please enter the passphrase. : 123456 3389 
May 15, 2015 1:24:22 PM com.pericore.util.PericoreProvider jsafeJCEinit 3390 
POST: [FIPS] FIPS-140 compliance self-test passed. 3391 
 3392 
What type of database do you wish to use?: 3393 
1: SQLSERVER 3394 
2: ORACLE 3395 
3: MYSQL 3396 
Choice [1] : 3 3397 
Please enter the hostname or IP address of the database server: [ozone] : 3398 
localhost 3399 
Please enter the port number for the database: [3306] 3306  3400 
Please enter the username for the database: [] : ozone 3401 
Please enter the database password: password 3402 
Using only available database: ozone 3403 
 3404 
How many initial administrators would you like to create? [2] : 2 3405 
Page 1 | Current Directory:  3406 
[00] ../  3407 
[01] lib/  3408 
[02] admin1.cer  3409 
[03] admin2.cer  3410 
  3411 
 3412 
Please select the file containing the administrators certificate: [ # ] : 2 3413 
3Page 1 | Current Directory:  3414 
[00] ../  3415 
[01] lib/  3416 
[02] admin1.cer  3417 
[03] admin2.cer  3418 
  3419 
Please select the file containing the administrators certificate: [ # ] : 1 3420 
Please enter distinguished name(DN) of the starting Organizational 3421 
Unit (OU) for this proof tree: [OU=Ozone] : ou=Ozone, dc=NCCOE, dc=test 3422 
Is: ou=Ozone, dc=NCCOE, dc=test correct? [Y] : Y 3423 
Please enter the minimum number of administrators required to approve 3424 
changes to the initial proofs: [1] : 1 3425 



DRAFT 
   

201 | NIST Cybersecurity Practice Guide SP 1800-2c 
 

Please enter a name for the initial publication schedule: [Primary Schedule] 3426 
: Daily 3427 
Please enter the publication interval: [12] : 12 3428 
Please select the time unit:: 3429 
1: Minute 3430 
2: Hour 3431 
3: Day 3432 
Choice [1] : 2 3433 
Please enter the validity period after publication: [12] : 12 3434 
Please select the validity period time unit:: 3435 
1: Minute 3436 
2: Hour 3437 
3: Day 3438 
Choice [1] : 2 3439 
 3440 
Please enter a name for the initial distribution point for proofs. [File 3441 
Distribution Point] : LDAP Distribution Point 3442 
 3443 
Please enter the initial distribution point for proofs. This may be changed 3444 
later. [file:///usr/local/authority/proofs/] : ldap://ozoneauthority/ 3445 
Configuration File: /usr/local/authority/conf/AuthorityConfiguration.xml 3446 
May 15, 2015 1:25:16 PM 3447 
com.pericore.util.ObjectIdentifierFactory$OIDDataLoader debug 3448 
INFO: ObjectIdentifierFactory Read 240.165 kb in 2.511 ms; Indexed 2,415 Arcs 3449 
in 51.731 ms; 2,310(1,054:5) keys => 2.003 kb 3450 
Created proof ou=Master Authorization Group, ou=Ozone, dc=NCCOE, dc=test in 3451 
the database. 3452 
Created proof ou=Applications, ou=Master Authorization Group, ou=Ozone, 3453 
dc=NCCOE, dc=test in the database. 3454 
Created proof ou=Groups, ou=Master Authorization Group, ou=Ozone, dc=NCCOE, 3455 
dc=test in the database. 3456 
Created proof ou=Attribute Types, ou=Master Authorization Group, ou=Ozone, 3457 
dc=NCCOE, dc=test in the database. 3458 
 3459 
Allowing a user certificate to be associated with a directory GUID 3460 
allows for a migration path from username and password to a PKI based 3461 
authentication and authorization mechanism. However, this method 3462 
lowers the initial security settings by relying on a directory for the 3463 
association. Please be sure you understand the risks associated with 3464 
this method before allowing this mechanism to be used. 3465 
Would you like to allow users certificates to be associated with a directory 3466 
GUID? [N] : N 3467 
Do you wish to display a logon message? [N] : N 3468 
 3469 
Ozone Authority 3470 
Version: 2014 - 4.0.1 (Build: 475) 3471 
Copyright Pericore, Inc. 2014 3472 
----------------------------------- 3473 
Started at: May 15, 2015 1:24:13 PM EDT 3474 
Licensed to: NCCOE 3475 
----------------------------------- 3476 
 3477 
Built: ou=Master Authorization Group, ou=Ozone, dc=NCCOE, dc=test in 3478 
0:00:00.304. 3479 
Built: ou=Applications, ou=Master Authorization Group, ou=Ozone, dc=NCCOE, 3480 
dc=test in 0:00:00.243. 3481 
Built: ou=Groups, ou=Master Authorization Group, ou=Ozone, dc=NCCOE, dc=test 3482 
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in 0:00:00.215. 3483 
Built: ou=Attribute Types, ou=Master Authorization Group, ou=Ozone, dc=NCCOE, 3484 
dc=test in 0:00:00.214. 3485 
Push Certificates loaded with: 0 certificates 3486 
 3487 
Started HTTPS Listener on port: 443 3488 
Ozone Authority> 3489 
 3490 
 3491 
Install LDAP (389) directory server 3492 
[root@ozone ~]# yum install 389-ds-base 3493 
[root@ozone ~]# vi /etc/hosts 3494 
Modify the first line of hosts file so that it is the same as below: 3495 
127.0.0.1  ozoneauthority.nccoe.test localhost localhost.localdomain 3496 
localhost4 localhost4.localdomain4 3497 
 3498 
Configure the directory server 3499 
[root@ozone ~]# setup-ds.pl  3500 
 3501 
=============================================================================3502 
= 3503 
This program will set up the 389 Directory Server. 3504 
 3505 
It is recommended that you have "root" privilege to set up the software. 3506 
Tips for using this program: 3507 
 - Press "Enter" to choose the default and go to the next screen 3508 
 - Type "Control-B" or the word "back" then "Enter" to go back to the 3509 
previous screen 3510 
 - Type "Control-C" to cancel the setup program 3511 
 3512 
Would you like to continue with set up? [yes]: yes 3513 
 3514 
=============================================================================3515 
= 3516 
Your system has been scanned for potential problems, missing patches, 3517 
etc. The following output is a report of the items found that need to 3518 
be addressed before running this software in a production 3519 
environment. 3520 
 3521 
389 Directory Server system tuning analysis version 23-FEBRUARY-2012. 3522 
 3523 
NOTICE : System is x86_64-unknown-linux3.8.13-68.2.2.el7uek.x86_64 (1 3524 
processor). 3525 
 3526 
NOTICE : The net.ipv4.tcp_keepalive_time is set to 7200000 milliseconds 3527 
(120 minutes). This may cause temporary server congestion from lost 3528 
client connections. 3529 
 3530 
WARNING: There are only 1024 file descriptors (soft limit) available, which 3531 
limit the number of simultaneous connections.  3532 
 3533 
WARNING : The warning messages above should be reviewed before proceeding. 3534 
 3535 
Would you like to continue? [no]: yes 3536 
 3537 
=============================================================================3538 
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= 3539 
Choose a setup type: 3540 
 3541 
 1. Express 3542 
 Allows you to quickly set up the servers using the most 3543 
 common options and pre-defined defaults. Useful for quick 3544 
 evaluation of the products. 3545 
 3546 
 2. Typical 3547 
 Allows you to specify common defaults and options. 3548 
 3549 
 3. Custom 3550 
 Allows you to specify more advanced options. This is  3551 
 recommended for experienced server administrators only. 3552 
 3553 
To accept the default shown in brackets, press the Enter key. 3554 
 3555 
Choose a setup type [2]: 2 3556 
 3557 
=============================================================================3558 
= 3559 
Enter the fully qualified domain name of the computer 3560 
on which you're setting up server software. Using the form 3561 
<hostname>.<domainname> 3562 
Example: eros.example.com. 3563 
 3564 
To accept the default shown in brackets, press the Enter key. 3565 
 3566 
Warning: This step may take a few minutes if your DNS servers 3567 
cannot be reached or if DNS is not configured correctly. If 3568 
you would rather not wait, hit Ctrl-C and run this program again 3569 
with the following command line option to specify the hostname: 3570 
 3571 
 General.FullMachineName=your.hostname.domain.name 3572 
 3573 
Computer name [ozone.mountaireygroup.com]: ozoneauthority.nccoe.test 3574 
 3575 
=============================================================================3576 
= 3577 
The server must run as a specific user in a specific group. 3578 
It is strongly recommended that this user should have no privileges 3579 
on the computer (i.e. a non-root user). The setup procedure 3580 
will give this user/group some permissions in specific paths/files 3581 
to perform server-specific operations. 3582 
 3583 
If you have not yet created a user and group for the server, 3584 
create this user and group using your native operating 3585 
system utilities. 3586 
 3587 
System User [nobody]: nobody 3588 
System Group [nobody]: nobody 3589 
 3590 
=============================================================================3591 
= 3592 
The standard directory server network port number is 389. However, if 3593 
you are not logged as the superuser, or port 389 is in use, the 3594 
default value will be a random unused port number greater than 1024. 3595 
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If you want to use port 389, make sure that you are logged in as the 3596 
superuser, that port 389 is not in use. 3597 
 3598 
Directory server network port [389]: 389 3599 
 3600 
=============================================================================3601 
= 3602 
Each instance of a directory server requires a unique identifier. 3603 
This identifier is used to name the various 3604 
instance specific files and directories in the file system, 3605 
as well as for other uses as a server instance identifier. 3606 
 3607 
Directory server identifier [ozoneauthority]: ozoneauthority 3608 
 3609 
=============================================================================3610 
= 3611 
The suffix is the root of your directory tree. The suffix must be a valid DN. 3612 
It is recommended that you use the dc=domaincomponent suffix convention. 3613 
For example, if your domain is example.com, 3614 
you should use dc=example,dc=com for your suffix. 3615 
Setup will create this initial suffix for you, 3616 
but you may have more than one suffix. 3617 
Use the directory server utilities to create additional suffixes. 3618 
 3619 
Suffix [dc=nccoe, dc=test]: dc=nccoe, dc=test 3620 
 3621 
=============================================================================3622 
= 3623 
Certain directory server operations require an administrative user. 3624 
This user is referred to as the Directory Manager and typically has a 3625 
bind Distinguished Name (DN) of cn=Directory Manager. 3626 
You will also be prompted for the password for this user. The password must 3627 
be at least 8 characters long, and contain no spaces. 3628 
Press Control-B or type the word "back", then Enter to back up and start 3629 
over. 3630 
 3631 
Directory Manager DN [cn=Directory Manager]: cn=Directory Manager 3632 
Password: password 3633 
Password (confirm): password 3634 
Your new DS instance 'ozoneauthority' was successfully created. 3635 
Exiting . . . 3636 
Log file is '/tmp/setup_C4mdK.log' 3637 
 3638 
Setup the directory structure 3639 
Modify the file /usr/local/authority/bin/389SetupDirectory.ldif 3640 
Set the correct DN structure and passwords for the ozone authority user and tree 3641 
[root@ozone bin]# vi 389SetupDirectory.ldif 3642 
[root@ozone bin]# cat 389SetupDirectory.ldif 3643 
 3644 
#Create the User for Ozone Authority 3645 
dn: uid=ozone, ou=Special Users, dc=nccoe, dc=test 3646 
changetype: add 3647 
objectClass: inetorgperson 3648 
objectClass: organizationalPerson 3649 
objectClass: person 3650 
objectClass: top 3651 
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cn: Ozone Authority 3652 
sn: Authority 3653 
givenName: Ozone 3654 
uid: ozone 3655 
userPassword: P@$$word 3656 
 3657 
#make the people writable by ozone 3658 
dn: ou=People, dc=nccoe, dc=test 3659 
changetype: modify 3660 
add: aci 3661 
aci: (targetattr="*")(version 3.0;acl "ozone authority";allow (all)(userdn = 3662 
"ldap:///uid=ozone, ou=Special Users, dc=nccoe, dc=test");) 3663 
 3664 
 3665 
#Create the Ozone OU 3666 
dn: ou=Ozone, dc=nccoe, dc=test 3667 
changetype: add 3668 
objectClass: organizationalUnit 3669 
objectClass: top 3670 
ou: Ozone 3671 
aci: (targetattr="*")(version 3.0;acl "ozone authority";allow (all)(userdn = 3672 
"ldap:///uid=ozone, ou=Special Users, dc=nccoe, dc=test");) 3673 
 3674 
#Create required Attributes and Object Classes 3675 
dn: cn=schema 3676 
changeType: modify 3677 
add: attributetypes 3678 
attributetypes: ( 1.3.6.1.4.1.26135.1.1.1.2 NAME 'authorizationProof' DESC 3679 
'Ozone Authorization Proof' SYNTAX 1.3.6.1.4.1.1466.115.121.1.40 SINGLE-VALUE 3680 
X-ORIGIN 'user defined' ) 3681 
attributetypes: ( 2.23.136.1.1.2 NAME 'cscaMasterList' DESC 'CSCA Master 3682 
List' SYNTAX 1.3.6.1.4.1.1466.115.121.1.40 SINGLE-VALUE X-ORIGIN 'user 3683 
defined' ) 3684 
 3685 
dn: cn=schema 3686 
changeType: modify 3687 
add: objectclasses 3688 
objectclasses: ( 1.3.6.1.4.1.26135.1.1.3 NAME 'ozoneAuthority' DESC '' SUP 3689 
top STRUCTURAL MAY (authorizationProof $ cscaMasterList) X-ORIGIN 'user 3690 
defined' ) 3691 
 3692 
Modify the directory using the LDIF 3693 
[root@ozone bin]# ldapmodify -x -D "cn=Directory Manager" -W -f 3694 
/usr/local/authority/bin/389SetupDirectory.ldif 3695 
Enter LDAP Password:  3696 
adding new entry "uid=ozone, ou=Special Users, dc=nccoe, dc=test" 3697 
 3698 
modifying entry "ou=People, dc=nccoe, dc=test" 3699 
 3700 
adding new entry "ou=Ozone, dc=nccoe, dc=test" 3701 
 3702 
modifying entry "cn=schema" 3703 
 3704 
modifying entry "cn=schema" 3705 
 3706 
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13.4 OZONE CONSOLE SERVER CONFIGURATION 3707 

Before proceeding ensure that OzoneAuthority has been started by running startauthority.sh on 3708 
the OzoneAuthority machine. 3709 

1. Open Ozone Console. 3710 

2. Go to File>Properties, Figure 160, below. 3711 

3. Enter the Ozone Authority URL. 3712 

4. Click Select Certificate and select the Ozone Authority Certificate. 3713 

5. Select SHA1withRSA as the Message Signature Algorithm. 3714 

6. Click Save to the connection information. 3715 

 3716 

Figure 160. Ozone Authority Connection Information 3717 

Create the publication point for the proofs 3718 

1. Select Publication > Add Publication Point > Add LDAP Publication Point, Figure 161 3719 

2. Enter a name for the publication point. 3720 

3. Enter the hostname or IP address of the directory server.  3721 

4. Enter a base context, if any. 3722 

5. Select the port. 3723 

6. Enter the name of the user who has permissions to write to the directory. 3724 

7. Enter the password for the user. 3725 

8. Confirm the password. 3726 
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 3727 

Figure 161. Ozone LDAP Publication Point 3728 

Import the desired groups from the RSA Adaptive directory 3729 

1. Right-click on the Groups proof. 3730 

2. Select Import Group from Active Directory, Figure 162. 3731 

3. Enter the directory connection information. 3732 

 3733 

Figure 162. Ozone Directory Connection Information 3734 

4. Select a group to import, see Figure 163. 3735 

5. Check the box to Import New Entities. 3736 
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6. Check the box to Import Associated Groups. 3737 

7. Then select Import 3738 

 3739 

Figure 163. Ozone Import Group from Directory 3740 

8. Select the publication schedule as shown in Figure 164. 3741 

9. Select the publication point as shown in Figure 164. 3742 

10. Select the distribution point as shown in Figure 164. 3743 
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 3744 

Figure 164. Ozone New Proof Information 3745 

11. Click the Administrators tab as shown in Figure 165 3746 

12. Click the Add Administrators button. 3747 

13. Select the users who will administer the proof. 3748 

14. Then select Add Entities 3749 
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 3750 

Figure 165. Ozone New Proof Administrators 3751 

15. Click the Save button. 3752 

 3753 
Create the Ozone Server Configuration 3754 

1. Select Configuration > Ozone Server > New… 3755 

2. Click the Add proof from tree… button. 3756 

3. Select a proof Ozone Server should use for authorizations as shown in Figure 166. 3757 
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 3758 

Figure 166. Ozone Peer Proofs 3759 

4. Set the number of proof references (Depth) the proof may follow in order to authorize a 3760 
credential as shown in Figure 167. 3761 

5. Ensure that the locations where the Ozone Server will retrieve the proof are correct. 3762 



DRAFT 
   

212 | NIST Cybersecurity Practice Guide SP 1800-2c 
 

 3763 

Figure 167. Ozone Add Authorization Proof 3764 

6. Click the Save button. 3765 

7. Repeat Steps 2–6 until you have selected all of the proofs Ozone Server should initially 3766 
retrieve for Authorizations. 3767 
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 3768 

Figure 168. Ozone Server Configuration 3769 

8. Click the Save configuration button as shown in Figure 168. 3770 

9. Select a certificate to be used to digitally sign the configuration. 3771 

10. Save the file as ServerConfiguation.xml. 3772 

11. SCP the file to the Ozone Server machine. 3773 

13.5 OZONE SERVER INSTALLATION 3774 

Create keys and certificates and store in Java Keystore (JKS) 3775 
 3776 
Install java 3777 
[root@ozone ~]# yum install java 3778 
 3779 
Install Ozone Server 3780 
[root@ozoneserver ~]# cd /usr/local/ 3781 
[root@ozoneserver local]# tar -xzf ~/Ozone\ Server-2014.tar.gz 3782 
 3783 
Copy the keystore to the conf directory 3784 
[root@ozoneserver local]# mkdir /usr/local/server/bin/conf/ 3785 
[root@ozoneserver local]# cp ~/server.jks server/bin/conf/ 3786 
 3787 
Copy the configuration and license files to the conf directory 3788 
[root@ozoneserver local]# cp ~/ServerConfiguration.xml server/bin/conf/ 3789 
[root@ozoneserver local]# cp ~/ServerLicense.xml server/bin/conf/ 3790 
 3791 
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Run the Ozone Server 3792 
[root@ozoneserver bin]# ./startServer.sh  3793 
POST [MAIN] v2.1.301 3794 
 3795 
 _______ __________ _______ __ _ ________   3796 
 / ___ \ _____ // ___ \ | \ | | ______| (R)  3797 
 | / \ | / /| / \ || \ \ | | |  3798 
 | | | | / / | | | || |\ \ | | |____  3799 
 | | | | / / | | | || | \ \ | | ____| 3800 
 | | | | / / | | | || | \ \| | | 3801 
 \ \___/ // /___ \ \___/ /| | \ \ | |______ 3802 
 \_______//________ \_______/ |_| \__|________| 3803 
 _____   3804 
 / ____|   3805 
 | (___ ___ _ ____ _____ _ __  3806 
 \___ \ / _ \ '__\ \ / / _ \ '__|  3807 
 ____) | __/ | \ V / __/ |  3808 
 |_____/ \___|_| \_/ \___|_|  3809 
 3810 
 3811 
   3812 
Ozone(R) Server copyright (c) Pericore, Inc. 2007-2011 3813 
------------------------------------------------------ 3814 
 Fri May 15 14:31:33 EDT 2015 3815 
 3816 
 3817 
May 15, 2015 2:31:35 PM com.pericore.util.PericoreProvider jsafeJCEinit 3818 
POST: [FIPS] FIPS-140 compliance self-test passed. 3819 
Found Java version: 1.8.0_31 3820 
Working in: /usr/local/server/bin 3821 
/usr/local/server/bin/conf/server.cfg not found. Run setup [Y] : Y 3822 
env.work/usr/local/server/bin 3823 
Found Java Version: 1.8.0_31 3824 
 3825 
Ozone Server Setup Utility 3826 
***WARNING*** 3827 
This product MUST be installed by a Pericore Certified Engineer. Pericore, 3828 
Inc. cannot be held liable for damages resulting from negligent or fraudulent 3829 
actions of unauthorized or unqualified administrators. Please review all 3830 
documentation thoroughly before continuing. Continuation of this 3831 
configuration process represents an agreement to abide by the Pericore EULA. 3832 
I agree to all terms and conditions set forth by Pericore, Inc. [N] : y 3833 
Enable Startup Password? [N] : n 3834 
May 15, 2015 2:31:37 PM 3835 
com.pericore.util.ObjectIdentifierFactory$OIDDataLoader debug 3836 
INFO: ObjectIdentifierFactory Read 240.165 kb in 3.313 ms; Indexed 2,415 Arcs 3837 
in 52.438 ms; 2,310(1,054:5) keys => 2.003 kb 3838 
Server Configuration Directory: 3839 
1: /usr/local/server/bin/conf 3840 
2: Other... 3841 
Choice [1] : 1 3842 
 3843 
Select the XML License File: 3844 
1: /usr/local/server/bin/conf/ServerLicense.xml 3845 
2: Other... 3846 
Choice [1] : 1 3847 
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 3848 
Select the XML Configuration File: 3849 
1: /usr/local/server/bin/conf/ServerConfiguration.xml 3850 
2: Other... 3851 
Choice [1] : 1 3852 
 3853 
Page 1 | Current Directory: /usr/local/server/bin 3854 
[00] ../  3855 
[01] lib/  3856 
[02] conf/  3857 
 Select Server Identity Keystore [ # ] : 2 3858 
Page 1 | Current Directory: /usr/local/server/bin/conf 3859 
[00] ../  3860 
[01] server.jks  3861 
 3862 
Select Server Identity Keystore [ # ] : 1 3863 
Enter password for server.jks : 123456 3864 
Is the Private Key Alias 'server' correct? [Y] : Y 3865 
 3866 
Enable logging? [Y] : Y 3867 
Log File Roll Size (Kb) [512] : 512 3868 
 3869 
Configured Client Services: 0 3870 
Choose an option: 3871 
1: Configure Authorization Service 3872 
2: Configure a Proof Proxy 3873 
3: Configure an Info Page 3874 
4: Configure a Push Service 3875 
5: Done Configuring Web Services 3876 
Choice [1] : 1 3877 
 3878 
Configuring XACML Authorization Service 3879 
Service Port [8080] : 443 3880 
Service Context [/AuthorizationService] : /AuthorizationService 3881 
Enable WS-Security? [Y] : Y 3882 
SOAP Signature Method: 3883 
1: RSA_SHA1 3884 
2: RSA_SHA256 3885 
3: RSA_SHA384 3886 
4: RSA_SHA512 3887 
Choice [1] : 2 3888 
Enable WS-Security Client Authentication? [N] : N 3889 
Configured Client Services: 1 3890 
 3891 
 3892 
Choose an option: 3893 
1: Configure Authorization Service 3894 
2: Configure a Proof Proxy 3895 
3: Configure an Info Page 3896 
4: Configure a Push Service 3897 
5: Done Configuring Web Services 3898 
Choice [1] : 5 3899 
 3900 
Enable SSL? [N] : y 3901 
Service Port [8080] : 443 3902 
Enable SSL Client Authentication? [N] : N 3903 
Enable SSL? [N] : N 3904 
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Modify Advanced Performance Options? [N] : N 3905 
 3906 
Writing server configuration... 3907 
Thank you for choosing Ozone Server 3908 
Goodbye. 3909 
 3910 
[root@ozoneserver local]# /usr/local/server/bin/startServer.sh 3911 

13.6 OZONE ENVOY INSTALLATION 3912 

Ozone Envoy was installed and not utilized in the builds. The functions it provides, automated 3913 
CRLs and certificate collection, were not required in the solution. 3914 
 3915 
Create keys and certificates and store in Java Keystore (JKS) 3916 
 3917 
Install java 3918 
[root@ozoneenvoy ~]# yum install java 3919 
 3920 
Install Ozone Envoy 3921 
[root@ozoneenvoy ~]# cd /usr/local/ 3922 
[root@ozoneenvoy local]# tar -xzf ~/Ozone\ Envoy-2014.tar.gz 3923 
 3924 
Copy the keystore to the bin directory 3925 
[root@ozoneenvoy local]# cp ~/envoy.jks envoy/bin/ 3926 
 3927 
Edit the envoy.txt file to set configuration options 3928 
### Ozone Suite (c) Pericore, Inc. 2007-2014. 3929 
### All rights reserved.  3930 
 3931 
#############################################################################3932 
### 3933 
### envoy.txt - Ozone Envoy 2014 Configuration File ### 3934 
###    ### 3935 
### Author: Jacob Dilles <jdilles@mountaireygroup.com> ### 3936 
###    ### 3937 
### Date: 1 Jan 2014   ### 3938 
###    ### 3939 
### Notes: This is a sample Ozone Envoy 4.1.0 Setup Configuration File ### 3940 
### demonstrating configuration options for Mobile Enrollment. ### 3941 
###    ### 3942 
### In a production environment, you should exclude the /pass= ### 3943 
### properties and provide them on the command line during setup.### 3944 
### After installation is complete, this file should be deleted ### 3945 
### or 'chown root; chgrp 0; chmod 000' to secure it. ### 3946 
#############################################################################3947 
### 3948 
 3949 
### General Envoy Configuration  3950 
 3951 
############################################################ 3952 
############ Identity Keystore Configuration ############## 3953 
############################################################ 3954 
### This keystore is used for: 3955 
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### - Authenticating with Ozone Authority 3956 
### - Secure log signing  3957 
system/identity/store=envoy.jks 3958 
 3959 
####### Authority Listener Configuration  3960 
### This web service endpoint listens for push configuration and fetch 3961 
requests 3962 
### from Ozone Authority. It should match what you entered in Ozone Console 3963 
 3964 
#authority/host.name= 3965 
authority/port=4242 3966 
authority/path=/ 3967 
authority/mode=ANY 3968 
 3969 
### Authority Web Service Endpoint Logging  3970 
authority/log/enable=true 3971 
authority/log/path=var/log 3972 
authority/log/rollsize=10485760 3973 
authority/log/format=CLF 3974 
 3975 
###################################################### 3976 
############ Enrollment Configuration ################ 3977 
###################################################### 3978 
 3979 
### Enable enrollment  3980 
enroll/enable=false 3981 
 3982 
Run Ozone Envoy to complete the setup 3983 
[root@ozoneenvoy bin]# ./startEnvoy.sh 3984 
 3985 
May 15, 2015 3:09:04 PM 3986 
com.pericore.util.ObjectIdentifierFactory$OIDDataLoader debug 3987 
INFO: ObjectIdentifierFactory Read 240.165 kb in 14.366 ms; Indexed 2,415 3988 
Arcs in 63.198 ms; 2,310(1,054:5) keys => 2.003 kb 3989 
May 15, 2015 3:09:06 PM com.pericore.util.PericoreProvider jsafeJCEinit 3990 
POST: [FIPS] FIPS-140 compliance self-test passed. 3991 
 _______ __________ _______ __ _ ________   3992 
 / ___ \ _____ // ___ \ | \ | | ______| (R)  3993 
 | / \ | / /| / \ || \ \ | | |  3994 
 | | | | / / | | | || |\ \ | | |____  3995 
 | | | | / / | | | || | \ \ | | ____| 3996 
 | | | | / / | | | || | \ \| | | 3997 
 \ \___/ // /___ \ \___/ /| | \ \ | |______ 3998 
 \_______//________ \_______/ |_| \__|________| 3999 
 4000 
 ______  4001 
 | ____|  4002 
 | |__ _ ____ _____ _ _  4003 
 | __| | '_ \ \ / / _ \| | | | 4004 
 | |____| | | \ V / (_) | |_| | 4005 
 |______|_| |_|\_/ \___/ \__, | 4006 
  __/ | 4007 
 2014 Mobile Edition |___/  4008 
 4009 
 Ozone(R) Envoy copyright (c) Pericore, Inc. 2007-2014 4010 
--------------------------------------------------------- 4011 
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 Fri May 15 15:09:04 EDT 2015 4012 
 4013 
Ozone Envoy Mobile 2014 Setup Utility  4014 
Ozone Suite copyright (c) Pericore, Inc. 2007-2014.  4015 
All rights reserved. 4016 
 4017 
***WARNING*** 4018 
This product MUST be installed by a Pericore Certified Engineer. 4019 
Improper configuration of Ozone Envoy Tool may cause security 4020 
vulnerabilities. 4021 
  4022 
I agree to all terms and conditions set forth by Pericore, Inc. [N] : y 4023 
envoy.jks 4024 
system/identity/store [/usr/local/envoy/bin/envoy.jks] :  4025 
Enter password for envoy.jks : 4026 
Is the Private Key Alias 'envoy' correct? [Y] : Y 4027 
 4028 
[POST] Starting Authority Listener: https://ozoneenvoy:4242/ ......... [ OK ] 4029 
> : 4030 
 4031 
Return to Ozone Console to complete Ozone Envoy Configuration 4032 

13.7 OZONE CONSOLE ENVOY CONFIGURATION 4033 

Create a proof to store the certificates retrieved by Ozone Envoy 4034 

1. Open Ozone Console. 4035 

2. Select an administrator certificate to log in as shown in Figure 169. 4036 

3. Select Proof>New Proof.. 4037 

4. Enter a name for the proof. 4038 

5. Select the publication schedule. 4039 

6. Select the publication point(s). 4040 

7. Select the distribution point(s). 4041 



DRAFT 
   

219 | NIST Cybersecurity Practice Guide SP 1800-2c 
 

 4042 

Figure 169. Ozone New Proof Information 4043 

8. Click the Administrators tab. 4044 

9. Select the administrators to manage the proof. 4045 

10. Click the Authentication tab. 4046 

11. Click the Add from file… button. 4047 

12. Select the CA and intermediate CA certificates to be used to authenticate certificates 4048 
retrieved. 4049 

13. Select the Certificate Revocation Lists tab as shown in Figure 170. 4050 

14. Enter a CRL grace period, the number of hours a CRL can be considered valid after its 4051 
next update time. 4052 

15. Click the Add… button to add a CRL. 4053 
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 4054 

Figure 170. Ozone New Proof Authentication CRLs 4055 

16. Select the Source Configuration tab ash shown in Figure 171. 4056 

17. Enter hostname or IP address of the LDAP server. 4057 

18. Enter the port the LDAP server is listening on. 4058 

19. Check the box for LDAPS. 4059 

20. Enter the base context of where user certificates can be obtained. 4060 

21. Enter the attributeName for the certificates, either userCertificate or 4061 
userCertificate;binary 4062 

22. Enter the base context of where updated CRLs can be obtained. 4063 

23. Enter the attributeName for the CRLs, typically certificateRevocationList shown in Figure 4064 
156. 4065 

24. Enter the connection information: 4066 

• If connecting anonymously, check the box for anonymous connections. 4067 

• If a username/password is required for the connection, enter them. 4068 

25. Enter the number of hours after which Ozone Envoy should check the directory for new 4069 
certificates. 4070 
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 4071 

Figure 171. Ozone New Proof Authentication Source Configuration 4072 

26. Click Save. 4073 
 4074 

Configure Ozone Authority to connect to Ozone Envoy 4075 

1. Select Enrollment>Envoy Configuration. 4076 

2. Enter the hostname or IP address of the Ozone Envoy. See Figure 172.. 4077 

3. Enter the port number Ozone Envoy is listening on. 4078 

4. Enter the number of hours that should elapse between connections to Ozone Envoy to 4079 
check for new information. 4080 

5. Enter the number of minutes to before attempting to reconnect to Ozone Envoy if the 4081 
connection fails. 4082 

6. Click Save. 4083 
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 4084 

Figure 172. Ozone Envoy Configuration 4085 

 4086 

14 PHYSICAL ACCESS CONTROL: XTEC XNODE 4087 

The XNode was installed in the DMZ network. The Xnode is a standalone IdAM demonstration 4088 
capability including a personal identification verification (PIV) card reader, PIV Interoperability 4089 
(PIV-I) cards, keypad and electric door strike. The XNode was preconfigured to poll the IP 4090 
address of the cloud based IdAM system at the Xtec control center. No additional configuration 4091 
information is required. The identities on the PIV cards included access allowed and access 4092 
denied status for demonstration purposes. 4093 

14.1 SECURITY CHARACTERISTICS 4094 

Cybersecurity Framework Categories: PR.AC-1: Identities and credentials are managed for 4095 
authorized devices and users 4096 

NIST 800-53 rev 4 Security Controls: AC-2, IA Family, PE-2, PE-3, PE-4, PE-5, PE-6, PE-9 4097 

15 ENTERPRISE PKI PLATFORM: GLOBALSIGN 4098 

15.1 OVERVIEW 4099 

The NCCoE used the GlobalSign Enterprise PKI platform to issue and manage North American 4100 
Energy Standards Board (NAESB) WEQ-12 digital certificates used for secure network access of 4101 
for both internal and external users, see Figure 173. The certificates were used in conjunction 4102 
with the MAG Ozone product to provide high assurance attributes for the Personal Profile 4103 
Application (PPA). The application has three main information groups for which actions can be 4104 
authorized: Personal Information, Credit Reports, and Criminal History. Based on the 4105 
authorizations associated with a credential, results pages are dynamically populated. 4106 
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 4107 

Figure 173. GlobalSign Overview 4108 

The North American Energy Standards Board (NAESB) serves as an industry forum for the 4109 
development and promotion of business process standards which can lead to a seamless 4110 
marketplace for wholesale and retail natural gas and electricity, as recognized by its customers, 4111 
business community, participants, and regulatory entities. GlobalSign is an active participant of 4112 
the NAESB Cyber-Security standards committee and is a NAESB-authorized Certificate Authority 4113 
(CA). For more information about NAESB, go to https://www.naesb.org/.  4114 

GlobalSign’s NAESB-compliant certificate-based authentication solution is managed through a 4115 
SaaS service accessed through a web-based portal. The web portal gives organizations control of 4116 
Digital IDs issued to individuals using one of four NIST defined assurance levels. Set-up usually 4117 
takes less than three days. Another advantage of the web-portal is that all of the lifecycle 4118 
functions including issuance, re-issuance, renewal, and revocation are available to the 4119 
administrator. 4120 

http://172.16.33.88:9080/AlertEnterprise/
http://172.16.33.88:9080/AlertEnterprise/
https://www.naesb.org/
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 Managing the Account 15.1.14121 
Managing the account is accomplished using the GlobalSign Certificate Management Center 4122 
(GCC). GCC is a web-based interface allowing you to access your certificates anywhere with an 4123 
Internet connection. Within the platform, administrators may add additional users and delegate 4124 
some or all certificate management functions. 4125 

 What Is a Profile? / Profile Management 15.1.24126 
A profile, or certificate profile, contains the organization’s identity information that will be used 4127 
for all NAESB WEQ-12 digital certificates issued from the account. Organization identity 4128 
information includes the organization legal name, country code, and optionally locality, state, 4129 
and up to three fixed organization units as well as assurance level.  4130 

 What Is a License? 15.1.34131 
GlobalSign NAESB digital certificates are valid for either (1) or (2) years and must be issued 4132 
within (12) months of license ordering.  4133 

GlobalSign NAESB digital certificates are sold in “license packs” (i.e., in quantities of 5, 10, 25, 4134 
50, etc.) Certificates are issued with either (1) or (2) year validities and must be issued within 4135 
(12) months of license ordering.  4136 

15.2 SECURITY CHARACTERISTICS 4137 

Cybersecurity Framework Categories: PR.AC-1: Identities and credentials are managed for 4138 
authorized devices and users 4139 

NIST 800-53 rev 4 Security Controls: AC-2, IA Family 4140 

15.3 HOW TO ORDER CERTIFICATES 4141 

 Step 1: Get a GlobalSign Gcc Account 15.3.14142 
Request a GlobalSign Certificate Center account here – 4143 
https://www.globalsign.com/en/verticals/energy/.  4144 

 Step 2: Order Certificate License Pack 15.3.24145 
Once you have your GCC account credentials, use the following link to login – 4146 
www.globalsign.com/en/login/. See Figure 174. 4147 

http://localhost:5176/
http://172.16.33.88:9080/AlertEnterprise/
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 4148 

Figure 174. GlobalSign Login Page 4149 

 4150 

Click on the “Enterprise PKI” tab as shown in Figure 175. 4151 

 4152 

Figure 175. GlobalSign Enterprise PKI Tab 4153 

 4154 

Click “Order Licenses” from the left hand menu as shown in Figure 176. 4155 

 4156 

Figure 176. GlobalSign Order Licenses Page 4157 

 4158 

Choose the “Enterprise PKI Pro For Personal Digital ID” license pack you intend to purchase and 4159 
click next as shown in Figure 177. 4160 
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 4161 

Figure 177. GlobalSign License Selection Page 4162 

 4163 

Choose your validity period (1 or 2 year certificate), see Figure 178. 4164 

 4165 

 4166 

Figure 178. GlobalSign Product Details 4167 

Provide payment details as shown in Figure 179. 4168 

 4169 
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 Figure 179. GlobalSign Payment Details 4170 

Confirm your order details and check the box confirming you understand that the license pack 4171 
will expire 12 months from the order date, Figure 180. 4172 

 4173 

Figure 180. GlobalSign Confirm Details 4174 

 Step 3: Set Up Organization Profile 15.3.34175 
Click “Order Additional Profiles” from the left navigation menu as shown in Figure 181. 4176 

 4177 

Figure 181. GlobalSign Order Additional Profiles 4178 

Enter your Organization Profile details. Please note the details you enter will be vetted and 4179 
included as the certificate identity within your issued certificate, see Figure 182. 4180 
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Additionally select the Assurance level appropriate for the risk associated with the transaction. 4181 
Contact GlobalSign NAESB experts for additional guidance on this topic. 4182 

 4183 

Figure 182. GlobalSign Certificate Profile Details 4184 

Confirm your profile details (Figure 183) and then review and accept the EPKI Service 4185 
Agreement that includes important NAESB WEQ-012 obligations. Note the EPKI Service 4186 
Agreement binds you to obligations as outlined in the GlobalSign Certificate Policy and 4187 
Certificate Practice Statements, including Local Registration Authority, end user, and relying 4188 
party, as defined in the NAESB Public Key Infrastructure (PKI) Standards – WEQ-012.  4189 

Certificate Practice Statements can be found at http://www.globalsign.com/repository/   4190 

https://www.globalsign.com/en/verticals/energy/
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 4191 

Figure 183. GlobalSign Confirm Details 4192 

 Step 4: Vetting 15.3.44193 
Once you have placed your order, all of your information will be sent to GlobalSign’s vetting 4194 
department. The organization details you provided for your profile will be vetted by GlobalSign 4195 
using third party checks.  4196 

 Step 5: Register for Your EPKI Administrator Certificate 15.3.54197 
Once your company profile has been approved, you will need to register for what is known as 4198 
an “EPKI Administrator Certificate.” An EPKI Administrator Certificate is required to authenticate 4199 
to secure areas of the EPKI service to register and manage end user certificates.  4200 

1. Login into GCC 4201 
2. Select “View Admin Menu Options” in the left hand menu to start the enrollment 4202 

process, see Figure 184. 4203 

 4204 

Figure 184. GlobalSign View Admin Menu Options 4205 

3. Choose a certificate password. It is very important to remember this password. 4206 
4. Download your administrator certificate and follow the on screen prompts to install your 4207 

certificate.  4208 

Please follow the guide http://www.globalsign.com/support/ordering-guides/epki-4209 
authentication-user-guide.pdf for step-by-step instructions on how to order, install, and use 4210 
your Administrator Certificate.  4211 
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CAUTION: If you need to access the EPKI administrator menu options from multiple machines, 4212 
you can copy your .pfx file to other computers and repeat the import process. Instructions for 4213 
importing your certificate can be found here - 4214 
https://support.globalsign.com/customer/portal/articles/1211387.  4215 

 Step 6: Register and Issue Certificates to Individual Users 15.3.64216 
Click “Order Certificates” in the left navigation menu as shown in Figure 185. 4217 

NOTE: If you haven’t already authenticated to the secure section of the portal with your 4218 
Administrator Certificate, you may see “View Admin Menu Options” instead of the menu 4219 
options included in the image below. Simply click the “View Admin Menu Options” link and 4220 
select the appropriate certificate to gain access to this section of the portal.  4221 

 4222 

Figure 185. GlobalSign Oder Certificates 4223 

Select the profile and license you want to use and click Next, see Figure 186. 4224 

 4225 

Figure 186. GlobalSign Product Selection 4226 

Complete the certificate identity details (Figure 187) for the end user of the certificate, including 4227 
the common name (i.e., the individual’s first and last name) and the email addresses. 4228 
Organization name, and other fields will be pre-populated from the profile you selected.  4229 
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 4230 

Figure 187. GlobalSign Certificate Identity Details 4231 

You will also need to choose a “pick up password”. The pick up password is a unique password 4232 
that you will give to the end user of the certificate. After you have completed the registration 4233 
process, the end user will receive an email invitation to pick up their certificate and at that time 4234 
they will be prompted for the pick up password (you gave them in an out-of-band method) 4235 
along with details of how to install their new certificate. 4236 

Finally, confirm the details of your certificate request as shown in Figure 188. 4237 
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 4238 

Figure 188. GlobalSign Confirm Details 4239 

Repeat this process until you have requested certificates for all of your end users. 4240 

For further information on the features available in your GlobalSign Certificate Center please 4241 
visit: http://www.globalsign.com/support/ordering-guides/globalsign-epki-admin-guide.pdf  4242 

15.4 GLOBALSIGN’S IDENTITY AND ACCESS MANAGEMENT SOLUTION FOR MANAGING EXTERNAL USERS 4243 

For use cases involving external users (e.g. Independent System Operators (ISOs) operating 4244 
wholesale electric marketplaces), GlobalSign PKI can provide an identity and access 4245 
management (IAM) solution that enables management of external user (customer and partner) 4246 
identities and the online services and applications they can access.  4247 

15.5 GETTING HELP  4248 

GlobalSign provides technical support through our Client Service departments around the 4249 
world. Visit https://www.support.globalsign.com for detailed instructions on installing and 4250 
managing certificates, or contact support@globalsign.com or 1-877-467-7543 with specific 4251 
questions.  4252 

16 INDUSTRIAL FIREWALL: SCHNEIDER ELECTRIC  4253 

A Schneider Electric (SE) industrial firewall is installed on the physical network that contains the 4254 
industrial control system/SCADA components that can be accessed and controlled via the OT 4255 
network. The firewall is configured to monitor the data passing between the RADiFlow SCADA 4256 

https://nccoe.nist.gov/sites/default/files/nccoe/NIST_PXPolicies.zipx
https://www.support.globalsign.com/
http://172.16.33.88:9080/AlertEnterprise/
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firewall and the OT network. The SE industrial firewall will alert if out-of- policy traffic is 4257 
detected on the network segment connecting the OT network and the SCADA network of 4258 
devices. 4259 

Install and Configure Schneider Tofino Firewall 4260 

1. Download the ConneXium software from the Schneider site as stated in the instructions 4261 
accompanying the firewall, start the ConneXium Tofino Configurator. 4262 

2. At the startup screen, click ‘Create New Project…’, Figure 189. 4263 

 4264 

Figure 189. Create New Project 4265 

3. In Project name, enter the name you would like to use for the project, as shown in 4266 
Figure 190. Also fill in the Company field. When finished, click Next. 4267 
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 4268 

Figure 190. New Project Wizard 4269 

4. In the Project Protection screen, Figure 191, choose a password to protect the project. 4270 
Then click Next.  4271 
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 4272 

Figure 191. Project Protection 4273 

In the Administrator Password screen,  4274 

5. Figure 192, choose the administrator password. Then click Finish. 4275 

 4276 
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Figure 192. Administrator Password 4277 

6. In the Project Explorer Window, Figure 193, right click ‘Tofino SAs’ and select ‘New 4278 
Tofino SA’. *Note: You can also chose to create a folder for the SAs to help organize 4279 
multiple areas.4280 

 4281 

Figure 193. Project Explorer Window 4282 

7. In the Tofino ID field, Figure 194, enter the MAC address listed on the firewall hardware 4283 
sticker. Fill out the rest of the fields as necessary. Then click Finish. 4284 
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 4285 

Figure 194. Tofino SA/MAC Address 4286 

8. Right click on the ‘Assets’ icon in the Project Explorer frame, Figure 195, and click ‘New 4287 
Asset.’ 4288 

 4289 

Figure 195. 4290 
Project 4291 

Explorer 4292 
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9. In the New Asset window, Figure 196, set the name of the device, as well as the type 4293 
and all other fields as necessary. Then click Next. 4294 

 4295 

Figure 196. New Asset 4296 

 4297 
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10. Fill in the IP address and/or the MAC address fields, Figure 197, then click Finish.  4298 

11. Repeat steps 8-10 for all devices on the network. When they are configured, click on the 4299 
‘Assets’ icon, Figure 197, in the Project Explorer frame (if it isn’t already selected) and 4300 
there should be a list of all the configured Assets.  4301 

 4302 

Figure 197. Project Explorer Assets Icon 4303 

12. Under the Project Explorer frame, click the dropdown arrow next to ‘Tofino SAs’, then 4304 
choose the SA created earlier, Figure 198. From there, click on ‘Firewall’ in the Project 4305 
Explorer frame to display current firewall rules. This should be empty currently.  4306 
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 4307 

Figure 198. Project Explorer Tofino SA Icon 4308 

 4309 

 4310 

13. To create the first rule, click on the ‘+ Create Rule’ button above the Tofino SA-Firewall 4311 
title, Figure 198, above. Then ensure the ‘Standard rule’ radio button is selected and 4312 
click ‘Next’, Figure 199. 4313 
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Figure 199. Rule Type 4314 

14. On the next screen, Figure 200, there a few options to determine. First is Asset 1, you 4315 
must choose the interface. This will be where the traffic is coming from into the device. 4316 
In the Lab Build, Asset 1 is the OT Workstation, which is connected to a network that is 4317 
connect to the External interface on the firewall. Select the ‘Select an asset from the list 4318 
below’ radio button for both Asset 1 and Asset 2, and select the systems to create a rule 4319 
between. Also, select the direction of the traffic using the arrow buttons in the middle. 4320 
When finished, select Next. 4321 

 4322 

Figure 200. Firewall Rule Wizard 4323 
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15. On the Asset Rule Profiles, Figure 201, select the ‘Manually create the firewall rules for 4324 
the selected assets’ radio button. Click Next. 4325 

 4326 

Figure 201. Asset Rule Profiles 4327 

16. On the Protocol screen, Figure 202, choose the protocol to be checked against. There are 4328 
drop down menus for ‘Common Industrial’, ‘Common IT’, and ‘Vendor Specific.’ For this 4329 
example, we are choosing SSH and Telnet (by holding the CTRL key, you can select 4330 
multiple protocols). Then choose the Permission on the right side of the screen, as well 4331 
as whether to log or not. Then click Finish. 4332 



DRAFT 
   

243 | NIST Cybersecurity Practice Guide SP 1800-2c 
 

Note: By default, any traffic that does not match the rules in the firewall will 4333 
automatically be denied.  4334 

Figure 202. Protocol Window 4335 

17. After that is completed, the firewall rule should be listed in the Rule Table, Figure 203.  4336 
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Figure 203. Rule Table 4337 

18. Repeat steps 13 through 17 for the remainder of the rules needed. 4338 

19. Finally, press the save button on the menu bar. Circled in red below in Figure 204.4339 

 4340 

Figure 204. Save rules in Project Explorer 4341 

20. Place a FAT/FAT32 formatted USB device into the computer running the ConneXium 4342 
Tofino Configurator, then right click ‘Tofino SAs’ in the Project Explorer pane and select 4343 
‘Apply.’ If the project asks you to save, press ‘OK’. 4344 
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21. In the Apply Configuration pane, Figure 205, ensure that your SA is selected in the table 4345 
at the top, and the ‘USB Drive’ radio button is selected. Then browse to the top-level 4346 
directory of your USB drive. Then click Finish.  4347 

Figure 205. Apply Configuration Pane 4348 

22. A popup, Figure 206, will notify you of successful completion. 4349 

 4350 
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Figure 206. Loadable USB Drive Popup 4351 

23. Ensure the firewall has been powered on and has been running for at least one minute, 4352 
then plug the USB device used to copy the Tofino configuration to into the USB port on 4353 
the back of the firewall.  4354 

24. Press the Save/Load/Reset button twice, setting it to the Load setting (Pressing once 4355 
should turn the indicator light to green, pressing it again will change it from green to 4356 
amber). After a few seconds, the device will begin displaying lights that move from right 4357 
to left across the LEDs on the back, indicating the configuration is being loaded. 4358 

25. Once the lights stop moving right to left, wait a few seconds, and ensure the Fault LED 4359 
does not light up. Then remove the USB drive and place it back into the computer 4360 
running the ConneXium Tofino Configurator software. 4361 

26. Right click ‘Tofino SAs’ in the Project Explorer pane and select ‘Verify’.  4362 

27. At the Verify Loaded Configuration window, select the Tofino SA in the table, and select 4363 
the ‘USB Drive’ radio button. Then select the USB drive using the Browse button. Finally, 4364 
press Finish. 4365 

28. A popup will notify you of successful verification, and configuration is complete. 4366 

 4367 

17 OPERATING SYSTEM STIG COMPLIANCE REPORTS 4368 

STIG compliance reports were generated for the STIG-compliant OS installations that were used 4369 
in the build. The reports for each installation are provided in the following subsections. Neither 4370 
the Windows 7 Console on the IT network nor the OT Management Windows 7 Workstation on 4371 
the OT network were STIG-compliant installations, so compliance reports for those OSs are not 4372 
provided. 4373 

The Linux implementations (except SUSE Linux) were configured to meet the DoD CentOS 6 4374 
STIG, because no CentOS 7 STIG was available at the time the build was implemented. The STIG 4375 
guidelines are available on-line at http://iase.disa.mil/stigs/os/Pages/index.aspx . The OS 4376 
configurations for each Linux implementation are listed below. The compliance results reports 4377 
identify the configuration items that do not conform to the STIG configuration guide. 4378 

Compliance reports are provided for the following OSs: 4379 

• SQL Server on IdAM Network STIG Compliance Report 4380 
• RSA IMG SUSE Linux Server STIG Compliance Report 4381 
• RSA Adaptive Directory Centos 7 Server STIG Compliance Report 4382 
• AlertEnterprise Microsoft Server STIG Compliance Report 4383 
• IT Domain Controller STIG Compliance Report 4384 

http://iase.disa.mil/stigs/os/Pages/index.aspx
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• IT Windows 7 Workstations STIG Compliance Report 4385 
• Ozone Authority and Ozone Server Centos 6 Server STIG Compliance Report 4386 
• Ozone Envoy Centos 6 Server STIG Compliance Report 4387 
• OT Domain Controller STIG Compliance Report 4388 
• OT ConsoleWorks Windows Server 2012 STIG Compliance Report 4389 
• OT Windows 7 Workstations STIG Compliance Report 4390 
• PACS Domain Controller STIG Compliance Report 4391 
• PACS Console Windows Server 2012 STIG Compliance Report 4392 
• Baseline CentOS 7 Linux Configuration 4393 

 4394 

17.1 SQL SERVER ON IDAM NETWORK STIG COMPLIANCE REPORT 4395 

Status STIG ID Rule ID Vuln ID Severity Rule Title 

N/A SQL2-00-
000300 

SV-53912r1_rule V-41389 CAT II  SQL Server must maintain and support organization-defined 
security labels on stored information. 

N/A SQL2-00-
000400 

SV-53914r1_rule V-41391 CAT II SQL Server must maintain and support organization-defined 
security labels on information in process. 

N/A SQL2-00-
000500 

SV-53916r1_rule V-41392 CAT II SQL Server must maintain and support organization-defined 
security labels on data in transmission. 

N/A SQL2-00-
000900 

SV-53917r1_rule V-41393 CAT II SQL Server must allow authorized users to associate security labels 
to information in the database. 

N/A SQL2-00-
00920 

SV-53920r1_rule V-41395 CAT II SQL Server must be protected from unauthorized access by 
developers. 

N/A SQL2-00-
009300 

SV-53921r1_rule V-41396 CAT II SQL Server must be protected from unauthorized access by 
developers on shared production/development host systems. 

PASS SQL2-00-
00950 

SV-53922r2_rule V-41397 CAT II Administrative privileges, built-in server roles and built-in database 
roles must be assigned to the DBMS login accounts that require 
them via custom roles, and not directly. 

PASS SQL2-00-
011050 

SV-53918r2_rule V-41394 CAT II SQL Server utilizing Discretionary Access Control (DAC) must 
enforce a policy that limits propagation of access rights. 

UNKNOWN 

What is 
considered 
auditable? 

SQL2-00-
011200 

SV-53928r2_rule V-41402 CAT II SQL Server must provide audit record generation capability for 
organization-defined auditable events within the database. 

 4396 

17.2 RSA IMG SUSE LINUX SERVER STIG COMPLIANCE REPORT 4397 

OpenSCAP Evaluation Report 4398 

 Evaluation Characteristics 17.2.14399 
Target machine dvd-acm 
Benchmark URL U_RedHat_6_V1R6_STIG_SCAP_1-1_Benchmark-xccdf.xml 
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Performed by root 

 Compliance and Scoring 17.2.24400 
The target system did not satisfy the conditions of 107 rules! Furthermore, the results of 12 rules 4401 
were inconclusive. Please review rule results and consider applying remediation.  4402 

 Rule Results 17.2.34403 
60 passed  4404 
107 failed  4405 
12 other  4406 

 Severity of Failed Rules 17.2.44407 
0 other  4408 
53 low  4409 

53 medium  4410 
1 high  4411 

 Score 17.2.54412 
Scoring system Score Maximum Percent 
urn:xccdf:scoring:default 33.519554 100.000000 33.52% 
Search 4413 
Title Severity Result 
Red Hat Enterprise Linux 6 Security Technical Implementation Guide 107x fail 12x error 

SRG-OS-999999 1x error 
Automated file system mounting tools must not be 
enabled unless needed. 

low error 

SRG-OS-000062 1x fail 
Auditing must be enabled at boot by setting a kernel 
parameter. 

low fail 

SRG-OS-999999 1x fail 
The /etc/gshadow file must be owned by root. medium fail 

SRG-OS-999999 1x fail 
The /etc/gshadow file must be group-owned by root. medium fail 

SRG-OS-999999 1x fail 
The /etc/gshadow file must have mode 0000. medium fail 

SRG-OS-999999 1x fail 
The system must use a separate file system for /tmp. low fail 

SRG-OS-999999 1x fail 
The system must use a separate file system for /var. low fail 

SRG-OS-999999 1x fail 
The system must use a separate file system for /var/log. low fail 

SRG-OS-000259 1x fail 
Library files must be owned by root. medium fail 

SRG-OS-000044 1x fail 
The system must use a separate file system for the 
system audit data path. 

low fail 

SRG-OS-000045 1x fail 
The audit system must alert designated staff members 
when the audit storage volume approaches capacity. 

medium fail 

SRG-OS-000259 1x fail 
All system command files must be owned by root. medium fail 

SRG-OS-999999 1x fail 
The system must use a separate file system for user low fail 
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Title Severity Result 
home directories. 

SRG-OS-000078 1x fail 
The system must require passwords to contain a minimum 
of 14 characters. 

medium fail 

SRG-OS-000075 1x fail 
Users must not be able to change passwords more than 
once every 24 hours. 

medium fail 

SRG-OS-000076 1x fail 
User passwords must be changed at least every 60 days. medium fail 

SRG-OS-000071 1x fail 
The system must require passwords to contain at least 
one numeric character. 

low fail 

SRG-OS-000103 1x fail 
The system package management tool must 
cryptographically verify the authenticity of system software 
packages during installation. 

medium fail 

SRG-OS-000232 1x fail 
A file integrity tool must be installed. medium fail 

SRG-OS-000273 1x fail 
The operating system must enforce requirements for the 
connection of mobile devices to operating systems. 

medium fail 

SRG-OS-000248 1x fail 
There must be no .rhosts or hosts.equiv files on the 
system. 

high fail 

SRG-OS-000249 1x fail 
The system must disable accounts after excessive login 
failures within a 15-minute interval. 

medium fail 

SRG-OS-999999 1x fail 
The /etc/shadow file must be group-owned by root. medium fail 

SRG-OS-999999 1x fail 
The /etc/shadow file must have mode 0000. medium fail 

SRG-OS-999999 1x fail 
IP forwarding for IPv4 must not be enabled, unless the 
system is a router. 

medium fail 

SRG-OS-000146 1x error 
The operating system must prevent public IPv4 access 
into an organizations internal networks, except as 
appropriately mediated by managed interfaces employing 
boundary protection devices. 

medium error 

SRG-OS-000231 1x fail 
The systems local IPv4 firewall must implement a deny-all, 
allow-by-exception policy for inbound packets. 

medium fail 

SRG-OS-000096 1x fail 
The Datagram Congestion Control Protocol (DCCP) must 
be disabled unless required. 

medium fail 

SRG-OS-000096 1x fail 
The Stream Control Transmission Protocol (SCTP) must 
be disabled unless required. 

medium fail 

SRG-OS-000096 1x fail 
The Reliable Datagram Sockets (RDS) protocol must be 
disabled unless required. 

low fail 

SRG-OS-000096 1x fail 
The Transparent Inter-Process Communication (TIPC) 
protocol must be disabled unless required. 

medium fail 

SRG-OS-000215 1x fail 
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Title Severity Result 
The operating system must back up audit records on an 
organization defined frequency onto a different system or 
media than the system being audited. 

medium fail 

SRG-OS-000043 1x fail 
The operating system must support the requirement to 
centrally manage the content of audit records generated 
by organization defined information system components. 

medium fail 

SRG-OS-000062 1x fail 
The audit system must be configured to audit all attempts 
to alter system time through settimeofday. 

low fail 

SRG-OS-999999 1x fail 
The system must not accept IPv4 source-routed packets 
on any interface. 

medium fail 

SRG-OS-999999 1x fail 
The system must not accept ICMPv4 redirect packets on 
any interface. 

medium fail 

SRG-OS-999999 1x fail 
The system must not accept ICMPv4 secure redirect 
packets on any interface. 

medium fail 

SRG-OS-000062 1x fail 
The audit system must be configured to audit all attempts 
to alter system time through clock_settime. 

low fail 

SRG-OS-999999 1x fail 
The system must log Martian packets. low fail 

SRG-OS-999999 1x fail 
The system must not accept IPv4 source-routed packets 
by default. 

medium fail 

SRG-OS-000062 1x fail 
The audit system must be configured to audit all attempts 
to alter system time through /etc/localtime. 

low fail 

SRG-OS-000004 1x fail 
The operating system must automatically audit account 
creation. 

low fail 

SRG-OS-999999 1x fail 
The system must not accept ICMPv4 secure redirect 
packets by default. 

medium fail 

SRG-OS-999999 1x fail 
The system must ignore ICMPv4 redirect messages by 
default. 

low fail 

SRG-OS-000239 1x fail 
The operating system must automatically audit account 
modification. 

low fail 

SRG-OS-999999 
The system must not respond to ICMPv4 sent to a 
broadcast address. 

low pass 

SRG-OS-000240 1x fail 
The operating system must automatically audit account 
disabling actions. 

low fail 

SRG-OS-999999 1x fail 
The system must ignore ICMPv4 bogus error responses. low fail 

SRG-OS-000241 1x fail 
The operating system must automatically audit account 
termination. 

low fail 

SRG-OS-000142 1x fail 
The system must be configured to use TCP syncookies. medium fail 
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Title Severity Result 
SRG-OS-999999 1x fail 

The audit system must be configured to audit 
modifications to the systems Mandatory Access Control 
(MAC) configuration (SELinux). 

low fail 

SRG-OS-000064 1x fail 
The audit system must be configured to audit all 
discretionary access control permission modifications 
using chmod. 

low fail 

SRG-OS-999999 1x fail 
The system must use a reverse-path filter for IPv4 network 
traffic when possible by default. 

medium fail 

SRG-OS-000064 1x fail 
The audit system must be configured to audit all 
discretionary access control permission modifications 
using chown. 

low fail 

SRG-OS-999999 1x fail 
The IPv6 protocol handler must not be bound to the 
network stack unless needed. 

medium fail 

SRG-OS-000064 1x fail 
The audit system must be configured to audit all 
discretionary access control permission modifications 
using fchmod. 

low fail 

SRG-OS-999999 1x fail 
The system must ignore ICMPv6 redirects by default. medium fail 

SRG-OS-000064 1x fail 
The audit system must be configured to audit all 
discretionary access control permission modifications 
using fchmodat. 

low fail 

SRG-OS-000064 1x fail 
The audit system must be configured to audit all 
discretionary access control permission modifications 
using fchown. 

low fail 

SRG-OS-000064 1x fail 
The audit system must be configured to audit all 
discretionary access control permission modifications 
using fchownat. 

low fail 

SRG-OS-000152 1x error 
The system must employ a local IPv4 firewall. medium error 

SRG-OS-000064 1x fail 
The audit system must be configured to audit all 
discretionary access control permission modifications 
using fremovexattr. 

low fail 

SRG-OS-000064 1x fail 
The audit system must be configured to audit all 
discretionary access control permission modifications 
using fsetxattr. 

low fail 

SRG-OS-000064 1x fail 
The audit system must be configured to audit all 
discretionary access control permission modifications 
using lchown. 

low fail 

SRG-OS-000064 1x fail 
The audit system must be configured to audit all 
discretionary access control permission modifications 
using lremovexattr. 

low fail 

SRG-OS-000064 1x fail 
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Title Severity Result 
The audit system must be configured to audit all 
discretionary access control permission modifications 
using lsetxattr. 

low fail 

SRG-OS-000064 1x fail 
The audit system must be configured to audit all 
discretionary access control permission modifications 
using removexattr. 

low fail 

SRG-OS-000064 1x fail 
The audit system must be configured to audit all 
discretionary access control permission modifications 
using setxattr. 

low fail 

SRG-OS-000064 1x fail 
The audit system must be configured to audit successful 
file system mounts. 

low fail 

SRG-OS-000069 1x fail 
The system must require passwords to contain at least 
one uppercase alphabetic character. 

low fail 

SRG-OS-000266 1x fail 
The system must require passwords to contain at least 
one special character. 

low fail 

SRG-OS-000070 1x fail 
The system must require passwords to contain at least 
one lowercase alphabetic character. 

low fail 

SRG-OS-000072 1x fail 
The system must require at least four characters be 
changed between the old and new passwords during a 
password change. 

low fail 

SRG-OS-000021 1x fail 
The system must disable accounts after three consecutive 
unsuccessful logon attempts. 

medium fail 

SRG-OS-000120 1x fail 
The system must use a FIPS 140-2 approved 
cryptographic hashing algorithm for generating account 
password hashes (system-auth). 

medium fail 

SRG-OS-000064 1x fail 
The audit system must be configured to audit user 
deletions of files and programs. 

low fail 

SRG-OS-000120 1x fail 
The system must use a FIPS 140-2 approved 
cryptographic hashing algorithm for generating account 
password hashes (login.defs). 

medium fail 

SRG-OS-000120 1x fail 
The system must use a FIPS 140-2 approved 
cryptographic hashing algorithm for generating account 
password hashes (libuser.conf). 

medium fail 

SRG-OS-000064 1x fail 
The audit system must be configured to audit changes to 
the /etc/sudoers file. 

low fail 

SRG-OS-999999 1x fail 
The system boot loader configuration file(s) must be 
owned by root. 

medium fail 

SRG-OS-000064 1x fail 
The audit system must be configured to audit the loading 
and unloading of dynamic kernel modules. 

medium fail 

SRG-OS-999999 1x fail 
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Title Severity Result 
The system boot loader configuration file(s) must be 
group-owned by root. 

medium fail 

SRG-OS-000096 1x error 
The xinetd service must be disabled if no network services 
utilizing it are enabled. 

medium error 

SRG-OS-999999 1x fail 
The system boot loader configuration file(s) must have 
mode 0600 or less permissive. 

medium fail 

SRG-OS-000096 1x fail 
The xinetd service must be uninstalled if no network 
services utilizing it are enabled. 

low fail 

SRG-OS-000080 1x fail 
The system boot loader must require authentication. medium fail 

SRG-OS-000080 1x fail 
The system must require authentication upon booting into 
single-user and maintenance modes. 

medium fail 

SRG-OS-000080 1x fail 
The system must not permit interactive boot. medium fail 

SRG-OS-000022 1x fail 
The system must require administrator action to unlock an 
account locked by excessive failed login attempts. 

medium fail 

SRG-OS-999999 1x fail 
The system must not send ICMPv4 redirects by default. medium fail 

SRG-OS-999999 1x fail 
The system must not send ICMPv4 redirects from any 
interface. 

medium fail 

SRG-OS-000096 1x error 
The ypbind service must not be running. medium error 

SRG-OS-999999 1x fail 
The cron service must be running. medium fail 

SRG-OS-999999 1x error 
The avahi service must be disabled. low error 

SRG-OS-000056 1x error 
The system clock must be synchronized continuously, or 
at least daily. 

medium error 

SRG-OS-999999 1x fail 
The system must set a maximum audit log file size. medium fail 

SRG-OS-000062 1x fail 
The audit system must be configured to audit all attempts 
to alter system time through adjtimex. 

low fail 

SRG-OS-999999 1x fail 
The system must retain enough rotated audit logs to cover 
the required log retention period. 

medium fail 

SRG-OS-000096 1x error 
The atd service must be disabled. low error 

SRG-OS-999999 1x fail 
The system default umask for daemons must be 027 or 
022. 

low fail 

SRG-OS-999999 1x fail 
The system default umask in /etc/login.defs must be 077. low fail 

SRG-OS-999999 1x fail 
The system default umask in /etc/profile must be 077. low fail 

SRG-OS-999999 1x fail 
The system default umask for the csh shell must be 077. low fail 

SRG-OS-000096 1x error 
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Title Severity Result 
The rdisc service must not be running. low error 

SRG-OS-999999 1x fail 
The system default umask for the bash shell must be 077. low fail 

SRG-OS-999999 1x error 
The postfix service must be enabled for mail delivery. low error 

SRG-OS-000096 1x error 
The netconsole service must be disabled unless required. low error 

SRG-OS-000248 1x fail 
X Windows must not be enabled unless required. medium fail 

SRG-OS-999999 1x fail 
Process core dumps must be disabled unless needed. low fail 

SRG-OS-000027 1x fail 
The system must limit users to 10 simultaneous system 
logins, or a site-defined number, in accordance with 
operational requirements. 

low fail 

SRG-OS-000160 1x fail 
The system must provide VPN connectivity for 
communications over untrusted networks. 

low fail 

SRG-OS-000024 1x fail 
A login banner must be displayed immediately prior to, or 
as part of, graphical desktop environment login prompts. 

medium fail 

SRG-OS-000034 1x error 
The Bluetooth service must be disabled. medium error 

GEN006660 1x fail 
Accounts must be locked upon 35 days of inactivity. low fail 

SRG-OS-000118 1x fail 
The operating system must manage information system 
identifiers for users and devices by disabling the user 
identifier after an organization defined time period of 
inactivity. 

low fail 

SRG-OS-999999 1x fail 
All public directories must be owned by a system account. low fail 

SRG-OS-999999 1x fail 
The system must use a Linux Security Module configured 
to enforce limits on system services. 

medium fail 

SRG-OS-999999 1x fail 
The system must use a Linux Security Module configured 
to limit the privileges of system services. 

low fail 

SRG-OS-999999 1x fail 
The operating system, upon successful logon/access, 
must display to the user the number of unsuccessful 
logon/access attempts since the last successful 
logon/access. 

medium fail 

SRG-OS-999999 1x fail 
The audit system must switch the system to single-user 
mode when available audit storage volume becomes 
dangerously low. 

medium fail 

 4414 

17.3 RSA ADAPTIVE DIRECTORY CENTOS 7 SERVER STIG COMPLIANCE REPORT 4415 

XCCDF Test Result 4416 

Introduction 4417 
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Test Result 4418 

Result ID Profile Start time End time Benchmark Benchmark 
version 

xccdf_org.open-
scap_testresult_default-profile 

(Default 
profile)  

2015-04-08 
08:16  

2015-04-08 
08:17  embedded  1 

Target info 4419 

Targets 
• adaptivedir 

Addresses 
• 127.0.0.1 
• 172.16.4.3 
• 0:0:0:0:0:0:0:1 
• fe80:0:0:0:250:56ff:fe89:8965 

  

Platforms 
• cpe:/o:redhat:enterprise_linux:6 

  

Score 4420 

system score max % bar 
urn:xccdf:scoring:default 96.65 100.00 96.65%  

 Rule Results Summary 17.3.14421 

pass fixed fail error not 
selected 

not 
checked 

not 
applicable informational unknown total 

173  0  6  0  0  0  0  0  0  179  
Title Result 

Auditing must be enabled at boot by setting a kernel parameter.  fail  
The audit system must be configured to audit modifications to the systems Mandatory Access Control 
(MAC) configuration (SELinux).  fail  

The system boot loader configuration file(s) must be owned by root.  fail  
The system boot loader configuration file(s) must be group-owned by root.  fail  
The system boot loader configuration file(s) must have mode 0600 or less permissive.  fail  
The system boot loader must require authentication.  fail  
 4423 

17.4 ALERTENTERPRISE MICROSOFT SERVER STIG COMPLIANCE REPORT 4424 

Non-Compliance Report - U_Windows_2008_R2_MS_V1R15_STIG_SCAP_1-0_Benchmark 4425 

SCAP Compliance Checker - 3.1.2 4426 
Score | System Information | Stream Information | Results | Detailed Results 4427 
Score 4428 

30.04% Adjusted Score: 30.04% 
Original Score: 30.04% 

Compliance Status: RED 
 

 4429 
Pass: 79 Not Applicable: 0 
Fail: 184 Not Checked: 0 

Error: 0 Not Selected: 0 

BLUE: Score equals 100 
GREEN: Score is greater than or equal to 90 

YELLOW: Score is greater than or equal to 80 

http://www.globalsign.com/support/ordering-guides/globalsign-epki-admin-guide.pdf#ruleresult-idp35910864
mailto:support@globalsign.com#ruleresult-idp36284992
mailto:support@globalsign.com#ruleresult-idp36284992
https://www.globalsign.com/en/login/#ruleresult-idp36449680
https://nistgov.sharepoint.com/sites/nccoe/Energy/Shared%20Documents/IdAM%20Practice%20Guide/Drafts/NIST_SP1800-2c_ES_IDAM-HowTo.docx#ruleresult-idp36460368
http://iase.disa.mil/stigs/os/Pages/index.aspx#ruleresult-idp36471056
http://iase.disa.mil/stigs/os/Pages/index.aspx#ruleresult-idp36481744
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Unknown: 0 Total: 263 
 

RED: Score is greater than or equal to 0 
 

System Information 4430 

Target: WIN-IPERGL2ELUD 

Operating System: Windows Server 2008 R2 Standard 

OS Service Pack:   

Results 4431 

• Unsupported Service Packs 4432 
o Systems must be at supported service pack (SP) or release levels. - Fail 4433 

• Legal Notice Display 4434 
o The required legal notice will be configured to display before console logon. - (CCE-10673-2) - Fail 4435 

• Caching of logon credentials 4436 
o Caching of logon credentials will be limited. - (CCE-10926-4) - Fail 4437 

• Anonymous shares are not restricted 4438 
o Anonymous enumeration of shares will be restricted. - (CCE-10557-7) - Fail 4439 

• Bad Logon Attempts 4440 
o The number of allowed bad-logon attempts will meet minimum requirements. - (CCE-11046-0) - Fail 4441 

• Bad Logon Counter Reset 4442 
o The time before the bad-logon counter is reset will meet minimum requirements. - (CCE-11059-3) - Fail 4443 

• Lockout Duration 4444 
o The lockout duration will meet minimum requirements. - (CCE-10399-4) - Fail 4445 

• Rename Built-in Guest Account 4446 
o The built-in guest account will be renamed. - (CCE-10747-4) - Fail 4447 

• Rename Built-in Administrator Account 4448 
o The built-in administrator account will be renamed. - (CCE-10976-9) - Fail 4449 

• LanMan Authentication Level 4450 
o The LanMan authentication level will be set to Send NTLMv2 response only\refuse LM & NTLM. - (CCE-10984-3) 4451 

- Fail 4452 
• Deny Access from the Network 4453 

o The Deny access to this computer from the network user right on member servers must be configured to 4454 
prevent access from highly privileged domain accounts and local administrator accounts on domain systems 4455 
and unauthenticated access on all systems. - (CCE-10733-4) - Fail 4456 

• Smart Card Removal Option  4457 
o The Smart Card removal option will be configured to Force Logoff or Lock Workstation. - (CCE-10573-4) - Fail 4458 

• Format and Eject Removable Media 4459 
o Ejection of removable NTFS media is not restricted to Administrators. - (CCE-10637-7) - Fail 4460 

• Password Expiration Warning 4461 
o Users will be warned in advance that their passwords will expire. - (CCE-10930-6) - Fail 4462 

• Disable Media Autoplay 4463 
o Autoplay will be disabled for all drives. - (CCE-11126-0) - Fail 4464 

• Anonymous Access to Named Pipes 4465 
o Named pipes that can be accessed anonymously will be configured to contain no values. - (CCE-10944-7) - Fail 4466 

• Remote Assistance - Solicit Remote Assistance 4467 
o Solicited Remote Assistance will not be allowed. - (CCE-11723-4) - Fail 4468 

• Undock Without Logging On 4469 
o A system must be logged on to before removing from a docking station. - (CCE-10883-7) - Fail 4470 

• Storage of Passwords and Credentials 4471 
o The system will be configured to prevent the storage of passwords and credentials - (CCE-10292-1) - Fail 4472 

• Force Logoff When Logon Hours Expire 4473 
o The system will be configured to force users to log off when their allowed logon hours expire. - (CCE-10588-2) - 4474 

Fail 4475 
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• Session Security for NTLM SSP Based Clients 4476 
o The system will be configured to meet the minimum session security requirement for NTLM SSP based clients. - 4477 

(CCE-10035-4) - Fail 4478 
• FIPS Compliant Algorithms  4479 

o The system will be configured to use FIPS-compliant algorithms for encryption, hashing, and signing. - (CCE-4480 
10789-6) - Fail 4481 

• TS/RDS - Session Limit 4482 
o Remote Desktop Services will limit users to one remote session. - (CCE-12016-2) - Fail 4483 

• TS/RDS - Password Prompting 4484 
o Remote Desktop Services will always prompt a client for passwords upon connection. - (CCE-11299-5) - Fail 4485 

• TS/RDS - Set Encryption Level 4486 
o Remote Desktop Services will be configured with the client connection encryption set to the required level. - 4487 

(CCE-11677-2) - Fail 4488 
• TS/RDS - Do Not Use Temp Folders 4489 

o Remote Desktop Services will be configured to use session-specific temporary folders. - (CCE-10669-0) - Fail 4490 
• TS/RDS - Delete Temp Folders 4491 

o Remote Desktop Services will delete temporary folders when a session is terminated. - (CCE-12046-9) - Fail 4492 
• TS/RDS - Time Limit for Disc. Session 4493 

o Remote Desktop Services will be configured to set a time limit for disconnected sessions. - (CCE-11117-9) - Fail 4494 
• TS/RDS - Time Limit for Idle Session 4495 

o Remote Desktop Services will be configured to disconnect an idle session after the specified time period. - (CCE-4496 
11506-3) - Fail 4497 

• Remote Assistance - Offer Remote Assistance 4498 
o The system will be configured to prevent unsolicited remote assistance offers. - (CCE-11625-1) - Fail 4499 

• Error Reporting - Report Errors 4500 
o The system will be configured to prevent automatic forwarding of error information. - (CCE-11750-7) - Fail 4501 

• Safe DLL Search Mode 4502 
o The system will be configured to use Safe DLL Search Mode. - (CCE-10772-2) - Fail 4503 

• Media Player - Disable Automatic Updates 4504 
o Media Player must be configured to prevent automatic checking for updates. - (CCE-11298-7) - Fail 4505 

• Session Security for NTLM SSP based Servers 4506 
o The system will be configured to meet the minimum session security requirement for NTLM SSP based servers. - 4507 

(CCE-10040-4) - Fail 4508 
• Audit Log Warning Level 4509 

o The system will generate an audit event when the audit log reaches a percent full threshold. - (CCE-11011-4) - 4510 
Fail 4511 

• Disable IP Source Routing 4512 
o The system will be configured to prevent IP source routing. - (CCE-10732-6) - Fail 4513 

• Disable ICMP Redirect 4514 
o The system will be configured to prevent ICMP redirects from overriding OSPF generated routes. - (CCE-10518-4515 

9) - Fail 4516 
• Disable Router Discovery 4517 

o The system will be configured to disable the Internet Router Discover Protocol (IRDP). - (CCE-10768-0) - Fail 4518 
• TCP Connection Keep-Alive Time 4519 

o The system will be configured to limit how often keep-alive packets are sent. - (CCE-10381-2) - Fail 4520 
• Name-Release Attacks 4521 

o The system will be configured to ignore NetBIOS name release requests except from WINS servers. - (CCE-4522 
10653-4) - Fail 4523 

• TCP Data Retransmissions 4524 
o The system will limit how many times unacknowledged TCP data is retransmitted. - (CCE-10941-3) - Fail 4525 

• Screen Saver Grace Period 4526 
o The system will be configured to have password protection take effect within a limited time frame when the 4527 

screen saver becomes active. - (CCE-10019-8) - Fail 4528 
• Remotely Accessible Registry Paths and Sub-Paths 4529 

o Unauthorized remotely accessible registry paths and sub-paths will not be configured. - (CCE-10935-5) - Fail 4530 
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• Strong Key Protection 4531 
o Users will be required to enter a password to access private keys. - (CCE-11035-3) - Fail 4532 

• Optional Subsystems 4533 
o Optional Subsystems will not be permitted to operate on the system. - (CCE-10913-2) - Fail 4534 

• Software Restriction Policies 4535 
o Software certificate restriction policies will be enforced. - (CCE-10900-9) - Fail 4536 

• TS/RDS - Secure RPC Connection. 4537 
o The Remote Desktop Session Host will require secure RPC communications. - (CCE-11368-8) - Fail 4538 

• Group Policy - Registry Policy Processing 4539 
o Group Policy objects will be reprocessed even if they have not changed. - (CCE-12754-8) - Fail 4540 

• SMB Client Packet Signing (Always) 4541 
o The Windows SMB client will be enabled to always perform SMB packet signing. - (CCE-10970-2) - Fail 4542 

• Minimum Password Length 4543 
o For systems utilizing a logon ID as the individual identifier, passwords will, at a minimum, be 14 characters. - 4544 

(CCE-10372-1) - Fail 4545 
• Display of Last User Name 4546 

o The system will be configured to prevent the display of the last user name on the logon screen. - (CCE-10788-8) 4547 
- Fail 4548 

• Audit Policy Subcategory Setting 4549 
o Audit policy using subcategories will be enabled. - (CCE-10112-1) - Fail 4550 

• IPSec Exemptions 4551 
o IPSec Exemptions will be limited. - (CCE-10018-0) - Fail 4552 

• UAC - Admin Approval Mode 4553 
o User Account Control approval mode for the built-in Administrator will be enabled. - (CCE-11028-8) - Fail 4554 

• UAC - Admin Elevation Prompt 4555 
o User Account Control will, at a minimum, prompt administrators for consent. - (CCE-11023-9) - Fail 4556 

• UAC - User Elevation Prompt 4557 
o User Account Control will automatically deny standard user requests for elevation. - (CCE-10807-6) - Fail 4558 

• Enumerate Administrator Accounts on Elevation 4559 
o The system will require username and password to elevate a running application. - (CCE-11450-4) - Fail 4560 

• TS/RDS - Prevent Password Saving 4561 
o Passwords will not be saved in the Remote Desktop Client. - (CCE-11905-7) - Fail 4562 

• TS/RDS - Drive Redirection 4563 
o Local drives will be prevented from sharing with Remote Desktop Session Hosts (Remote Desktop Services 4564 

Role). - (CCE-11709-3) - Fail 4565 
• RPC - Unauthenticated RPC Clients 4566 

o Unauthenticated RPC clients will be restricted from connecting to the RPC server. - (CCE-10881-1) - Fail 4567 
• RPC - Endpoint Mapper Authentication 4568 

o Client computers will be required to authenticate for RPC communication. - (CCE-10715-1) - Fail 4569 
• Internet Download / Online Ordering 4570 

o Web publishing and online ordering wizards will be prevented from downloading a list of providers. - (CCE-4571 
11136-9) - Fail 4572 

• Printing Over HTTP 4573 
o Printing over HTTP will be prevented. - (CCE-11360-5) - Fail 4574 

• HTTP Printer Drivers 4575 
o Downloading print driver packages over HTTP will be prevented. - (CCE-11563-4) - Fail 4576 

• Windows Update Device Drive Searching 4577 
o Windows will be prevented from using Windows Update to search for drivers. - (CCE-10357-2) - Fail 4578 

• IPv6 Transition 4579 
o IPv6 will be disabled until a deliberate transition strategy has been implemented. - Fail 4580 

• Windows Peer to Peer Networking  4581 
o Windows Peer-to-Peer networking services will be turned off. - (CCE-11604-6) - Fail 4582 

• Prohibit Network Bridge 4583 
o Network Bridges will be prohibited in Windows. - (CCE-12074-1) - Fail 4584 

• Root Certificates Update 4585 



DRAFT 
   

259 | NIST Cybersecurity Practice Guide SP 1800-2c 
 

o Root Certificates will not be updated automatically from the Microsoft site. - (CCE-11264-9) - Fail 4586 
• Event Viewer Events.asp Links 4587 

o Event Viewer Events.asp links will be turned off. - (CCE-10693-0) - Fail 4588 
• Internet File Association Service  4589 

o The Internet File Association service will be turned off. - (CCE-10697-1) - Fail 4590 
• Order Prints Online 4591 

o The Order Prints Online wizard will be turned off. - (CCE-11243-3) - Fail 4592 
• Classic Logon 4593 

o The classic logon screen will be required for user logons. - (CCE-11256-5) - Fail 4594 
• RSS Attachment Downloads 4595 

o Attachments will be prevented from being downloaded from RSS feeds. - Fail 4596 
• Windows Explorer – Shell Protocol Protected Mode  4597 

o Windows Explorer shell protocol will run in protected mode. - (CCE-11530-3) - Fail 4598 
• Windows Installer – IE Security Prompt 4599 

o Users will be notified if a web-based program attempts to install software. - (CCE-10343-2) - Fail 4600 
• Windows Installer – User Control  4601 

o Users will be prevented from changing installation options. - (CCE-10906-6) - Fail 4602 
• Windows Installer – Vendor Signed Updates 4603 

o Non-administrators will be prevented from applying vendor signed updates. - (CCE-11468-6) - Fail 4604 
• Media Player – First Use Dialog Boxes  4605 

o Users will not be presented with Privacy and Installation options on first use of Windows Media Player. - (CCE-4606 
11596-4) - Fail 4607 

• Network – Mapper I/O Driver  4608 
o The Mapper I/O network protocol driver will be disabled. - (CCE-10484-4) - Fail 4609 

• Network – Responder Driver  4610 
o The Responder network protocol driver will be disabled. - (CCE-11304-3) - Fail 4611 

• Network – WCN Wireless Configuration  4612 
o The configuration of wireless devices using Windows Connect Now will be disabled. - (CCE-11242-5) - Fail 4613 

• Network – Windows Connect Now Wizards  4614 
o The Windows Connect Now wizards will be disabled. - (CCE-11155-9) - Fail 4615 

• Device Install – PnP Interface Remote Access  4616 
o Remote access to the Plug and Play interface will be disabled for device installation. - (CCE-11248-2) - Fail 4617 

• Device Install – Drivers System Restore Point 4618 
o A system restore point will be created when a new device driver is installed. - (CCE-10546-0) - Fail 4619 

• Device Install – Generic Driver Error Report 4620 
o An Error Report will not be sent when a generic device driver is installed. - (CCE-12274-7) - Fail 4621 

• Driver Install – Device Driver Search Prompt 4622 
o Users will not be prompted to search Windows Update for device drivers. - (CCE-11319-1) - Fail 4623 

• Handwriting Recognition Error Reporting 4624 
o Errors in handwriting recognition on Tablet PCs will not be reported to Microsoft. - (CCE-11030-4) - Fail 4625 

• Power Mgmt – Password Wake on Battery 4626 
o Users will be prompted for a password on resume from sleep (on battery). (Applicable to Server 2008 R2 if the 4627 

system is configured to sleep.) - (CCE-12088-1) - Fail 4628 
• Power Mgmt – Password Wake When Plugged In 4629 

o The user will be prompted for a password on resume from sleep (Plugged In). (Applicable on Server 2008 R2 if 4630 
the system is configured to sleep.) - (CCE-11651-7) - Fail 4631 

• Remote Assistance – Session Logging 4632 
o Remote Assistance log files will be generated. - (CCE-11263-1) - Fail 4633 

• Game Explorer Information Downloads 4634 
o Game explorer information will not be downloaded from Windows Metadata Services. - (CCE-11739-0) - Fail 4635 

• Error Reporting – Logging  4636 
o Error Reporting events will be logged in the system event log. - (CCE-11621-0) - Fail 4637 

• Error Reporting – Windows Error Reporting 4638 
o Windows Error Reporting to Microsoft will be disabled. - (CCE-11708-5) - Fail 4639 

• Error Reporting – Additional Data 4640 
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o Additional data requests in response to Error Reporting will be declined. - (CCE-11584-0) - Fail 4641 
• Windows Explorer – Heap Termination 4642 

o Windows Explorer heap termination on corruption will be disabled. - (CCE-10981-9) - Fail 4643 
• Logon – Report Logon Server 4644 

o Users will be notified if the logon server was inaccessible and cached credentials were used. - (CCE-12260-6) - 4645 
Fail 4646 

• Media DRM – Internet Access 4647 
o Windows Media Digital Rights Management will be prevented from accessing the Internet. - (CCE-11052-8) - 4648 

Fail 4649 
• TS/RDS – COM Port Redirection 4650 

o The system will be configured to prevent users from mapping local COM ports and redirecting data from the 4651 
Remote Desktop Session Host to local COM ports. (Remote Desktop Services Role) - (CCE-10600-5) - Fail 4652 

• TS/RDS – LPT Port Redirection 4653 
o The system will be configured to prevent users from mapping local LPT ports and redirecting data from the 4654 

Remote Desktop Session Host to local LPT ports. (Remote Desktop Services Role) - (CCE-11623-6) - Fail 4655 
• TS/RDS - PNP Device Redirection 4656 

o The system will be configured to prevent users from redirecting Plug and Play devices to the Remote Desktop 4657 
Session Host. (Remote Desktop Services Role) - (CCE-11128-6) - Fail 4658 

• TS/RDS – Smart Card Device Redirection 4659 
o The system will be configured to ensure smart card devices can be redirected to the Remote Desktop Session. 4660 

(Remote Desktop Services Role) - (CCE-11517-0) - Fail 4661 
• TS/RDS – Printer Redirection 4662 

o The system will be configured to allow only the default client printer to be redirected in the Remote Desktop 4663 
session. (Remote Desktop Services Role) - (CCE-10977-7) - Fail 4664 

• TS/RDS – Remove Disconnect Option  4665 
o The system will be configured to remove the Disconnect option from the Shut Down Windows dialog box on the 4666 

Remote Desktop Client. (Remote Desktop Services Role) - (CCE-11997-4) - Fail 4667 
• Windows Customer Experience Improvement Program  4668 

o The Windows Customer Experience Improvement Program will be disabled. - (CCE-11354-8) - Fail 4669 
• SPN Target Name Validation Level 4670 

o The service principal name (SPN) target name validation level will be turned off. - (CCE-10617-9) - Fail 4671 
• Computer Identity Authentication for NTLM 4672 

o Services using Local System that use negotiate when reverting to NTLM authentication will use the computer 4673 
identity vs. authenticating anonymously. - (CCE-10817-5) - Fail 4674 

• NTLM NULL Session Fallback 4675 
o NTLM will be prevented from falling back to a Null session. - (CCE-10812-6) - Fail 4676 

• PKU2U Online Identities Authentication 4677 
o PKU2U authentication using online identities will be prevented. - (CCE-10839-9) - Fail 4678 

• Kerberos Encryption Types 4679 
o Kerberos encryption types will be configured to prevent the use of DES encryption suites. - (CCE-10843-1) - Fail 4680 

• IPv6 Source Routing 4681 
o IPv6 source routing will be configured to highest protection. - (CCE-10888-6) - Fail 4682 

• IPv6 TCP Data Retransmissions 4683 
o IPv6 TCP data retransmissions will be configured to prevent resources from becoming exhausted. - (CCE-10804-4684 

3) - Fail 4685 
• Elevate when setting a network’s location 4686 

o Domain users will be required to elevate when setting a network’s location. - (CCE-11610-3) - Fail 4687 
• Direct Access – Route Through Internal Network 4688 

o All Direct Access traffic will be routed through the internal network. - (CCE-11300-1) - Fail 4689 
• Windows Update Point and Print Driver Search 4690 

o Windows Update will be prevented from searching for point and print drivers. - (CCE-11976-8) - Fail 4691 
• Prevent device metadata retrieval from Internet 4692 

o Device metadata retrieval from the Internet will be prevented. - (CCE-11589-9) - Fail 4693 
• Prevent Windows Update for device driver search 4694 

o Device driver searches using Windows Update will be prevented. - (CCE-11787-9) - Fail 4695 
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• MSDT Interactive Communication 4696 
o Microsoft Support Diagnostic Tool (MSDT) interactive communication with Microsoft will be prevented. - (CCE-4697 

10855-5) - Fail 4698 
• Windows Online Troubleshooting Service 4699 

o Access to Windows Online Troubleshooting Service (WOTS) will be prevented. - (CCE-11161-7) - Fail 4700 
• Disable PerfTrack 4701 

o Responsiveness events will be prevented from being aggregated and sent to Microsoft. - (CCE-11889-3) - Fail 4702 
• Application Compatibility Program Inventory 4703 

o The Application Compatibility Program Inventory will be prevented from collecting data and sending the 4704 
information to Microsoft. - (CCE-11043-7) - Fail 4705 

• Autoplay for non-volume devices 4706 
o Autoplay will be turned off for non-volume devices. - (CCE-11375-3) - Fail 4707 

• Turn Off Game Updates 4708 
o Downloading of game update information will be turned off. - (CCE-11807-5) - Fail 4709 

• Prevent Joining Homegroup 4710 
o The system will be prevented from joining a homegroup. - (CCE-10691-4) - Fail 4711 

• Windows Anytime Upgrade 4712 
o Windows Anytime Upgrade will be disabled. - (CCE-10544-5) - Fail 4713 

• Explorer Data Execution Prevention 4714 
o Explorer Data Execution Prevention will be enabled. - (CCE-12161-6) - Fail 4715 

• Default Autorun Behavior 4716 
o The default autorun behavior will be configured to prevent autorun commands. - (CCE-11431-4) - Fail 4717 

• Legal Banner Dialog Box Title 4718 
o The Windows dialog box title for the legal banner will be configured. - (CCE-10010-7) - Fail 4719 

• Access this computer from the network 4720 
o Unauthorized accounts will not have the "Access this computer from the network" user right. - (CCE-10086-7) - 4721 

Fail 4722 
• Adjust memory quotas for a process  4723 

o Unauthorized accounts will not have the "Adjust memory quotas for a process" user right. - (CCE-10849-8) - Fail 4724 
• Allow log on locally 4725 

o Unauthorized accounts will not have the "Allow log on locally" user right. - (CCE-10853-0) - Fail 4726 
• Back up files and directories 4727 

o Unauthorized accounts will not have the "Back up files and directories" user right. - (CCE-10880-3) - Fail 4728 
• Bypass traverse checking 4729 

o Unauthorized accounts will not have the "Bypass traverse checking" user right. - (CCE-10369-7) - Fail 4730 
• Change the system time 4731 

o Unauthorized accounts will not have the "Change the system time" user right. - (CCE-10122-0) - Fail 4732 
• Change the time zone 4733 

o Unauthorized accounts will not have the "Change the time zone" user right. - (CCE-10897-7) - Fail 4734 
• Deny log on as a batch job 4735 

o The Deny log on as a batch job user right on member servers must be configured to prevent access from highly 4736 
privileged domain accounts on domain systems and unauthenticated access on all systems. - (CCE-10596-5) - 4737 
Fail 4738 

• Deny log on as service  4739 
o The Deny log on as a service user right on member servers must be configured to prevent access from highly 4740 

privileged domain accounts on domain systems. No other groups or accounts must be assigned this right. - 4741 
(CCE-10226-9) - Fail 4742 

• Deny log on locally 4743 
o The Deny log on locally user right on member servers must be configured to prevent access from highly 4744 

privileged domain accounts on domain systems and unauthenticated access on all systems. - (CCE-10750-8) - 4745 
Fail 4746 

• Deny log on through Remote Desktop \ Terminal Services 4747 
o The Deny log on through Remote Desktop Services user right on member servers must be configured to prevent 4748 

access from highly privileged domain accounts and local administrator accounts on domain systems and 4749 
unauthenticated access on all systems. - (CCE-10878-7) - Fail 4750 
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• Force shutdown from a remote system 4751 
o Unauthorized accounts will not have the "Force shutdown from a remote system" user right. - (CCE-10785-4) - 4752 

Fail 4753 
• Generate security audits 4754 

o Unauthorized accounts will not have the "Generate security audits" user right. - (CCE-10274-9) - Fail 4755 
• Impersonate a client after authentication 4756 

o Unauthorized accounts will not have the "Impersonate a client after authentication" user right. - (CCE-9946-5) - 4757 
Fail 4758 

• Increase a process working set 4759 
o Unauthorized accounts will not have the "Increase a process working set" user right. - (CCE-10548-6) - Fail 4760 

• Load and unload device drivers 4761 
o Unauthorized accounts will not have the "Load and unload device drivers" user right. - (CCE-10202-0) - Fail 4762 

• Log on as a batch job 4763 
o Unauthorized accounts will not have the "Log on as a batch job" user right. - (CCE-10549-4) - Fail 4764 

• Replace a process level token 4765 
o Unauthorized accounts will not have the "Replace a process level token" user right. - (CCE-10599-9) - Fail 4766 

• Restore files and directories 4767 
o Unauthorized accounts will not have the "Restore files and directories" user right. - (CCE-10805-0) - Fail 4768 

• Shut down the system 4769 
o Unauthorized accounts will not have the "Shut down the system" user right. - (CCE-10439-8) - Fail 4770 

• Audit - Credential Validation - Failure 4771 
o The system will be configured to audit "Account Logon > Credential Validation" failures. - Fail 4772 

• Audit - Computer Account Management - Failure 4773 
o The system will be configured to audit "Account Management > Computer Account Management" failures. - Fail 4774 

• Audit - Other Account Management Events - Success 4775 
o The system will be configured to audit "Account Management > Other Account Management Events" successes. 4776 

- Fail 4777 
• Audit - Other Account Management Events - Failure 4778 

o The system will be configured to audit "Account Management > Other Account Management Events" failures. - 4779 
Fail 4780 

• Audit - Security Group Management - Failure 4781 
o The system will be configured to audit "Account Management > Security Group Management" failures. - Fail 4782 

• Audit - User Account Management - Success 4783 
• Audit - User Account Management - Failure 4784 

o The system will be configured to audit "Account Management > User Account Management" failures. - Fail 4785 
• Audit - Process Creation - Success 4786 

o The system will be configured to audit "Detailed Tracking > Process Creation" successes. - Fail 4787 
• Audit - File System - Failure 4788 

o The system will be configured to audit "Object Access > File System" failures. - Fail 4789 
• Audit - Registry - Failure 4790 

o The system will be configured to audit "Object Access > Registry" failures. - Fail 4791 
• Audit - Audit Policy Change - Failure 4792 

o The system will be configured to audit "Policy Change > Audit Policy Change" failures. - Fail 4793 
• Audit - Sensitive Privilege Use - Success 4794 

o The system will be configured to audit "Privilege Use > Sensitive Privilege Use" successes. - Fail 4795 
• Audit - Sensitive Privilege Use - Failure 4796 

o The system will be configured to audit "Privilege Use > Sensitive Privilege Use" failures. - Fail 4797 
• Audit - IPSec Driver - Success 4798 

o The system will be configured to audit "System > IPSec Driver" successes. - Fail 4799 
• Audit - IPSec Driver - Failure 4800 

o The system will be configured to audit "System > IPSec Driver" failures. - Fail 4801 
• Audit - Security State Change - Failure 4802 

o The system will be configured to audit "System > Security State Change" failures. - Fail 4803 
• Audit - Security System Extension - Success 4804 

o The system will be configured to audit "System > Security System Extension" successes. - Fail 4805 
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• Audit - Security System Extension - Failure 4806 
o The system will be configured to audit "System > Security System Extension" failures. - Fail 4807 

• 6to4 State 4808 
o The 6to4 IPv6 transition technology will be disabled. - (CCE-11356-3) - Fail 4809 

• IP-HTTPS State 4810 
o The IP-HTTPS IPv6 transition technology will be disabled. - (CCE-10832-4) - Fail 4811 

• ISATAP State 4812 
o The ISATAP IPv6 transition technology will be disabled. - (CCE-11141-9) - Fail 4813 

• Teredo State 4814 
o The Teredo IPv6 transition technology will be disabled. - (CCE-11865-3) - Fail 4815 

• Maximum Log Size - Application 4816 
o The Application event log will be configured to a minimum size requirement. - (CCE-11143-5) - Fail 4817 

• Maximum Log Size - Security 4818 
o The Security event log will be configured to a minimum size requirement. - (CCE-11033-8) - Fail 4819 

• Maximum Log Size - Setup 4820 
o The Setup event log will be configured to a minimum size requirement. - (CCE-11717-6) - Fail 4821 

• Maximum Log Size - System 4822 
o The System event log will be configured to a minimum size requirement. - (CCE-11174-0) - Fail 4823 

• Device Install Software Request Error Report 4824 
o Windows will be prevented from sending an error report when a device driver requests additional software 4825 

during installation. - (CCE-11336-5) - Fail 4826 
• Always Install with Elevated Privileges Disabled 4827 

o The Windows Installer Always install with elevated privileges must be disabled. - (CCE-12401-6) - Fail 4828 
• Local admin accounts filtered token policy enabled on domain systems. 4829 

o Local administrator accounts must have their privileged token filtered to prevent elevated privileges from being 4830 
used over the network on domain systems. - Fail 4831 

• WINCC-000078 4832 
o The Enhanced Mitigation Experience Toolkit (EMET) system-wide Address Space Layout Randomization (ASLR) 4833 

must be enabled and configured to Application Opt In. - Fail 4834 
• WINCC-000079 4835 

o The Enhanced Mitigation Experience Toolkit (EMET) Default Protections for Internet Explorer must be enabled. - 4836 
Fail 4837 

• WINCC-000080 4838 
o The Enhanced Mitigation Experience Toolkit (EMET) Default Protections for Recommended Software must be 4839 

enabled. - Fail 4840 
• WINCC-000081 4841 

o The Enhanced Mitigation Experience Toolkit (EMET) Default Protections for Popular Software must be enabled. 4842 
- Fail 4843 

• WINCC-000082 4844 
o The Enhanced Mitigation Experience Toolkit (EMET) system-wide Data Execution Prevention (DEP) must be 4845 

enabled and configured to at least Application Opt Out. - Fail 4846 
• WINCC-000083 4847 

o The Enhanced Mitigation Experience Toolkit (EMET) system-wide Structured Exception Handler Overwrite 4848 
Protection (SEHOP) must be configured to Application Opt Out. - Fail 4849 

• WINGE-000100 4850 
o The Enhanced Mitigation Experience Toolkit (EMET) V4.1 Update 1 or later must be installed on the system. - 4851 

Fail 4852 
• WINGE-000200 4853 

o A group named DenyNetworkAccess must be defined on domain systems to include all local administrator 4854 
accounts. - Fail 4855 

 4856 
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17.5 IT DOMAIN CONTROLLER STIG COMPLIANCE REPORT 4857 

Non-Compliance Report - U_Windows2012_DC_V1R3_STIG_SCAP_1-1_Benchmark 4858 

SCAP Compliance Checker - 3.1.2 4859 
Score | System Information | Stream Information | Results | Detailed Results 4860 
Score 4861 

91.13% Adjusted Score: 91.13% 
Original Score: 91.13% 

Compliance Status: GREEN 
 

 4862 
Pass: 267 Not Applicable: 0 
Fail: 26 Not Checked: 0 

Error: 0 Not Selected: 0 
Unknown: 0 Total: 293 

 

BLUE: Score equals 100 
GREEN: Score is greater than or equal to 90 

YELLOW: Score is greater than or equal to 80 
RED: Score is greater than or equal to 0 

 

System Information 4863 

Target: ITDC 

Operating System: Windows Server 2012 R2 Standard 

OS Service Pack:   

Domain: ES-IDAM-B1 

Results 4864 

• Bad Logon Attempts 4865 
o The number of allowed bad logon attempts must meet minimum requirements. - (CCE-23909-5) - Fail 4866 

• Force Logoff When Logon Hours Expire 4867 
o The system must be configured to force users to log off when their allowed logon hours expire. - (CCE-25367-4) 4868 

- Fail 4869 
• LDAP Signing Requirements 4870 

o Domain controllers must require LDAP access signing. - (CCE-23587-9) - Fail 4871 
• Computer Account Password Change 4872 

o Domain controllers must be configured to allow reset of machine account passwords. - (CCE-24692-6) 4873 
- Fail 4874 

• Remotely Accessible Registry Paths and Sub-Paths 4875 
o Unauthorized remotely accessible registry paths and sub-paths must not be configured. - (CCE-25426-8) - Fail 4876 

• Minimum Password Length 4877 
o Passwords must, at a minimum, be 14 characters. - (CCE-25317-9) - Fail 4878 

• Media DRM – Internet Access 4879 
• Software Certificate Installation Files 4880 

o Software certificate installation files must be removed from a system. - Fail 4881 
• Legal Banner Dialog Box Title 4882 

o The Windows dialog box title for the legal banner must be configured. - (CCE-24020-0) - Fail 4883 
• Access this computer from the network 4884 

o Unauthorized accounts must not have the Access this computer from the network user right on domain 4885 
controllers. - Fail 4886 

• Allow log on locally 4887 
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o Unauthorized accounts must not have the Allow log on locally user right. - (CCE-25228-8) - Fail 4888 
• Back up files and directories 4889 

o Unauthorized accounts must not have the Back up files and directories user right. - (CCE-25380-7) - Fail 4890 
• Bypass traverse checking 4891 

o Unauthorized accounts must not have the Bypass traverse checking user right. - (CCE-25271-8) - Fail 4892 
• Change the system time 4893 

o Unauthorized accounts must not have the Change the system time user right. - (CCE-24185-1) - Fail 4894 
• Change the time zone 4895 

o Unauthorized accounts must not have the Change the time zone user right. - (CCE-24632-2) - Fail 4896 
• Force shutdown from a remote system 4897 

o Unauthorized accounts must not have the Force shutdown from a remote system user right. - (CCE-24734-6) - 4898 
Fail 4899 

• Increase a process working set 4900 
o Unauthorized accounts must not have the Increase a process working set user right. - (CCE-24162-0) - Fail 4901 

• Increase scheduling priority 4902 
• Load and unload device drivers 4903 

o Unauthorized accounts must not have the Load and unload device drivers user right. - (CCE-24779-1) - Fail 4904 
• Log on as a batch job 4905 

o Unauthorized accounts must not have the Log on as a batch job user right. - (CCE-23386-6) - Fail 4906 
• Restore files and directories 4907 

o Unauthorized accounts must not have the Restore files and directories user right. - (CCE-25518-2) - Fail 4908 
• Shut down the system 4909 

o Unauthorized accounts must not have the Shut down the system user right. - (CCE-23500-2) - Fail 4910 
• Add workstations to domain 4911 

o Unauthorized accounts must not have the Add workstations to domain user right. - (CCE-23271-0) - Fail 4912 
• Audit Directory Service Access - Success 4913 

o The system must be configured to audit DS Access - Directory Service Access successes. - Fail 4914 
• Audit - Directory Service Access - Failure 4915 

o The system must be configured to audit DS Access - Directory Service Access failures. - Fail 4916 
• Audit - Directory Service Changes - Success 4917 

o The system must be configured to audit DS Access - Directory Service Changes successes. - Fail 4918 
• Audit - Directory Service Changes - Failure 4919 

o The system must be configured to audit DS Access - Directory Service Changes failures. - Fail 4920 
• WINGE-000100 4921 

o The Enhanced Mitigation Experience Toolkit (EMET) V4.1 Update 1 or later must be installed on the system. - 4922 
Fail 4923 

 4924 

17.6 IT WINDOWS 7 WORKSTATIONS STIG COMPLIANCE REPORT 4925 

Non-Compliance Report - U_Windows_7_V1R23_STIG_SCAP_1-0_Benchmark 4926 

SCAP Compliance Checker - 3.1.2 4927 
Score | System Information | Stream Information | Results | Detailed Results 4928 
Score 4929 

94.72% Adjusted Score: 94.72% 
Original Score: 94.72% 

Compliance Status: GREEN 
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 4930 
Pass: 251 Not Applicable: 0 
Fail: 14 Not Checked: 0 

Error: 0 Not Selected: 0 
Unknown: 0 Total: 265 

 

BLUE: Score equals 100 
GREEN: Score is greater than or equal to 90 

YELLOW: Score is greater than or equal to 80 
RED: Score is greater than or equal to 0 

 

System Information 4931 

Target: ITWORKS1 

Operating System: Windows 7 Enterprise 

OS Service Pack: Service Pack 1 

Domain: ES-IDAM-B1 

Processor: Intel(R) Xeon(R) CPU E5-2660 0 @ 2.20GHz 

Processor Architecture: Intel64 Family 6 Model 45 Stepping 7 

Processor Speed: 2200 MHz 

Physical Memory: 6144 mb 

Manufacturer: VMware, Inc. 

Model: VMware Virtual Platform 

Serial Number: VMware-42 09 b3 57 32 50 16 c6-cb 47 45 dd e3 a9 68 f1 

BIOS Version: 6.00 

Interfaces: • [00000007] Intel(R) PRO/1000 MT Network Connection 
o 172.16.5.6 
o 00:50:56:89:A2:29 

Results 4932 

• Legal Notice Display 4933 
o The required legal notice must be configured to display before console logon. - (CCE-8973-0) - Fail 4934 

• Bad Logon Attempts 4935 
o Number of allowed bad-logon attempts does not meet minimum requirements. - (CCE-9136-3) - Fail 4936 

• Secure Print Driver Installation 4937 
o Print driver installation privilege is not restricted to administrators. - (CCE-9026-6) - Fail 4938 

• Deny Access from the Network 4939 
o The Deny access to this computer from the network user right on workstations must be configured to prevent 4940 

access from highly privileged domain accounts and local administrator accounts on domain systems and 4941 
unauthenticated access on all systems. - (CCE-9244-5) - Fail 4942 

• Force Logoff When Logon Hours Expire 4943 
o The system is not configured to force users to log off when their allowed logon hours expire. - (CCE-9704-8) - 4944 

Fail 4945 
• Minimum Password Length 4946 

o For systems utilizing a logon ID as the individual identifier, passwords must be a minimum of 14 characters in 4947 
length. - (CCE-9357-5) - Fail 4948 

• TS/RDS - Remote User Connections 4949 
o Terminal Services / Remote Desktop Services - Prevent users from connecting using Terminal Services or 4950 

Remote Desktop. - (CCE-9985-3) - Fail 4951 
• Unnecessary Features Installed 4952 

o Unnecessary features are installed. - Fail 4953 
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• Deny log on as a batch job 4954 
o The Deny log on as a batch job user right on workstations must be configured to prevent access from highly 4955 

privileged domain accounts on domain systems and unauthenticated access on all systems. - (CCE-9212-2) - Fail 4956 
• Deny log on as service  4957 

o The Deny log on as a service user right on workstations must be configured to prevent access from highly 4958 
privileged domain accounts on domain systems. No other groups or accounts must be assigned this right. - 4959 
(CCE-9098-5) - Fail 4960 

• Deny log on locally 4961 
o The Deny log on locally user right on workstations must be configured to prevent access from highly privileged 4962 

domain accounts on domain systems and unauthenticated access on all systems. - (CCE-9239-5) - Fail 4963 
• Deny log on through Remote Desktop \ Terminal Services 4964 

o The Deny log on through Remote Desktop Services user right on workstations must prevent all access if RDS is 4965 
not used by the organization. If RDS is used, it must be configured to prevent access from highly privileged 4966 
domain accounts and local administrator accounts on domain systems and unauthenticated access on all 4967 
systems. - (CCE-9274-2) - Fail 4968 

• Enable accounts to be trusted for delegation 4969 
• WINGE-000100 4970 

o The Enhanced Mitigation Experience Toolkit (EMET) V4.1 Update 1 or later must be installed on the system. - 4971 
Fail 4972 

• WINGE-000200 4973 
o A group named DenyNetworkAccess must be defined on domain systems to include all local administrator 4974 

accounts. - Fail 4975 

 4976 

17.7 OZONE AUTHORITY AND OZONE SERVER CENTOS 6 SERVER STIG COMPLIANCE REPORT 4977 

XCCDF Test Result 4978 

 Introduction 17.7.14979 
Test Result 4980 

Result ID Profile Start time End time Benchmark Benchmark 
version 

xccdf_org.open-
scap_testresult_default-profile 

(Default 
profile)  

2015-04-08 
07:58  

2015-04-08 
07:59  embedded  1 

Target info 4981 

Targets 
• localhost.localdomain 

Addresses 
• 127.0.0.1 
• 172.16.4.11 
• 0:0:0:0:0:0:0:1 
• fe80:0:0:0:250:56ff:fe89:76dd 

  

Platforms 
• cpe:/o:redhat:enterprise_linu  

  

Score 4982 

system score max % bar 
urn:xccdf:scoring:default 95.53 100.00 95.53%  

 Rule Results Summary 17.7.24983 

pass fixed fail error not 
selected 

not 
checked 

not 
applicable informational unknown total 

171  0  8  0  0  0  0  0  0  179  
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Title Result 
Auditing must be enabled at boot by setting a kernel parameter.  fail  
Library files must be owned by root.  fail  
The audit system must be configured to audit modifications to the systems Mandatory Access Control 
(MAC) configuration (SELinux).  fail  

The system boot loader configuration file(s) must be owned by root.  fail  
The system boot loader configuration file(s) must be group-owned by root.  fail  
The system boot loader configuration file(s) must have mode 0600 or less permissive.  fail  
The system boot loader must require authentication.  fail  
The system must provide VPN connectivity for communications over untrusted networks.  fail  
 4985 

17.8 OZONE ENVOY CENTOS 6 SERVER STIG COMPLIANCE REPORT 4986 

XCCDF Test Result 4987 

 Introduction 17.8.14988 
Test Result 4989 

Result ID Profile Start time End time Benchmark Benchmark 
version 

xccdf_org.open-
scap_testresult_default-profile 

(Default 
profile)  

2015-04-08 
08:02  

2015-04-08 
08:03  embedded  1 

Target info 4990 

Targets 
• localhost.localdomain 

Addresses 
• 127.0.0.1 
• 172.16.4.12 
• 0:0:0:0:0:0:0:1 
• fe80:0:0:0:250:56ff:fe89:980a 

  

Platforms 
• cpe:/o:redhat:enterprise_linu  

  

Score 4991 

system score max % bar 
urn:xccdf:scoring:default 96.09 100.00 96.09%  

 Rule Results Summary 17.8.24992 

pass fixed fail error not 
selected 

not 
checked 

not 
applicable informational unknown total 

172  0  7  0  0  0  0  0  0  179  
Title Result 

Auditing must be enabled at boot by setting a kernel parameter.  fail  
The audit system must be configured to audit modifications to the systems Mandatory Access Control 
(MAC) configuration (SELinux).  fail  

The system boot loader configuration file(s) must be owned by root.  fail  
The system boot loader configuration file(s) must be group-owned by root.  fail  
The system boot loader configuration file(s) must have mode 0600 or less permissive.  fail  
The system boot loader must require authentication.  fail  
The system must provide VPN connectivity for communications over untrusted networks.  fail  
 4994 
 4995 

http://172.16.33.88:9080/AlertEnterprise/#ruleresult-idp59061600
http://172.16.33.88:9080/AlertEnterprise/#ruleresult-idp59061600
https://www.globalsign.com/en/login#ruleresult-idp59247648
http://www.globalsign.com/repository/#ruleresult-idp59258336
http://iase.disa.mil/stigs/os/Pages/index.aspx#ruleresult-idp59589392
http://nccoe.nist.gov/#ruleresult-idp44525104
http://www.globalsign.com/support/ordering-guides/epki-authentication-user-guide.pdf#ruleresult-idp44899232
http://www.globalsign.com/support/ordering-guides/epki-authentication-user-guide.pdf#ruleresult-idp44899232
http://www.cisco.com/c/en/us/td/docs/security/ise/1-4/installation_guide/b_ise_InstallationGuide14/b_ise_InstallationGuide14_chapter_0100.html#ruleresult-idp45063904
https://support.ca.com/#ruleresult-idp45074592
https://access.redhat.com/documentation/en-US/JBoss_Enterprise_Application_Platform/6.3/html/Installation_Guide/Install_JBoss_Enterprise_Application_Platform_6_Microsoft_Windows_Service.html#ruleresult-idp45085280
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17.9 OT DOMAIN CONTROLLER STIG COMPLIANCE REPORT 4996 

Non-Compliance Report - U_Windows2012_DC_V1R3_STIG_SCAP_1-1_Benchmark 4997 

SCAP Compliance Checker - 3.1.2 4998 
Score | System Information | Stream Information | Results | Detailed Results 4999 
Score 5000 

91.13% Adjusted Score: 91.13% 
Original Score: 91.13% 

Compliance Status: GREEN 
 

 5001 
Pass: 267 Not Applicable: 0 
Fail: 26 Not Checked: 0 

Error: 0 Not Selected: 0 
Unknown: 0 Total: 293 

 

BLUE: Score equals 100 
GREEN: Score is greater than or equal to 90 

YELLOW: Score is greater than or equal to 80 
RED: Score is greater than or equal to 0 

 

System Information 5002 

Target: OTDC 

Operating System: Windows Server 2012 R2 Standard 

OS Service Pack:   

Domain: OT-ES-IDAM-B1 

Results 5003 

• Bad Logon Attempts 5004 
o The number of allowed bad logon attempts must meet minimum requirements. - (CCE-23909-5) - Fail 5005 
• B 5006 

• Force Logoff When Logon Hours Expire 5007 
o The system must be configured to force users to log off when their allowed logon hours expire. - (CCE-25367-4) 5008 

- Fail 5009 
• LDAP Signing Requirements 5010 

o Domain controllers must require LDAP access signing. - (CCE-23587-9) - Fail 5011 
• Computer Account Password Change 5012 

o Domain controllers must be configured to allow reset of machine account passwords. - (CCE-24692-6) - Fail 5013 
• Remotely Accessible Registry Paths and Sub-Paths 5014 

o Unauthorized remotely accessible registry paths and sub-paths must not be configured. - (CCE-25426-8) - Fail 5015 
• Minimum Password Length 5016 

o Passwords must, at a minimum, be 14 characters. - (CCE-25317-9) - Fail 5017 
• Software Certificate Installation Files 5018 

o Software certificate installation files must be removed from a system. - Fail 5019 
• Legal Banner Dialog Box Title 5020 

o The Windows dialog box title for the legal banner must be configured. - (CCE-24020-0) - Fail 5021 
• Access this computer from the network 5022 

o Unauthorized accounts must not have the Access this computer from the network user right on domain 5023 
controllers. - Fail 5024 

• Adjust memory quotas for a process  5025 
• Allow log on locally 5026 
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o Unauthorized accounts must not have the Allow log on locally user right. - (CCE-25228-8) - Fail 5027 
• Allow log on through Remote Desktop Services 5028 
• Back up files and directories 5029 

o Unauthorized accounts must not have the Back up files and directories user right. - (CCE-25380-7) - Fail 5030 
• Bypass traverse checking 5031 

o Unauthorized accounts must not have the Bypass traverse checking user right. - (CCE-25271-8) - Fail 5032 
• Change the system time 5033 

o Unauthorized accounts must not have the Change the system time user right. - (CCE-24185-1) - Fail 5034 
• Change the time zone 5035 

o Unauthorized accounts must not have the Change the time zone user right. - (CCE-24632-2) - Fail 5036 
• Force shutdown from a remote system 5037 

o Unauthorized accounts must not have the Force shutdown from a remote system user right. - (CCE-24734-6) - 5038 
Fail 5039 

• Increase a process working set 5040 
o Unauthorized accounts must not have the Increase a process working set user right. - (CCE-24162-0) - Fail 5041 

• Load and unload device drivers 5042 
o Unauthorized accounts must not have the Load and unload device drivers user right. - (CCE-24779-1) - Fail 5043 

• Log on as a batch job 5044 
o Unauthorized accounts must not have the Log on as a batch job user right. - (CCE-23386-6) - Fail 5045 

• Restore files and directories 5046 
o Unauthorized accounts must not have the Restore files and directories user right. - (CCE-25518-2) - Fail 5047 

• Shut down the system 5048 
o Unauthorized accounts must not have the Shut down the system user right. - (CCE-23500-2) - Fail 5049 

• Add workstations to domain 5050 
o Unauthorized accounts must not have the Add workstations to domain user right. - (CCE-23271-0) - Fail 5051 

• Audit Directory Service Access - Success 5052 
o The system must be configured to audit DS Access - Directory Service Access successes. - Fail 5053 

• Audit - Directory Service Access - Failure 5054 
o The system must be configured to audit DS Access - Directory Service Access failures. - Fail 5055 

• Audit - Directory Service Changes - Success 5056 
o The system must be configured to audit DS Access - Directory Service Changes successes. - Fail 5057 

• Audit - Directory Service Changes - Failure 5058 
o The system must be configured to audit DS Access - Directory Service Changes failures. - Fail 5059 

• WINGE-000100 5060 
o The Enhanced Mitigation Experience Toolkit (EMET) V4.1 Update 1 or later must be installed on the system. - 5061 

Fail 5062 

17.10  OT CONSOLEWORKS WINDOWS SERVER 2012 STIG COMPLIANCE REPORT 5063 

Non-Compliance Report - U_Windows2012_MS_V1R3_STIG_SCAP_1-1_Benchmark 5064 

SCAP Compliance Checker - 3.1.2 5065 
Score | System Information | Stream Information | Results | Detailed Results 5066 
Score 5067 

97.13% Adjusted Score: 97.13% 
Original Score: 97.13% 

Compliance Status: GREEN 
 

 5068 
Pass: 271 Not Applicable: 0 
Fail: 8 Not Checked: 0 

BLUE: Score equals 100 
GREEN: Score is greater than or equal to 90 
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Error: 0 Not Selected: 0 
Unknown: 0 Total: 279 

 

YELLOW: Score is greater than or equal to 80 
RED: Score is greater than or equal to 0 

 

System Information 5069 

Target: OT-CONSOLEWORKS 

Operating System: Windows Server 2012 R2 Standard 

OS Service Pack:   

Domain: OT-ES-IDAM-B1 

Processor: Intel(R) Xeon(R) CPU E5-2660 0 @ 2.20GHz 

Processor Architecture: Intel64 Family 6 Model 45 Stepping 7 

Processor Speed: 2200 MHz 

Physical Memory: 8192 mb 

Manufacturer: VMware, Inc. 

Model: VMware Virtual Platform 

Serial Number: VMware-42 09 c2 cc c1 37 31 5c-2d 94 63 96 80 d2 05 fe 

BIOS Version: 6.00 

Interfaces: • [00000010] Intel(R) 82574L Gigabit Network Connection 
o 172.16.6.8 
o 00:50:56:89:56:86 

Results 5070 

• Bad Logon Attempts 5071 
o The number of allowed bad logon attempts must meet minimum requirements. - (CCE-23909-5) - Fail 5072 

• Force Logoff When Logon Hours Expire 5073 
o The system must be configured to force users to log off when their allowed logon hours expire. - (CCE-25367-4) 5074 

- Fail 5075 
• Minimum Password Length 5076 

o Passwords must, at a minimum, be 14 characters. - (CCE-25317-9) - Fail 5077 
• Legal Banner Dialog Box Title 5078 

o The Windows dialog box title for the legal banner must be configured. - (CCE-24020-0) - Fail 5079 
• Deny log on as a batch job 5080 

o The Deny log on as a batch job user right on member servers must be configured to prevent access from highly 5081 
privileged domain accounts on domain systems, and from unauthenticated access on all systems. - (CCE-25215-5082 
5) - Fail 5083 

• Deny log on as service  5084 
o The Deny log on as a service user right on member servers must be configured to prevent access from highly 5085 

privileged domain accounts on domain systems. No other groups or accounts must be assigned this right. - 5086 
(CCE-23117-5) - Fail 5087 

• Deny log on locally 5088 
o The Deny log on locally user right on member servers must be configured to prevent access from highly 5089 

privileged domain accounts on domain systems, and from unauthenticated access on all systems. - (CCE-24460-5090 
8) - Fail 5091 

• WINGE-000100 5092 
o The Enhanced Mitigation Experience Toolkit (EMET) V4.1 Update 1 or later must be installed on the system. - 5093 

Fail 5094 



DRAFT 
   

272 | NIST Cybersecurity Practice Guide SP 1800-2c 
 

17.11 OT WINDOWS 7 WORKSTATIONS STIG COMPLIANCE REPORT 5095 

Non-Compliance Report - U_Windows_7_V1R23_STIG_SCAP_1-0_Benchmark 5096 

SCAP Compliance Checker - 3.1.2 5097 
Score | System Information | Stream Information | Results | Detailed Results 5098 
Score 5099 

95.47% Adjusted Score: 95.47% 
Original Score: 95.47% 

Compliance Status: GREEN 
 

 5100 
Pass: 253 Not Applicable: 0 
Fail: 12 Not Checked: 0 

Error: 0 Not Selected: 0 
Unknown: 0 Total: 265 

 

BLUE: Score equals 100 
GREEN: Score is greater than or equal to 90 

YELLOW: Score is greater than or equal to 80 
RED: Score is greater than or equal to 0 

 

System Information 5101 

Target: OTWORKS1 

Operating System: Windows 7 Enterprise 

OS Service Pack: Service Pack 1 

Domain: OT-ES-IDAM-B1 

Processor: Intel(R) Xeon(R) CPU E5-2660 0 @ 2.20GHz 

Processor Architecture: Intel64 Family 6 Model 45 Stepping 7 

Processor Speed: 2200 MHz 

Physical Memory: 4096 mb 

Manufacturer: VMware, Inc. 

Model: VMware Virtual Platform 

Serial Number: VMware-42 09 49 1e 0a 42 38 8e-03 d2 8f e6 31 25 5a 63 

BIOS Version: 6.00 

Interfaces: • [00000007] Intel(R) PRO/1000 MT Network Connection 
o 172.16.6.6 
o 00:50:56:89:0B:7A 

Results 5102 

• Legal Notice Display 5103 
o The required legal notice must be configured to display before console logon. - (CCE-8973-0) - Fail 5104 

• Bad Logon Attempts 5105 
o Number of allowed bad-logon attempts does not meet minimum requirements. - (CCE-9136-3) - Fail 5106 

• Secure Print Driver Installation 5107 



DRAFT 
   

273 | NIST Cybersecurity Practice Guide SP 1800-2c 
 

o Print driver installation privilege is not restricted to administrators. - (CCE-9026-6) - Fail 5108 
• Deny Access from the Network 5109 

o The Deny access to this computer from the network user right on workstations must be configured to prevent 5110 
access from highly privileged domain accounts and local administrator accounts on domain systems and 5111 
unauthenticated access on all systems. - (CCE-9244-5) - Fail 5112 

• Force Logoff When Logon Hours Expire 5113 
o The system is not configured to force users to log off when their allowed logon hours expire. - (CCE-9704-8) - 5114 

Fail 5115 
• Minimum Password Length 5116 

o For systems utilizing a logon ID as the individual identifier, passwords must be a minimum of 14 characters in 5117 
length. - (CCE-9357-5) - Fail 5118 

• Deny log on as a batch job 5119 
o The Deny log on as a batch job user right on workstations must be configured to prevent access from highly 5120 

privileged domain accounts on domain systems and unauthenticated access on all systems. - (CCE-9212-2) - Fail 5121 
• Deny log on as service  5122 

o The Deny log on as a service user right on workstations must be configured to prevent access from highly 5123 
privileged domain accounts on domain systems. No other groups or accounts must be assigned this right. - 5124 
(CCE-9098-5) - Fail 5125 

• Deny log on locally 5126 
o The Deny log on locally user right on workstations must be configured to prevent access from highly privileged 5127 

domain accounts on domain systems and unauthenticated access on all systems. - (CCE-9239-5) - Fail 5128 
• Deny log on through Remote Desktop \ Terminal Services 5129 

o The Deny log on through Remote Desktop Services user right on workstations must prevent all access if RDS is 5130 
not used by the organization. If RDS is used, it must be configured to prevent access from highly privileged 5131 
domain accounts and local administrator accounts on domain systems and unauthenticated access on all 5132 
systems. - (CCE-9274-2) - Fail 5133 

• WINGE-000100 5134 
o The Enhanced Mitigation Experience Toolkit (EMET) V4.1 Update 1 or later must be installed on the system. - 5135 

Fail 5136 
• WINGE-000200 5137 

o A group named DenyNetworkAccess must be defined on domain systems to include all local administrator 5138 
accounts. - Fail 5139 

17.12 PACS DOMAIN CONTROLLER STIG COMPLIANCE REPORT 5140 

All Settings Report - U_Windows2012_DC_V1R3_STIG_SCAP_11_Benchmark 

SCAP Compliance Checker - 3.1.2 

Score | System Information | Stream Information | Results | Detailed Results 
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 Error: 0 Not Selected: 0 YELLOW: Score is greater than or equal to 80 

 Unknown: 0 Total: 293 RED: Score is greater than or equal to 0 

System Information 

 

Target: PACSDC 

Operating System: Windows Server 2012 R2 Standard 

OS Service Pack:   

Domain: PACS-ES-IDAM-B1 

Stream Information 

 

 Release Info  Release: 3 Benchmark Date: 28 Oct 2014  

 Stream: U_Windows2012_DC_V1R3_STIG_SCAP_1-1_Benchmark  

Title: Windows Server 2012 / 2012 R2 Domain Controller Security Technical Implementation Guide 

Description: The Windows Server 2012 / 2012 R2 Domain Controller Security Technical Implementation Guide (STIG) is published as a 
tool to improve the security of Department of Defense (DoD) information systems. Comments or proposed revisions to this 
document should be sent via e-mail to the following address: 
disa.letterkenny.FSO.mbx.stig-customer-support-mailbox@mail.mil. 

Notice: Developed_by_DISA_for_the_DoD 

Target 
Platforms: 

 cpe:/o:microsoft:windows_server_2012:- 

Identity 
Authenticated: 

true 

 5141 
Detailed Results 5142 

1. Bad Logon Attempts - The number of allowed bad logon attempts must meet minimum requirements. - (CCE-23909-5) - Fail 5143 

Score 

91.47 % 

Adjusted Score: 91.47 % 
Original Score: 91.47 % 

Compliance Status: GREEN 

Pass: 268 Not Applicable: 0 
Fail: 25 Not Checked: 0 BLUE: Score equals 100 

GREEN: Score is greater than or equal to 90 
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2. Force Logoff When Logon Hours Expire - The system must be configured to force users to log off when their allowed logon hours 5144 
expire. - (CCE-25367-4) - Fail 5145 

3. LDAP Signing Requirements - Domain controllers must require LDAP access signing. - (CCE-23587-9) - Fail 5146 
4. Computer Account Password Change - Domain controllers must be configured to allow reset of machine account passwords. - 5147 

(CCE-24692-6) - Fail 5148 
5. Remotely Accessible Registry Paths and Sub-Paths - Unauthorized remotely accessible registry paths and sub-paths must not be 5149 

configured. - (CCE-25426-8) - Fail 5150 
6. Minimum Password Length - Passwords must, at a minimum, be 14 characters. - (CCE-25317-9) - Fail 5151 
7. Legal Banner Dialog Box Title - The Windows dialog box title for the legal banner must be configured. - (CCE-24020-0) - Fail 5152 
8. Access this computer from the network - Unauthorized accounts must not have the Access this computer from the network user 5153 

right on domain controllers. - Fail 5154 
9. Allow log on locally - Unauthorized accounts must not have the Allow log on locally user right. - (CCE-25228-8) - Fail 5155 
10. Back up files and directories - Unauthorized accounts must not have the Back up files and directories user right. - (CCE-25380-7) - Fail 5156 
11. Bypass traverse checking - Unauthorized accounts must not have the Bypass traverse checking user right. - (CCE-25271-8) - Fail 5157 
12. Change the system time - Unauthorized accounts must not have the Change the system time user right. - (CCE-24185-1) - Fail 5158 
13. Change the time zone - Unauthorized accounts must not have the Change the time zone user right. - (CCE-24632-2) - Fail 5159 
14. Force shutdown from a remote system Unauthorized accounts must not have the Force shutdown from a remote system user right. - 5160 

(CCE-24734-6) - Fail 5161 
15. Increase a process working set - Unauthorized accounts must not have the Increase a process working set user right. - (CCE-24162-0) 5162 

- Fail 5163 
16. Load and unload device drivers - Unauthorized accounts must not have the Load and unload device drivers user right. - 5164 

(CCE-24779-1) - Fail 5165 
17. Log on as a batch job - Unauthorized accounts must not have the Log on as a batch job user right. - (CCE-23386-6) - Fail 5166 
18. Restore files and directories - Unauthorized accounts must not have the Restore files and directories user right. - (CCE-25518-2) - Fail 5167 
19. Shut down the system - Unauthorized accounts must not have the Shut down the system user right. - (CCE-23500-2) - Fail 5168 
20. Add workstations to domain - Unauthorized accounts must not have the Add workstations to domain user right. - (CCE-23271-0) - Fail 5169 
21. Audit Directory Service Access - Success - The system must be configured to audit DS Access - Directory Service Access successes. - 5170 

Fail 5171 
22. Audit - Directory Service Access - Failure - The system must be configured to audit DS Access - Directory Service Access failures. - Fail 5172 
23. Audit - Directory Service Changes - Success - The system must be configured to audit DS Access - Directory Service Changes 5173 

successes. - Fail 5174 
24. Audit - Directory Service Changes - Failure - The system must be configured to audit DS Access - Directory Service Changes failures. - 5175 

Fail 5176 
25. WINGE-000100 - The Enhanced Mitigation Experience Toolkit (EMET) V4.1 Update 1 or later must be installed on the system. - Fail 5177 

 5178 

17.13 PACS CONSOLE WINDOWS SERVER 2012 STIG COMPLIANCE REPORT 5179 

Non-Compliance Report - U_Windows2012_MS_V1R3_STIG_SCAP_1-1_Benchmark 5180 

SCAP Compliance Checker - 3.1.2 5181 
Score | System Information | Stream Information | Results | Detailed Results 5182 
Score 5183 

96.06% Adjusted Score: 96.06% 
Original Score: 96.06% 

Compliance Status: GREEN 
 

 5184 
Pass: 268 Not Applicable: 0 
Fail: 11 Not Checked: 0 

Error: 0 Not Selected: 0 
Unknown: 0 Total: 279 

 

BLUE: Score equals 100 
GREEN: Score is greater than or equal to 90 

YELLOW: Score is greater than or equal to 80 
RED: Score is greater than or equal to 0 

 

System Information 5185 
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Target: PACS-CONSOLE 

Operating System: Windows Server 2012 R2 Standard 

OS Service Pack:   

Domain: PACS-ES-IDAM-B1 

Processor: Intel(R) Xeon(R) CPU E5-2660 0 @ 2.20GHz 

Processor Architecture: Intel64 Family 6 Model 45 Stepping 7 

Processor Speed: 2200 MHz 

Physical Memory: 8192 mb 

Manufacturer: VMware, Inc. 

Model: VMware Virtual Platform 

Serial Number: VMware-42 09 dc 00 da 26 44 78-07 ea f5 33 59 b9 af 46 

BIOS Version: 6.00 

Interfaces: • [00000010] Intel(R) 82574L Gigabit Network Connection 
o 172.16.7.11 
o 00:50:56:89:F8:E0 

Results 5186 

• Bad Logon Attempts 5187 
o The number of allowed bad logon attempts must meet minimum requirements. - (CCE-23909-5) - Fail 5188 

• Force Logoff When Logon Hours Expire 5189 
o The system must be configured to force users to log off when their allowed logon hours expire. - (CCE-25367-4) 5190 

- Fail 5191 
• Minimum Password Length 5192 

o Passwords must, at a minimum, be 14 characters. - (CCE-25317-9) - Fail 5193 
• Legal Banner Dialog Box Title 5194 

o The Windows dialog box title for the legal banner must be configured. - (CCE-24020-0) - Fail 5195 
• Adjust memory quotas for a process  5196 

o Unauthorized accounts must not have the Adjust memory quotas for a process user right. - (CCE-25112-4) - Fail 5197 
• Bypass traverse checking 5198 

o Unauthorized accounts must not have the Bypass traverse checking user right. - (CCE-25271-8) - Fail 5199 
• Deny log on as a batch job 5200 

o The Deny log on as a batch job user right on member servers must be configured to prevent access from highly 5201 
privileged domain accounts on domain systems, and from unauthenticated access on all systems. - (CCE-25215-5202 
5) - Fail 5203 

• Deny log on as service  5204 
o The Deny log on as a service user right on member servers must be configured to prevent access from highly 5205 

privileged domain accounts on domain systems. No other groups or accounts must be assigned this right. - 5206 
(CCE-23117-5) - Fail 5207 

• Deny log on locally 5208 
o The Deny log on locally user right on member servers must be configured to prevent access from highly 5209 

privileged domain accounts on domain systems, and from unauthenticated access on all systems. - (CCE-24460-5210 
8) - Fail 5211 

• Replace a process level token 5212 
o Unauthorized accounts must not have the Replace a process level token user right. - (CCE-24555-5) - Fail 5213 

• WINGE-000100 5214 
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o The Enhanced Mitigation Experience Toolkit (EMET) V4.1 Update 1 or later must be installed on the system. - 5215 
Fail 5216 

17.14 BASELINE CENTOS 7 LINUX CONFIGURATION 5217 

How To STIG/Configure Centos 7 5218 
Install fresh Centos 7 server image, using Minimal Install. The following are assumptions in the 5219 
installation: 5220 

• Separate partitions for /var, /var/log, /var/log/audit, /tmp, /home 5221 
• Networking is configured for your network 5222 

 5223 
yum update -y 5224 
yum install wget openscap-utiles aide libreswan iptables-service ntp 5225 
mkdir {reports,xml} 5226 
cd xml 5227 
wget http://iase.disa.mil/stigs/Documents/u_RedHat_6_V1R6_STIG_SCAP_1-5228 
1_Benchmark.zip 5229 
unzip u_RedHat* 5230 
 5231 

-----------------------------------------   Run Initial Test   ----------------------------------------- 5232 
 5233 
oscap xccdf eval --report ../reports/report.html --cpe *cpe-5234 
dictionary.xml *Benchmark-xccdf.xml 5235 
python -m SimpleHTTPServer 5236 
 5237 

Go to http://<Centos 7 IP Address>:8000/ to view the results of the STIG test 5238 
 5239 

1. Next add the following files to the following locations: 5240 
• rules_d-audit.rules > /etc/audit/rules.d/audit.rules 5241 
• audit.rules > /etc/audit/audit.rules 5242 
• audit.conf > /etc/audit/audit.conf 5243 
• system-auth > /etc/pam.d/system-auth 5244 
• system-au0 0 * * * root /sbin/aide –checkth-ac > /etc/pam.d/system-auth-ac 5245 
• sysctl.conf > /etc/sysctl.conf 5246 
• password-auth-ac > /etc/pam.d/password-auth-ac 5247 
• iptables > /etc/sysconfig/iptables 5248 

2. Next edit the following files: 5249 
1. In /etc/logindefs add/change variables to: 5250 

PASS_MIN_LEN 14 5251 
PASS_MIN_DAYS 1 5252 
PASS_MAX_DAYS 60 5253 

2. Add the following to /etc/crontab: 5254 
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◦ 0 0 * * * root /sbin/aide –check 5255 
3. In /etc/modprobe.d/disabled.conf (create if doesn't exist), add: 5256 

install usb-storage /bin/false 5257 
install dccp /bin/false 5258 
install sctp /bin/false 5259 
install rds /bin/false 5260 
install tipc /bin/false 5261 
install ipv6 /bin/false 5262 

4. Remove any line in /etc/securetty that starts with 'vc' or 'ttyS' 5263 
5. Add to /etc/rsyslog.conf 5264 

*.* @@<any remote syslog server IP address>:514 5265 
6. Add to /etc/sysconfig/init 5266 

SINGLE=/sbin/sulogin 5267 
PROMPT=no 5268 

7. Edit /etc/ntp.conf 5269 
◦ place '#' in front of any line that starts with 'server' 5270 
◦ Add 'server tick.usno.navy.mil' 5271 

8. For all files /etc/csh.cshrc, /etc/profile, /etc/login.defs, and /etc/bashrc 5272 
◦ Change any 'umask' line to 'umask 077' and any 'UMASK' line to 'UMASK 077' 5273 

9. Add to /etc/inittab 5274 
id:3:initdefault: 5275 

10. Add to /etc/security/limits.conf 5276 
* hard core 0 5277 
* hard maxlogins 0 5278 

11. Edit /etc/default/useradd 5279 
◦ Change 'INACTIVE=-1' to 'INACTIVE=35' 5280 

12. yum remove firewalld 5281 
13. chkconfig ntpd on 5282 
14. service ntpd start 5283 
15. ln -sf /lib/systemd/system/multi-user.target /etc/systemd/system/default.target 5284 

 Baseline CentOS 7 Configuration Files 17.14.15285 
1. Audit.rules file contents: 5286 
2. Audit.conf file contents: 5287 
3. iptables file contents: 5288 
4. Password_auth-ac file contents 5289 
5. rules_d-audi.rules file contents 5290 
6. Sysctl.conf files contents 5291 
7. system-auth file contents 5292 
8. system-auth-ac file contents 5293 

 5294 
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 Audit.rules File Contents 17.14.25295 
# 5296 
# This file controls the configuration of the audit daemon 5297 
# 5298 
 5299 
log_file = /var/log/audit/audit.log 5300 
log_format = RAW 5301 
log_group = root 5302 
priority_boost = 4 5303 
flush = INCREMENTAL 5304 
freq = 20 5305 
num_logs = 5 5306 
disp_qos = lossy 5307 
dispatcher = /sbin/audispd 5308 
name_format = NONE 5309 
##name = mydomain 5310 
max_log_file = 6  5311 
max_log_file_action = ROTATE 5312 
space_left = 75 5313 
space_left_action = email 5314 
action_mail_acct = root 5315 
admin_space_left = 50 5316 
admin_space_left_action = SINGLE 5317 
disk_full_action = SUSPEND 5318 
disk_error_action = SUSPEND 5319 
##tcp_listen_port =  5320 
tcp_listen_queue = 5 5321 
tcp_max_per_addr = 1 5322 
##tcp_client_ports = 1024-65535 5323 
tcp_client_max_idle = 0 5324 
enable_krb5 = no 5325 
krb5_principal = auditd 5326 
##krb5_key_file = /etc/audit/audit.key 5327 
 5328 

 Audit.conf File Contents 17.14.35329 
# 5330 
# This file controls the configuration of the audit daemon 5331 
# 5332 
 5333 
log_file = /var/log/audit/audit.log 5334 
log_format = RAW 5335 
log_group = root 5336 
priority_boost = 4 5337 
flush = INCREMENTAL 5338 
freq = 20 5339 
num_logs = 5 5340 
disp_qos = lossy 5341 
dispatcher = /sbin/audispd 5342 
name_format = NONE 5343 
##name = mydomain 5344 
max_log_file = 6  5345 
max_log_file_action = ROTATE 5346 
space_left = 75 5347 
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space_left_action = email 5348 
action_mail_acct = root 5349 
admin_space_left = 50 5350 
admin_space_left_action = SINGLE 5351 
disk_full_action = SUSPEND 5352 
disk_error_action = SUSPEND 5353 
##tcp_listen_port =  5354 
tcp_listen_queue = 5 5355 
tcp_max_per_addr = 1 5356 
##tcp_client_ports = 1024-65535 5357 
tcp_client_max_idle = 0 5358 
enable_krb5 = no 5359 
krb5_principal = auditd 5360 
##krb5_key_file = /etc/audit/audit.key 5361 
 5362 

 iptables File Contents 17.14.45363 
# Generated by iptables-save v1.4.21 on Tue Jan 27 13:28:25 2015 5364 
*nat 5365 
:PREROUTING ACCEPT [219:23061] 5366 
:INPUT ACCEPT [2:120] 5367 
:OUTPUT ACCEPT [125:7804] 5368 
:POSTROUTING ACCEPT [125:7804] 5369 
:OUTPUT_direct - [0:0] 5370 
:POSTROUTING_ZONES - [0:0] 5371 
:POSTROUTING_ZONES_SOURCE - [0:0] 5372 
:POSTROUTING_direct - [0:0] 5373 
:POST_public - [0:0] 5374 
:POST_public_allow - [0:0] 5375 
:POST_public_deny - [0:0] 5376 
:POST_public_log - [0:0] 5377 
:PREROUTING_ZONES - [0:0] 5378 
:PREROUTING_ZONES_SOURCE - [0:0] 5379 
:PREROUTING_direct - [0:0] 5380 
:PRE_public - [0:0] 5381 
:PRE_public_allow - [0:0] 5382 
:PRE_public_deny - [0:0] 5383 
:PRE_public_log - [0:0] 5384 
-A PREROUTING -j PREROUTING_direct 5385 
-A PREROUTING -j PREROUTING_ZONES_SOURCE 5386 
-A PREROUTING -j PREROUTING_ZONES 5387 
-A OUTPUT -j OUTPUT_direct 5388 
-A POSTROUTING -j POSTROUTING_direct 5389 
-A POSTROUTING -j POSTROUTING_ZONES_SOURCE 5390 
-A POSTROUTING -j POSTROUTING_ZONES 5391 
-A POSTROUTING_ZONES -o ens160 -g POST_public 5392 
-A POSTROUTING_ZONES -g POST_public 5393 
-A POST_public -j POST_public_log 5394 
-A POST_public -j POST_public_deny 5395 
-A POST_public -j POST_public_allow 5396 
-A PREROUTING_ZONES -i ens160 -g PRE_public 5397 
-A PREROUTING_ZONES -g PRE_public 5398 
-A PRE_public -j PRE_public_log 5399 
-A PRE_public -j PRE_public_deny 5400 
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-A PRE_public -j PRE_public_allow 5401 
COMMIT 5402 
# Completed on Tue Jan 27 13:28:25 2015 5403 
# Generated by iptables-save v1.4.21 on Tue Jan 27 13:28:25 2015 5404 
*mangle 5405 
:PREROUTING ACCEPT [94235:148159541] 5406 
:INPUT ACCEPT [94155:148151187] 5407 
:FORWARD ACCEPT [0:0] 5408 
:OUTPUT ACCEPT [43012:2796100] 5409 
:POSTROUTING ACCEPT [43027:2798919] 5410 
:FORWARD_direct - [0:0] 5411 
:INPUT_direct - [0:0] 5412 
:OUTPUT_direct - [0:0] 5413 
:POSTROUTING_direct - [0:0] 5414 
:PREROUTING_ZONES - [0:0] 5415 
:PREROUTING_ZONES_SOURCE - [0:0] 5416 
:PREROUTING_direct - [0:0] 5417 
:PRE_public - [0:0] 5418 
:PRE_public_allow - [0:0] 5419 
:PRE_public_deny - [0:0] 5420 
:PRE_public_log - [0:0] 5421 
-A PREROUTING -j PREROUTING_direct 5422 
-A PREROUTING -j PREROUTING_ZONES_SOURCE 5423 
-A PREROUTING -j PREROUTING_ZONES 5424 
-A INPUT -j INPUT_direct 5425 
-A FORWARD -j FORWARD_direct 5426 
-A OUTPUT -j OUTPUT_direct 5427 
-A POSTROUTING -j POSTROUTING_direct 5428 
-A PREROUTING_ZONES -i ens160 -g PRE_public 5429 
-A PREROUTING_ZONES -g PRE_public 5430 
-A PRE_public -j PRE_public_log 5431 
-A PRE_public -j PRE_public_deny 5432 
-A PRE_public -j PRE_public_allow 5433 
COMMIT 5434 
# Completed on Tue Jan 27 13:28:25 2015 5435 
# Generated by iptables-save v1.4.21 on Tue Jan 27 13:28:25 2015 5436 
*security 5437 
:INPUT ACCEPT [94003:148133781] 5438 
:FORWARD ACCEPT [0:0] 5439 
:OUTPUT ACCEPT [43012:2796100] 5440 
:FORWARD_direct - [0:0] 5441 
:INPUT_direct - [0:0] 5442 
:OUTPUT_direct - [0:0] 5443 
-A INPUT -j INPUT_direct 5444 
-A FORWARD -j FORWARD_direct 5445 
-A OUTPUT -j OUTPUT_direct 5446 
COMMIT 5447 
# Completed on Tue Jan 27 13:28:25 2015 5448 
# Generated by iptables-save v1.4.21 on Tue Jan 27 13:28:25 2015 5449 
*raw 5450 
:PREROUTING ACCEPT [94236:148159577] 5451 
:OUTPUT ACCEPT [43012:2796100] 5452 
:OUTPUT_direct - [0:0] 5453 
:PREROUTING_direct - [0:0] 5454 
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-A PREROUTING -j PREROUTING_direct 5455 
-A OUTPUT -j OUTPUT_direct 5456 
COMMIT 5457 
# Completed on Tue Jan 27 13:28:25 2015 5458 
# Generated by iptables-save v1.4.21 on Tue Jan 27 13:28:25 2015 5459 
*filter 5460 
:INPUT DROP [0:0] 5461 
:FORWARD ACCEPT [0:0] 5462 
:OUTPUT ACCEPT [0:0] 5463 
:FORWARD_IN_ZONES - [0:0] 5464 
:FORWARD_IN_ZONES_SOURCE - [0:0] 5465 
:FORWARD_OUT_ZONES - [0:0] 5466 
:FORWARD_OUT_ZONES_SOURCE - [0:0] 5467 
:FORWARD_direct - [0:0] 5468 
:FWDI_public - [0:0] 5469 
:FWDI_public_allow - [0:0] 5470 
:FWDI_public_deny - [0:0] 5471 
:FWDI_public_log - [0:0] 5472 
:FWDO_public - [0:0] 5473 
:FWDO_public_allow - [0:0] 5474 
:FWDO_public_deny - [0:0] 5475 
:FWDO_public_log - [0:0] 5476 
:INPUT_ZONES - [0:0] 5477 
:INPUT_ZONES_SOURCE - [0:0] 5478 
:INPUT_direct - [0:0] 5479 
:IN_public - [0:0] 5480 
:IN_public_allow - [0:0] 5481 
:IN_public_deny - [0:0] 5482 
:IN_public_log - [0:0] 5483 
:OUTPUT_direct - [0:0] 5484 
-A INPUT -m conntrack --ctstate RELATED,ESTABLISHED -j ACCEPT 5485 
-A INPUT -i lo -j ACCEPT 5486 
-A INPUT -j INPUT_direct 5487 
-A INPUT -j INPUT_ZONES_SOURCE 5488 
-A INPUT -j INPUT_ZONES 5489 
-A INPUT -p icmp -j ACCEPT 5490 
-A INPUT -j REJECT --reject-with icmp-host-prohibited 5491 
-A FORWARD -m conntrack --ctstate RELATED,ESTABLISHED -j ACCEPT 5492 
-A FORWARD -i lo -j ACCEPT 5493 
-A FORWARD -j FORWARD_direct 5494 
-A FORWARD -j FORWARD_IN_ZONES_SOURCE 5495 
-A FORWARD -j FORWARD_IN_ZONES 5496 
-A FORWARD -j FORWARD_OUT_ZONES_SOURCE 5497 
-A FORWARD -j FORWARD_OUT_ZONES 5498 
-A FORWARD -p icmp -j ACCEPT 5499 
-A FORWARD -j REJECT --reject-with icmp-host-prohibited 5500 
-A OUTPUT -j OUTPUT_direct 5501 
-A FORWARD_IN_ZONES -i ens160 -g FWDI_public 5502 
-A FORWARD_IN_ZONES -g FWDI_public 5503 
-A FORWARD_OUT_ZONES -o ens160 -g FWDO_public 5504 
-A FORWARD_OUT_ZONES -g FWDO_public 5505 
-A FWDI_public -j FWDI_public_log 5506 
-A FWDI_public -j FWDI_public_deny 5507 
-A FWDI_public -j FWDI_public_allow 5508 
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-A FWDO_public -j FWDO_public_log 5509 
-A FWDO_public -j FWDO_public_deny 5510 
-A FWDO_public -j FWDO_public_allow 5511 
-A INPUT_ZONES -i ens160 -g IN_public 5512 
-A INPUT_ZONES -g IN_public 5513 
-A IN_public -j IN_public_log 5514 
-A IN_public -j IN_public_deny 5515 
-A IN_public -j IN_public_allow 5516 
-A IN_public_allow -p tcp -m tcp --dport 22 -m conntrack --ctstate NEW -j 5517 
ACCEPT 5518 
COMMIT 5519 
# Completed on Tue Jan 27 13:28:25 2015 5520 
 5521 

 Password_auth-ac File Contents 17.14.55522 
#%PAM-1.0 5523 
# This file is auto-generated. 5524 
# User changes will be destroyed the next time authconfig is run. 5525 
auth  required  pam_env.so 5526 
auth  sufficient pam_unix.so nullok try_first_pass 5527 
auth  [default=die] pam_faillock.so authfail deny=3 unlock_time=604800 5528 
fail_interval=900 5529 
auth  required pam_faillock.so authsucc deny=3 unlock_time=604800 5530 
fail_interval=900 5531 
auth  requisite  pam_succeed_if.so uid >= 1000 quiet_success 5532 
auth  required  pam_deny.so 5533 
 5534 
account  required  pam_unix.so 5535 
account  sufficient pam_localuser.so 5536 
account  sufficient pam_succeed_if.so uid < 1000 quiet 5537 
account  required  pam_permit.so 5538 
 5539 
password requisite  pam_pwquality.so try_first_pass local_users_only 5540 
retry=3 authtok_type= 5541 
password sufficient pam_unix.so sha512 shadow nullok try_first_pass 5542 
use_authtok 5543 
password required  pam_deny.so 5544 
 5545 
session  optional  pam_keyinit.so revoke 5546 
session  required  pam_limits.so 5547 
-session  optional  pam_systemd.so 5548 
session  [success=1 default=ignore] pam_succeed_if.so service in crond 5549 
quiet use_uid 5550 
session  required  pam_unix.so 5551 
 5552 

 rules_d-audi.rules File Contents 17.14.65553 
# This file contains the auditctl rules that are loaded 5554 
# whenever the audit daemon is started via the initscripts. 5555 
# The rules are simply the parameters that would be passed 5556 
# to auditctl. 5557 
 5558 
# First rule - delete all 5559 
-D 5560 
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 5561 
# Increase the buffers to survive stress events. 5562 
# Make this bigger for busy systems 5563 
-b 320 5564 
 5565 
# Feel free to add below this line. See auditctl man page 5566 
# STIG Stuff Below 5567 
 5568 
# audit_time_rules 5569 
-a always,exit -F arch=b64 -S adjtimex -S settimeofday -S clock_settime -k 5570 
audit_time_rules 5571 
-w /etc/localtime -p wa -k audit_time_rules 5572 
 5573 
# audit_account_changes 5574 
-w /etc/group -p wa -k audit_account_changes 5575 
-w /etc/passwd -p wa -k audit_account_changes 5576 
-w /etc/gshadow -p wa -k audit_account_changes 5577 
-w /etc/shadow -p wa -k audit_account_changes 5578 
-w /etc/security/opasswd -p wa -k audit_account_changes 5579 
 5580 
# MAC-policy 5581 
-w /etc/selinux -p wa -k MAC-policy 5582 
 5583 
# export 5584 
-a always,exit -F arch=b64 -S mount -F auid>=500 -F auid!=4294967295 -k 5585 
export 5586 
-a always,exit -F arch=b64 -S mount -F auid=0 -k export 5587 
 5588 
# delete 5589 
-a always,exit -F arch=b64 -S rmdir -S unlink -S unlinkat -S rename -S 5590 
renameat -F auid>=500 -F auid!=4294967295 -k delete 5591 
-a always,exit -F arch=b64 -S rmdir -S unlink -S unlinkat -S rename -S 5592 
renameat -F auid=0 -k delete 5593 
 5594 
# actions 5595 
-w /etc/sudoers -p wa -k actions 5596 
 5597 
# modules 5598 
-w /sbin/insmod -p x -k modules 5599 
-w /sbin/rmmod -p x -k modules 5600 
-w /sbin/modprobe -p x -k modules 5601 
-a always,exit -F arch=b64 -S init_module -S delete_module -k modules 5602 
 5603 
# perm_mod 5604 
-a always,exit -F arch=b32 -S chmod -F auid>=500 -F auid!=4294967295 -k 5605 
perm_mod 5606 
-a always,exit -F arch=b32 -S chmod -F auid=0 -k perm_mod 5607 
-a always,exit -F arch=b32 -S fchmod -F auid>=500 -F auid!=4294967295 -k 5608 
perm_mod 5609 
-a always,exit -F arch=b32 -S fchmod -F auid=0 -k perm_mod 5610 
-a always,exit -F arch=b64 -S chmod -F auid>=500 -F auid!=4294967295 -k 5611 
perm_mod 5612 
-a always,exit -F arch=b64 -S chmod -F auid=0 -k perm_mod 5613 
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-a always,exit -F arch=b64 -S fchmod -F auid>=500 -F auid!=4294967295 -k 5614 
perm_mod 5615 
-a always,exit -F arch=b64 -S fchmod -F auid=0 -k perm_mod 5616 
 5617 
-a always,exit -F arch=b32 -S fchmodat -F auid>=500 -F auid!=4294967295 -k 5618 
perm_mod 5619 
-a always,exit -F arch=b32 -S fchmodat -F auid=0 -k perm_mod 5620 
-a always,exit -F arch=b64 -S fchmodat -F auid>=500 -F auid!=4294967295 -k 5621 
perm_mod 5622 
-a always,exit -F arch=b64 -S fchmodat -F auid=0 -k perm_mod 5623 
 5624 
-a always,exit -F arch=b32 -S fchown -F auid>=500 -F auid!=4294967295 -k 5625 
perm_mod 5626 
-a always,exit -F arch=b32 -S fchown -F auid=0 -k perm_mod 5627 
-a always,exit -F arch=b64 -S fchown -F auid>=500 -F auid!=4294967295 -k 5628 
perm_mod 5629 
-a always,exit -F arch=b64 -S fchown -F auid=0 -k perm_mod 5630 
 5631 
-a always,exit -F arch=b32 -S chown -F auid>=500 -F auid!=4294967295 -k 5632 
perm_mod 5633 
-a always,exit -F arch=b32 -S chown -F auid=0 -k perm_mod 5634 
-a always,exit -F arch=b64 -S chown -F auid>=500 -F auid!=4294967295 -k 5635 
perm_mod 5636 
-a always,exit -F arch=b64 -S chown -F auid=0 -k perm_mod 5637 
 5638 
-a always,exit -F arch=b32 -S fchownat -F auid>=500 -F auid!=4294967295 -k 5639 
perm_mod 5640 
-a always,exit -F arch=b32 -S fchownat -F auid=0 -k perm_mod 5641 
-a always,exit -F arch=b64 -S fchownat -F auid>=500 -F auid!=4294967295 -k 5642 
perm_mod 5643 
-a always,exit -F arch=b64 -S fchownat -F auid=0 -k perm_mod 5644 
 5645 
-a always,exit -F arch=b32 -S fremovexattr -F auid>=500 -F 5646 
auid!=4294967295 -k perm_mod 5647 
-a always,exit -F arch=b32 -S fremovexattr -F auid=0 -k perm_mod 5648 
-a always,exit -F arch=b64 -S fremovexattr -F auid>=500 -F 5649 
auid!=4294967295 -k perm_mod 5650 
-a always,exit -F arch=b64 -S fremovexattr -F auid=0 -k perm_mod 5651 
 5652 
-a always,exit -F arch=b32 -S fsetxattr -F auid>=500 -F auid!=4294967295 -5653 
k perm_mod 5654 
-a always,exit -F arch=b32 -S fsetxattr -F auid=0 -k perm_mod 5655 
-a always,exit -F arch=b64 -S fsetxattr -F auid>=500 -F auid!=4294967295 -5656 
k perm_mod 5657 
-a always,exit -F arch=b64 -S fsetxattr -F auid=0 -k perm_mod 5658 
 5659 
-a always,exit -F arch=b32 -S lchown -F auid>=500 -F auid!=4294967295 -k 5660 
perm_mod 5661 
-a always,exit -F arch=b32 -S lchown -F auid=0 -k perm_mod 5662 
-a always,exit -F arch=b64 -S lchown -F auid>=500 -F auid!=4294967295 -k 5663 
perm_mod 5664 
-a always,exit -F arch=b64 -S lchown -F auid=0 -k perm_mod 5665 
 5666 
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-a always,exit -F arch=b32 -S lremovexattr -F auid>=500 -F 5667 
auid!=4294967295 -k perm_mod 5668 
-a always,exit -F arch=b32 -S lremovexattr -F auid=0 -k perm_mod 5669 
-a always,exit -F arch=b64 -S lremovexattr -F auid>=500 -F 5670 
auid!=4294967295 -k perm_mod 5671 
-a always,exit -F arch=b64 -S lremovexattr -F auid=0 -k perm_mod 5672 
 5673 
-a always,exit -F arch=b32 -S lsetxattr -F auid>=500 -F auid!=4294967295 -5674 
k perm_mod 5675 
-a always,exit -F arch=b32 -S lsetxattr -F auid=0 -k perm_mod 5676 
-a always,exit -F arch=b64 -S lsetxattr -F auid>=500 -F auid!=4294967295 -5677 
k perm_mod 5678 
-a always,exit -F arch=b64 -S lsetxattr -F auid=0 -k perm_mod 5679 
 5680 
-a always,exit -F arch=b32 -S removexattr -F auid>=500 -F auid!=4294967295 5681 
-k perm_mod 5682 
-a always,exit -F arch=b32 -S removexattr -F auid=0 -k perm_mod 5683 
-a always,exit -F arch=b64 -S removexattr -F auid>=500 -F auid!=4294967295 5684 
-k perm_mod 5685 
-a always,exit -F arch=b64 -S removexattr -F auid=0 -k perm_mod 5686 
 5687 
-a always,exit -F arch=b32 -S setxattr -F auid>=500 -F auid!=4294967295 -k 5688 
perm_mod 5689 
-a always,exit -F arch=b32 -S setxattr -F auid=0 -k perm_mod 5690 
-a always,exit -F arch=b64 -S setxattr -F auid>=500 -F auid!=4294967295 -k 5691 
perm_mod 5692 
-a always,exit -F arch=b64 -S setxattr -F auid=0 -k perm_mod 5693 
 5694 

 Sysctl.conf Files Contents 17.14.75695 
# System default settings live in /usr/lib/sysctl.d/00-system.conf. 5696 
# To override those settings, enter new settings here, or in an 5697 
/etc/sysctl.d/<name>.conf file 5698 
# 5699 
# For more information, see sysctl.conf(5) and sysctl.d(5). 5700 
net.ipv4.ip_forward = 0 5701 
net.ipv4.conf.all.accept_source_route = 0 5702 
net.ipv4.conf.all.accept_redirects = 0 5703 
net.ipv4.conf.all.secure_redirects = 0 5704 
net.ipv4.conf.all.log_martians = 1 5705 
net.ipv4.conf.default.accept_source_route = 0 5706 
net.ipv4.conf.default.secure_redirects = 0 5707 
net.ipv4.conf.default.accept_redirects = 0 5708 
net.ipv4.icmp_echo_ignore_broadcasts = 1 5709 
net.ipv4.icmp_ignore_bogus_error_responses = 1 5710 
net.ipv4.tcp_syncookies = 1 5711 
net.ipv4.conf.all.rp_filter = 1 5712 
net.ipv4.conf.default.rp_filter = 1 5713 
net.ipv6.conf.default.accept_redirects = 0 5714 
net.ipv4.conf.default.send_redirects = 0 5715 
net.ipv4.conf.all.send_redirects = 0 5716 
 5717 
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 system-auth File Contents 17.14.85718 
#%PAM-1.0 5719 
# This file is auto-generated. 5720 
# User changes will be destroyed the next time authconfig is run. 5721 
auth  required  pam_env.so 5722 
auth  sufficient pam_unix.so try_first_pass 5723 
auth  [default=die] pam_faillock.so authfail deny=3 unlock_time=604800 5724 
fail_interval=900 5725 
auth  required  pam_faillock.so authsucc deny=3 unlock_time=604800 5726 
fail_interval=900 5727 
auth  requisite  pam_succeed_if.so uid >= 1000 quiet_success 5728 
auth  required  pam_deny.so 5729 
 5730 
account  required  pam_unix.so 5731 
account  sufficient pam_localuser.so 5732 
account  sufficient pam_succeed_if.so uid < 1000 quiet 5733 
account  required  pam_permit.so 5734 
 5735 
password required  pam_cracklib.so retry=3 minlen=14 dcredit=-1 ucredit=-1 5736 
ocredit=-1 lcredit=-1 difok=4 5737 
password requisite  pam_pwquality.so try_first_pass local_users_only 5738 
retry=3 authtok_type= 5739 
password sufficient pam_unix.so sha512 shadow try_first_pass use_authtok 5740 
password required  pam_deny.so 5741 
 5742 
session  optional  pam_keyinit.so revoke 5743 
session  required  pam_limits.so 5744 
-session  optional  pam_systemd.so 5745 
session  [success=1 default=ignore] pam_succeed_if.so service in crond 5746 
quiet use_uid 5747 
session  required  pam_unix.so 5748 
session  required  pam_lastlog.so showfailed 5749 
session  required   pam_limits.so 5750 
 5751 

 system-auth-ac File Contents 17.14.95752 
#%PAM-1.0 5753 
# This file is auto-generated. 5754 
# User changes will be destroyed the next time authconfig is run. 5755 
auth  required  pam_env.so 5756 
auth  sufficient pam_unix.so try_first_pass 5757 
auth  [default=die] pam_faillock.so authfail deny=3 unlock_time=604800 5758 
fail_interval=900 5759 
auth  required  pam_faillock.so authsucc deny=3 unlock_time=604800 5760 
fail_interval=900 5761 
auth  requisite  pam_succeed_if.so uid >= 1000 quiet_success 5762 
auth  required  pam_deny.so 5763 
 5764 
account  required  pam_unix.so 5765 
account  sufficient pam_localuser.so 5766 
account  sufficient pam_succeed_if.so uid < 1000 quiet 5767 
account  required  pam_permit.so 5768 
 5769 
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password required  pam_cracklib.so retry=3 minlen=14 dcredit=-1 ucredit=-1 5770 
ocredit=-1 lcredit=-1 difok=4 5771 
password requisite  pam_pwquality.so try_first_pass local_users_only 5772 
retry=3 authtok_type= 5773 
password sufficient pam_unix.so sha512 shadow try_first_pass use_authtok 5774 
password required  pam_deny.so 5775 
 5776 
session  optional  pam_keyinit.so revoke 5777 
session  required  pam_limits.so 5778 
-session  optional  pam_systemd.so 5779 
session  [success=1 default=ignore] pam_succeed_if.so service in crond 5780 
quiet use_uid 5781 
session  required  pam_unix.so 5782 
session  required  pam_lastlog.so showfailed 5783 
session  required   pam_limits.so 5784 
 5785 

17.15 BASELINE CENTOS 7 STIG COMPLIANCE 5786 

Note the STIG compliance test is based on the CentOS 6 STIG compliance analysis. At the time 5787 
this testing was completed the CentOS 7 STIG had not been published. 5788 
Introduction 5789 

Test Result 5790 

Result ID Profile Start 
time 

End 
time Benchmark Benchmark 

version 

xccdf_org.open-
scap_testresult_default-

profile 

(Default 
profile)  

2015-
03-11 
12:25  

2015-
03-11 
12:26  

embedded  1 

Target info 5791 

Targets 

• localhost.localdomain 

Addresses 

• 127.0.0.1 
• 10.32.2.59 
• 0:0:0:0:0:0:0:1 
• fe80:0:0:0:250:56ff:fe89:5cab 

•  

Platform 

• cpe:/o:redhat:enterprise_linux:6 

 

Score 5792 

system score max % bar 

urn:xccdf:scoring:default 96.65 100.00 96.65% 
 

Results overview 5793 



DRAFT 
   

289 | NIST Cybersecurity Practice Guide SP 1800-2c 
 

Rule Results Summary 5794 

pass fixed fail error not 
selected 

not 
checked 

not 
applicable informational unknown total 

173  0  6  0  0  0  0  0  0  179  

 Rule Results Summary 17.15.15795 
Title Result 

Auditing must be enabled at boot by setting a kernel parameter.  fail  

The audit system must be configured to audit modifications to the systems Mandatory 
Access Control (MAC) configuration (SELinux).  fail  

The system boot loader configuration file(s) must be owned by root.  fail  

The system boot loader configuration file(s) must be group-owned by root.  fail  

The system boot loader configuration file(s) must have mode 0600 or less permissive.  fail  

The system boot loader must require authentication.  fail  

  5796 

http://172.16.33.88:9080/AlertEnterprise/#ruleresult-idp59479504
https://www.naesb.org/pdf4/ac_authorities_2015.pdf#ruleresult-idp60018320
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18 ACRONYMS 5797 

Acronym Literal Translation 

AD Active Directory 

CA Certificate authority (also used as shorthand for the name of the 
company “CA Technologies”) 

CIP Critical Infrastructure Protection 

.csv Comma-Separated Value 

DISA Defense Information Systems Agency 

DMZ Demilitarized Zone 

DoD Department of Defense 

EMS Energy Management System 

ICS Industrial Control System 

IdAM Identity and Access Management 

iEMS RADiFlow ICS/SCADA router configuration management software 

ISE Identity Services Engine 

iSIM Industrial Service Management Tool 

IT Information Technology 

JRE Java Runtime Environment 

NAS Network Attached Storage 

NCCoE National Cybersecurity Center of Excellence 

NERC North American Electric Reliability Corporation 

NIST National Institute of Standards and Technology 

OS Operating System 

OT Operational Technology 

PACS Physical Access Control System 
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Acronym Literal Translation 

PLC Programmable Logic Controller 

RAM Random Access Memory 

RTU Remote Terminal Unit 

SCADA Supervisory Control and Data Acquisition 

STIG Security Technical Implementation Guideline 

VLAN Virtual Local Area Network 

VM Virtual Machine 

VPN Virtual Private Network 

WAR Web Application Archive 
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